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Getting Started 

Thank you, for choosing Kothari Print Pro for your digital printing needs. This 

section will help you in installing the software on your computer machine 

and help you getting it running right away. 

 

Installation 
Enter the accompanying CD disk in the CD-ROM drive of your computer and 

the installation program should start running automatically. If it does not, 

run \Print Pro\Setup.exe yourself from the CD. 
 

Step 1: Follow the instructions given by the installation program to get the 

program installed on your hard disk. 
 
Step 2: Go to the root directory of the CD in the Windows explorer. Run the 

file InstallHasp.exe. This file is the installation program for installing the 

drivers for the accompanied lock on your PC‟s hard disk. Follow the 

instructions given by the installation program. 

 

Step 3: Connect the lock to the parallel/USB port of your PC depending 

upon the type of lock. If the lock is attached to the parallel port, you may 

attach printer cable to the other end of the lock. 

 

Step 4: Reboot your PC. 

 

Launching the Software 
You can run Print Pro either by double clicking its icon on the desktop or by 

selecting Start > Programs > Print Pro T-Shirt > Print Pro. 
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System Recommendations 
 Processor: Requires a PC based on Intel i5 or i7 quad core (3.3 GHz) 

or higher processor. 

 Operating System: Microsoft® Windows® 7 64-bit or later. 

 RAM: 6GB DDR3 or more. 

 Hard Disk: Hard Drive with SATA interface and 1 TB free disk space. 

Solid state drives are recommended for better performance. 

 Monitor: SVGA or better with resolution of 1280 x 1024 or better. 32 

bits or more color support recommended. 

 Printer: Subjected to software specification. 

 

Limitations 
There is practically no limitation on output size when using Print Pro‟s 

custom printer driver. 

 

Rest of the portion of the manual will help you in getting familiar with the 

software and putting it to use. 

 

This manual assumes that you are familiar with Microsoft® Windows® 

Operating system and know the terminology and general Windows UI well. 

 

Most of the examples drawn here in this manual are from Textile printing, 

but are equally applicable to other forms of printing. 
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Organization of the Manual 
Next topic „About Print Pro‟ offers an insight into what this software can 

do for you. 

 

Rest of the manual is organized into three sections. 

 

Section I „On The Fast Track‟ describes how to get quick production from 

the machine, the pre-press and the color management topics and Print Pro‟s 

support for it. These topics are as follows. 

 

1. Preparing Images for printing - Underbase Creation. 

2. Color management. 

 

Section II deals with the interface part of the software. It includes the 

following topics. 

 

1. Printing. 

a. Queue Manager 

b. Port Manager 

c. Printer drivers 

d. Print options 

 

2. Page Layout (Optional feature in the basic version of the software). 

3. Filters. 

4. The Application Interface. 

5. Productivity features. 

6. Common Error messages and Warnings. 

 

Section III deals with the „Platen Organizer' application (Optional feature 

in the basic version of the software), which is used to create and modify the 

layout templates. 
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About KITL 
KITL is a young and ambitious company with current focus on tools and 

technologies for color reproduction. 

 

Currently we at KITL have five major lines of products targeted for graphic 

arts and textiles.  

 

1. RIPS (Raster Image Processing software) and color management 

software for: 

a. Screen making. 

b. Large/ Wide format digital printing. 

c. Digital Textile Printing. 

d. Digital photo Mini Labs. 

e. Proofing solutions for graphic arts. 

 

2. Color formulation and QC software for textiles. 

3. Inks and chemistry solutions for digital textile printing. 

4. Label printing and RIP and Server solutions for automated 

operation in volume printing environment. 

5. Print tracking, billing and supplies management software. 

 

To know more about our products and us please logon to our website 

www.kothariinfotech.com. 

 

http://www.kothariinfotech.com/
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About Print Pro 

This version of Print Pro has been designed for direct inkjet printing on 

various substrates. With the printing techniques used in direct substrate 

printing getting increasingly sophisticated, the software catering to these 

techniques needs to keep in pace with them as well. Print Pro does that and 

takes it to the next level.   

 

With this special edition of Print Pro, you have, 

 

1. ICC based color workflow. 

2. Reads and uses embedded profiles if any, inside the image file. It also 

has Assign Profile feature for assigning different ICC profile to the image 

besides the one already embedded in the image file. 

3. Interpolation support for high quality output. 

4. Custom printer driver for various Printer models (these drivers may vary 

based on the version of this software). 

5. Simultaneous RIP and Print. 

6. Rip once output many (ROOM). 

7. Save Ripped and printed jobs for future use. 

8. Print selected layers from a ripped data, e.g., White underbase layer or 

color layer. Simultaneous printing of multiple layers. 

9. Port manager to manage ports. 

10. Queue manager to manage jobs. 

11. Lots of other features to boost your productivity. 

12. Ability to connect to any windows compatible printer. 

13. Powerful page layout feature (Optional feature in the basic version of 

the software) to print job(s) on a single page with transparency support 

using predefined designs. 

14. Platen Organizer to create and modify template layouts of desired sizes. 

 

Rest of the topics will explain you in detail the various options that are 

offered by Print Pro. 
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Getting Productive 

This is a quick reference guide that will walk you through some of the most 

basic features of Print Pro, which will help you start printing images on your 

machine right away using Print Pro. 

 

Before we begin, it‟s important for you to know that this edition of Print Pro 

has been designed to work the best with Adobe Photoshop. Later topics in 

this chapter will explain this in detail. 

 

Before you start, install the Windows USB port driver for printer as you will 

be utilizing this USB port for printing from Print Pro. 
 

Configuring Print Pro 
Please follow the below mentioned steps carefully. 

 

1. Launch Print Pro either using the desktop shortcut or from Start > 

Programs > Print Pro T-Shirt > Print Pro.  

2. Invoke the menu command Options > General Preferences….The 

various options available in the dialog are explained below.  

a. Physical RAM usage: Physical RAM usage box provides the detail 

information about available system RAM, RAM used by the Print Pro 

and instructed RAM amount for use by Print Pro. The value to be 

entered here depends upon how you are going to use your system. 

This value may range from 70% to 30%. For example if you are 

going to run Adobe Photoshop along with Print Pro at the same time 

then you may have to share the primary RAM between the 2 

applications. Choose 30% for Print Pro and similar amount for 

Photoshop in the Photoshop. However if you are going to run Print 

Pro exclusively on the machine then you may choose to give Print 

Pro 60% or 70% of RAM. 

b. Primary disk used: Select a Primary Scratch Space from the list of 

available spaces. Print Pro uses hard drives to handle the images 

and uses RAM as cache. 

c. Remove: Click this button to remove secondary disks from the 

'Used' column. 
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d. Add: Click this button to add available secondary disks to the 

'Used' column. 

e. Cache Settings: Cache levels and flag to indicate whether to use 

the cache levels when computing the histogram for the images. 

f. Tile Size: Specifies the amount of size software processes at once. 

Choose from large to small size depending on whether working on 

few big size images or many small size images. Choosing large tile 

size is recommended. 

 

Fig 1. General Preferences 

a 

b 

e f 

c 

d 
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3. Invoke the menu command Queue Manager > Port Manager. Add the 

appropriate port on which you want to do the printing. After adding the 

port, press the „Finish‟ button. For more details on how to configure 

ports using the port manager, please refer „Port Manager‟ on page no.  

57. 

 

Fig 2. Port Manager 

 

4. Invoke the menu command Color > Color Management… or use the 

keyboard shortcut <Ctrl> + <Shift> + <K> to get the color 

management dialog. Choose the appropriate color spaces. Say if you 

are using Adobe Photoshop then you may want to keep the default color 

spaces same as in Photoshop. 

 

For more details on how to use the different options available in the 

dialog, please refer „Color Management Dialog‟ on page no 21. 
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Fig 3. Color Management Options 

 

 Default RGB : Select sRGB IEC61966-2.1 

 Default CMYK : Select U.S. Web Coated (SWOP) v2 

 

5. Close Print Pro and then re-launch Print Pro now for allowing the 

changes to have an effect. 
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Printing Images 
Printing images in general is a 4 step process. 

 

1. Open the image you want to print. Print Pro supports variety of raster 

file formats. However, working with Photoshop‟s PSD file format is 

highly recommended as among other things you can have transparency 

information embedded in it. Also refer „Preparing Images for Printing‟ on 

page 17. 

2. Tune the size and placement related information, if required. You can 

do that using the QRip. Access QRip by View > Show QRip command. 

See „Q Rip‟ for more details on page 229. 

 

Fig 4. Quick Rip Options 
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Fig 5. Printer Settings Tool Bar with Environment Selection 

 

3. Select the appropriate print environment from the printer settings tool 

bar. For more details refer „Printer Settings Toolbar‟ on page no. 195. 

4. After defining the appropriate settings, give the print command (<Ctrl> 

+ <P>). 
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Fig 6. Print Dialog 

 

a. Printer Name: This field specifies the name of the printer that you 

select to print the page. 

b. What do you want to print:  Select any one option to print either the 

whole page or selected portion. 

c. To Print: Enter the number of pages you want to print and the total 

number of copies that you want. 

d. Selected port: Shows the currently selected port. One can also change 

the selected port from the available ports list in the combo list.   

 

If you are printing for the first time using the printer settings to the printer, 

and there is no port associated with it then you may be asked to associate a 

port with the current printer setting that identifies the printer you would like 

to print on. 

 

 

 

 

 

 

b 

a 

c 

d 
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Fig 7. Queue Manager when no Port is selected 

 

As you can see in Fig 7, there is no port currently selected for printing. So it 

says No port is selected. 

 

The dialog given in Fig 8 shows the list of the available ports from which you 

can select one for your printing needs. 

 

Fig 8. Queue Manager with the Port Selection List 

 

Also refer to „Preparing White Underbase‟ on page 18. 
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Preparing Images for Printing 
If you are using Adobe Photoshop then it is recommended that you work with 

PSD file format. In that case preparing the image for printing on various 

color background becomes very simple. All you need to do is to knock the 

background off and make the area transparent. You can thus have a single 

target for all color backgrounds. 

 

Another advantage of working with this format is that you can have soft 

edges on the image boundaries that will allow smooth merging of the image 

with the background. 

 

In case of other file formats then you may have to generate image having 

the background color same as that of your printing substrate. For example to 

print on White substrate the background of the image should be white. 

Similarly to print on black substrate the background of the image should be 

black and so on. 

 

 Some sample images with background knocked off are shown below. 

 

Fig 9. Background Knock Off Sample 

 

The background has been knocked off to make it transparent making the 

image usable with printing base of any color. The grid in the right hand 

portion of the images represents transparency. 
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Preparing White Underbase 
You don‟t really have to do anything to create the white underbase, as the 

software automatically generates this for you. All you need to do is to choose 

the right printer setting. 

 

However you may feel some time the need for having White highlights. A 

white highlight is generally the area in the image which is either white or is 

close to white. Again this can be generated in the Adobe Photoshop and 

saved with the image as a Spot / Alpha channel. When the image is imported 

into Print Pro, the highlight channel is also read in. All you need to do before 

printing the image is to tell the software which channel contains the highlight 

information. To know more about how to do this, see Channel Palette on 

page 198. 

 

Highlight white is printed along with the color pass. 

 

Please note by default the highlight white is not printed along with the color 

data when printing on the white substrate, however you can turn on the 

printing of highlight white if you desire so. 
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Color Management 

So far throughout the manual, we taught you how to get productive with the 

software right away. In the remaining part of the manual we now explain the 

powerful control that Print Pro offers over the various variables involved in 

textile printing.  

 

Printing is all about producing color on the desired substrate. The details of 

the color are derived from the image data. This image data reflects the 

imagination of its creator. Under most circumstances we would like to have a 

conforming print to the image data or in other words WYSIWYG.  

 

Print Pro offers considerable support to this in the form of color 

management. The heart of the Print Pro‟s color support is its color 

management module. 

 

Print Pro‟s Color Management Module (CMM) is based on ICC (International 

Color Consortium) model.  

 

Fig 10. ICC Based Color Workflow 

 

Where Device 1 can be a RGB monitor and Device 2 can be a CMYK printer, 

and so on. Images rendered on Device 1 are rendered on Device 2 via PCS. 

This transformation helps in maintaining the same color appearance of the 

image on two devices. This is step towards WYSIWYG (What you see is what 

you get)*. 

 

PCS 
(Profile Connection Space) 

Device 1 Device 2 Device 3 … 

Device N 
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* Color management‟s effectiveness is greatly influenced by the proper 

characterization of the rendering devices and the differences in their color 

gamuts. 

 

What is Color Management? 
Color management allows you to create designs or images on one device and 

renders the same on other device having different colorimetry/ technology 

while maintaining the same color appearance. E.g., Color management will 

allow image viewed on the RGB monitor to appear same when printed on the 

CMYK printer. 

 

Print Pro Offers 
Print Pro offers color-managed workflow. This essentially means that Print 

Pro will use the device profiles to manage the color appearance across 

different color input/ output devices. 

 

Print Pro reads and uses any embedded ICC color profile present in the input 

image file.  

 

In absence of any embedded profile Print Pro uses one of the appropriate 

default ICC profiles as specified by the user. Use the Color management 

Dialog to specify the default color settings. 
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Fig 11. Color Management Dialog 

 

a. Monitor Profile: Select a profile from the drop down list or, or choose 

the custom option from the list to define a custom monitor. You can also 

choose the load option to load a specific ICC monitor profile. 

b. Reset Hardware Gamma table, if not found in ICC profile: If 

hardware gamma table not exist in selected ICC profile then print pro 

automatically reset the gamma table. 

c. Default RGB: Select a profile from the drop down list, or choose the 

custom option from the list to define a RGB Setup. See also: Specifying 

a 

c 

h 
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RGB setup to page no. 26. You can also choose the load option to load a 

specific ICC RGB color profile. 

d. Ignore embedded RGB profile in document: Ignore the embedded 

ICC RGB color profile in the document and render the contents according 

to the currently chosen Default RGB profile. 

e. Default CMYK: Select a profile from the drop down list, or choose the 

load option to load a specific ICC CMYK color profile. 

f. Ignore embedded CMYK profile in document: Ignore the embedded 

ICC CMYK color profile in the document and render the contents 

according to the currently chosen Default CMYK profile. 

g. Rendering Intent: It specifies the rendering intent to be used with the 

profile. The available rendering intents are as follows. 

o Perceptual 

o Relative Colorimetric 

o Saturation 

o Absolute Colorimetric 

h. Default Gray: Select a gray profile from the drop down list. You can 

also choose the load option to load a specific profile. You can choose the 

“Custom…” option for custom gray setup. 

 

Fig 12. Custom gray Setup  

 

a. Gamma: „Value box‟ for gamma gray level. Valid range is 

between (0.75 – 3.00). Available only with “Custom Gamma” 

type. 

b. Gray setup type: The available gray setup types are as 

follows. 

b a 
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o Predefine type: The available predefine types are 

“Gamma 2.2”, “Gamma 1.8”, “Dot Gain 10%”, “Dot 

Gain 15%”, “Dot Gain 20%”, “Dot Gain 25%”, and 

“Dot Gain 30%”. 

o Custom Gamma: If custom gamma type is selected, 

then use the Value box labelled (b) to enter the 

gamma value. 

o Curved based gain: When “Curve based gain…” 

option is selected following dialog will appear. 

Fig 13. Custom Dot Gain 

a. Transfer curve editing area. 

b. Gray Ramp indicating ink levels from 0% to 100%. 

c. Click here to change values of different input 

percentages. 

d. Load Button. Press this button for loading a previously saved 

TRC from the disk. 

a 

b 

c 

d e 

Handle 
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e. Save Button. Press this button to save the current TRC on the 

disk. 

Refer 
For knowing how to specify the curve, see „Transfer Curve 

Editing‟ on page 27. 

 

i. Consider readings from spectrophotometer in absolute 

colorimetry: By default, readings taken by the spectrophotometer is 

assumed relative to the media and hence in relative colorimetry. If 

producing the exact color is your target then „Check‟ this box to consider 

the readings in absolute colorimetry. 

j. Tune input for brighter output: This will produce brighter output. This 

setting will take place next time the application is launched. 

 

Specifying Spot Color Gain 
 

For spot channels/screens you can specify the spot gain by using the „Gain 

Setup‟ dialog. 

 

 

Fig 14. Gain Setup Dialog 

 

a. Gain type selection: If standard gain type option is selected, then use 

the Value box labelled (b) to enter the gain value at 50% gray level. If 

the option selected is curve based then use the „Gain Curve‟ dialog as 

shown on page 23 to specify the desired gain curve.  

b. Amount: „Value Box‟ for gain at 50% gray level. Valid gain range is 

between (-10% to 50%). 

a b 
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Print Pro uses CIE LAB as PCS (Profile Connection Space) and uses Relative 

Colorimetry.  

 

See Fig 15 to know how Print Pro color manages the images. 

 

Fig 15. Print Pro Color Workflow 

 

Refer 

In case the printer is Windows printer or output is directed to a 

Print to File printer driver, Printer Space is taken as SRGB. For 

more on SRGB visit http://www.w3.org/Graphics/Color/sRGB. 

 

 

RGB Image / Indexed Images 
 

RGB Space           PCS           Monitor / Printer Space (for printing) 
If no RGB profile is present then default RGB profile is assumed. 

 
Grayscale Images 

 
Gray Space           PCS           Monitor / Printer Space (for printing) 

If no embedded Gray profile is present then default RGB profile is assumed. 
 

CMYK Images 
 

CMYK Space          PCS          Monitor / Printer Space (for printing) 
If no embedded CMYK profile is present then default CMYK profile is assumed. 

 
Spot-Channel Gain Model 

 
Used for modeling the gain profile of the spot channels during channel 

composition. CMYK channels are not subjected to spot gain. 
 

Note: All output before transferring to printer is converted to SRGB as almost all 
windows compatible printer driver assumes the printers to be RGB printers. 

 
Print Pro doesn’t use Windows ICM in its processing pipeline. 

 

http://www.w3.org/Graphics/Color/sRGB
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Specifying RGB Setup 

Fig 16. RGB Setup Dialog 

 

a. Predefined RGB type.  

b. Custom RGB setup name.  

c. Predefined RGB phosphor.  

d. Custom RGB phosphor.  

e. White point. 

f. Custom D illuminant temperature.  

g. Custom white point.  

h. Gamma for RGB.  

i. Load RGB ICC profile.  

j. Save current RGB setup as ICC profile. 
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Transfer Curve Editing 

 

Fig 17. Transfer Curve Adjustment Dialog 

 

a. Transfer curve editing area. 

b. Gray Ramp indicating ink levels from 0% to 100%. 

c. Box listing all the channels/screens in the design showing the 

channel/screen for which settings currently are being established. 

d. Load Button. Press this button for loading a previously saved TRC from 

the disk. 

e. Save Button. Press this button to save the current TRC on the disk. 

f. Save all channels Button. Press this button to save the TRC of all 

channels together in the same file on the disk. 

g. Edit here to change values at different input percentages. 

h. Checking this option results in Print Pro using the same TRC for all the 

channels. 
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Handle 
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Editing the transfer curve 
 

Editing the Transfer Curve is a relatively easy task. 

 

Initially there is a handle corresponding to every level whose value is 

specified in the list. However as you move the mouse and click the left 

button, depending upon the mouse position, one of these handles gets 

visible (depending which is the nearest) and gets close to the clicked point. 

You can then drag the point to give the curve the shape you desire. You can 

delete / hide a handle by dragging it outside the grid area, except the first 

and the last handle. Key values are updated automatically in the respective 

position in the list as the curve is being edited. 

 

You can also provide specific output % at various input % by double clicking 

on the corresponding entry in the list. Any values entered through the list 

are also reflected on the drawn curve automatically. 

 

Pressing „Save…‟ button, you can save Transfer Pressing „Save all channels…‟ 

button, you can save Transfer Curves for all the channels in a single file as 

Print Pro‟s TRC format file on the disk for later recall. 

 

„Transfer Curve Adjustment‟ dialog is used in „Print Setup‟ dialog. 
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Color Management Options 
The menu shows the features offered by Print Pro for the color management 

tasks. 

 

Fig 18. Color Menu 

 

a. Color Management: For more details see „Color Management Dialog‟ 

on page 21. 

b. Spot color gain: For more details see „Specifying Spot Color Gain‟ on 

page 24. 
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Color Measuring Devices 
First step involved in any device calibration is to read the colors produced by 

it using various combinations of colorants. For reading these colors you need 

a color measurement device, which can be either a colorimeter or a 

spectrophotometer.  

 

Print Pro exposes these devices through a uniform interface to the user and 

these devices are supported on plug–in basis. Print Pro at present supports 

the following measuring devices. 

 

1. Gretag Macbeth‟s Eye-One Pro. 

2. Color Picker - Virtual color specify. 

 

You can use these devices to calibrate both your printer and monitor devices 

except Gretag Macbeth‟s SpectroScan, which can only be used for printer 

calibration. 

 

Both Gretag Macbeth‟s SpectroScan and Gretag Macbeth‟s Eye-One Pro 

devices can be used for automatic or semi-automatic mode of reading the 

patches under the application control. In Print Pro it is known as “Sheet 

measurement” mode and is exposed through a common interface for both 

the devices. 

 

In future new measuring devices will be added to the list. These new devices 

can be used with Print Pro by simply downloading the new drivers from 

KITL‟s Website and installing them. 

 

Fig 19. Measuring Device Selection Dialog 
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You can use the dialog shown in Fig 19 to choose one of the color-measuring 

devices from the list of supported measuring devices by Print Pro. Next step 

is to establish the settings of color-measuring device for measurement. This 

can be done by accessing the settings dialog by using Color > Colorimeter > 

Settings… menu. See Fig 20 to specify settings for Eye One Pro 

spectrophotometer. Other devices will have relevant settings dialog as shown 

in later. 

 

 

Fig 20. Eye One Pro Settings Dialog 
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Device Calibration 
Calibration essentially means measuring the characteristics of a device and 

getting it into a known state. In a color managed workflow it becomes 

absolutely essential to calibrate your input and output devices. 

 

This edition of Print Pro offers support for calibrating the following devices: 

 

1. Monitor Calibration. 
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Monitor Calibration 
In order to view colors on the monitor correctly, the monitor must be 

calibrated and its color profile must be created for use by the application.  
 

The process of bringing the monitor to a known state is called Monitor 

Calibration and measuring its capabilities is called profiling. It is important to 

calibrate the monitor before calibrating any media or scanner because; you 

will be comparing hardcopy with image displayed on the monitor. Hence it is 

imperative that your monitor is calibrated to the desired illuminant for 

achieving the best results with Print Pro. Generally this illuminant is the one 

under which hardcopy images are viewed. 

 

Choose the appropriate color measuring device and key in the proper 

settings for the device. For more details regarding how to do this refer to 

page 30.  

 

Invoke the color management dialog <ctrl> + <shift> + <k> and pull down 

the option list for monitor calibration and select the option „Custom....‟ For 

details about color management dialog refer to page 21.  

 

On selecting the option „Custom....‟ the following dialog box will appear on 

the screen.  

 

Before you begin: 

 

1. Make sure that the surface of the CRT/LCD screen is cleaned with a soft 

piece of cloth before calibration and that the screen is free of dust and 

stains. 

2. Keep the ambient light to the minimum (ideally completely dark). 

 

Both dust and ambient light have potential to adversely affect the results of 

monitor calibration.  

 

3. Clean the suction cup with a soft cloth.  

4. Do not use suction cup on LCD screen surface as it may damage the 

screen. Instead use the attachment supplied with the measuring 

instrument for taking readings on the LCD screen. 
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Fig 21. Monitor Calibration Dialog 

 

a. Profiling Speed: Select the quality of monitor profile required. 

b. Monitor Type: Specify whether you want to create profile for CRT/LCD 

monitor. 

c. Target White Point: Specify target white point you want to achieve. 

User can either select predefined white point or measure white point 

using selected spectro. 

a 

b 

c 

d 

e 

f 

g 
h 
i 
j 
k 
l 

m 
n 

o p q 



 

35 

 

Fig 22. White Point Measurement Dialog 

 

After measuring click on „Ok‟ button to use measured white point value 

as Target White Point. 

 

d. Target Luminance: Specify target luminance you want to achieve. User 

can either select predefined luminance or measure luminance using 

selected spectro. 
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Fig 23. Luminance Measurement Dialog 

 

After measuring click on „Ok‟ button to use measured luminance value as 

Target luminance. 

 

e. Desired Gamma: Specify desired gamma value you want to achieve. 

f. Import Settings From Profile: Press this button to load calibration 

settings from previously created monitor profile. 
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g. Neutralize Black: Check this box to neutralize shades of black while 

creating monitor profile. 

h. Perform display hardware setup: Check this box to allow changes in 

monitor hardware settings while creating monitor profile. 

i. Manual adjustment by visualization: Select this option if you want to 

adjust monitor hardware values manually by visual procedure.   

 

In this procedure you will visually determine the proper brightness and 

contrast settings of your monitor. The following two diagrams show the 

contrast and the brightness setting pages that you will encounter (in 

that order). 

 

Fig 24. Visual Contrast Adjustment Dialog 
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Adjust the contrast of the monitor such that the innermost light rectangle is 

just distinguishable from the outermost white rectangle and press „Next‟ 

button. 

 

Fig 25. Visual Brightness Adjustment Dialog 

 

Adjust the brightness of the monitor such that the innermost dark rectangle 

is just distinguishable from the outermost black rectangle and press „Next‟ 

button. 
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j. Manual adjustment by measurement: Select this option if you want 

to adjust monitor hardware values manually by measurement.   

 

In this procedure you will determine the proper contrast, RGB controls 

and luminance settings of your monitor by measurement. The following 

three diagrams show the pages that you will encounter (in that order). 

 

Fig 26. Manual Contrast Adjustment Dialog 
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Fig 27. Manual RGB Adjustment Dialog 
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Fig 28. Manual Luminance Adjustment Dialog 

 

k. Automatic adjustment: Select this option if you want software to 

adjust monitor hardware values automatically. 

l. Adjustment Contrast automatically: Check this option if you want 

software to adjust contrast values automatically. 

m. Adjustment RGB Controls automatically: Check this option if you 

want software to adjust RGB Control values automatically. 

n. Adjustment Brightness automatically: Check this option if you want 

software to adjust brightness values automatically. 

o. Back: Click this button to jump to previous page. 

p. Next: Click this button to jump to next page. 
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q. Cancel: Click this button to cancel monitor profiling process. 

 

White Point Calibration and Profiling 
In this procedure software will measure sample colors. 

 

Fig 29. White Point Calibration and Profiling Dialog 
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Monitor Profiling Done 
This page will display achieved White Point and Luminance values. 

 

Fig 30. Monitor Profiling Result Dialog 

 

a. Profile Options: Select which type of profile you want to create. User 

can either create matrix based / LUT based profile.  

a 

b 

c 
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Fig 31. Monitor Profile Options Dialog 

 

b. Create and save profile: Click this button to save created monitor 

profile. 

c. Finish: Click this button to end monitor profiling process. This will set 

software monitor profile to just created monitor profile. 
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47 

Printing 

Tools for Managing Printing Workflow 
Print Pro offer tools to manage your printing workflow as well as it offers 

comprehensive control over print settings of individual jobs. These are as 

follows. 

 

Tools for managing printing workflow – 

 

1. Print queue manager. 

2. Port manager. 

3. Printer driver. 

 

Let‟s understand these features one by one. 

 

Print Queue Manager 
Print Pro offers you to print multiple jobs to multiple printers simultaneously. 

The Print Queue Manager manages it. It manages a queue of jobs and jobs 

get serviced in order they come. Using this Queue Manager you can drive 

unlimited printers from the single application.  

 

However, it is generally required to constrain this number to a value, which 

will enable you to get reasonable throughput of the computer system and full 

speed of the printer(s) connected. 

 

The queue manager is responsible for simultaneous RIP and Print, RIP once 

Print many, Job order changing, deleting, holding as per the priority. Let us 

discuss the Print Queue Manager features in detail. 
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How to Use? 
You can access Print Queue Manager from Application Window by selecting 

the QueueManager > Show Queue Manager. 

 

The Queue Manager interface will appear as shown below. In order to hide 

Queue Manager Interface you can either select Queue Manager > Hide 

Queue Manager or click the close button on the top-right corner of the 

interface. 

 

Fig 32. Print Queue Manager Interface 

 

 Toolbar 

 Job queue 

 

Tool Bar 
Let‟s see the Toolbar option of Print Queue Manager. 

 

Fig 33. Print Queue Manager Tool Bar 

 

a. To load a Job in the queue. You can also do this by QueueManager > 

Load Job menu too. 

b. To add the active document i.e. currently working document. You can 

also do this by QueueManager > Add The Active Document menu too. 

c. To remove the selected job from the queue. 

d. To pause the selected job in the queue. 

e. To resume the selected job in the queue. 

a b c d e f g h i j k l 
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f. To cancel the processing of the selected jobs in the queue. 

g. To print the selected jobs in the queue. 

h. To rip the selected jobs in the queue. 

i. To save the selected job in „kprn‟ file format. 

j. To get the printer setting dialog. 

k. To get the print options dialog. 

l. Show Job Thumbnail in tool tip: Check this option to show the 

thumbnail of the ripped job. When you move the mouse on the 'Job Info' 

field of ripped job at that time thumbnail of job will be visible. If you do 

not want to display the thumbnail then uncheck this option. This option 

is helpful when you load the saved job (KPRN file) from disk and you 

want to know the content of that saved job.  

 
Fig 34. Job Thumbnail in Tool Tip 

 

Note 

KPRN files are Kothari printer files used to save the printer data 

where as PRN files are printer files written in the internal format 

needed by the printer. Printing a „kprn‟ file is very fast. 

 

Tip 
You can also left click and drag to the printer queue, the 

document that you want to add to the printer queue. 

 

Job queue 
As shown in Fig 32, Job Queue contains seven fields for each job. These 

fields are explained below, in the same order as they appear in the figure 

from left to right. 

 

1) S No.  

This field specifies the position of a job in the queue. 

2) Job Info  
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This field contains job information in tree form as shown below. To expand 

the tree, click on the plus sign. To collapse this information, click on the 

minus sign. 

 

 

 

 

 

Fig 35. Job Info Tree 

 

The job info tree contains the following information for the job. 

 

a. Name of Job: Root node of the Job Info tree specifies the name of the 

job. 

b. Job Dimension: Specify the width and height of the job in Inches. 

c. Number of Pages: This is the total number of pages in the job, 

irrespective of how many are requested to be printed. 
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d. Pages to Print: Specify the page numbers of the pages to be printed. 

Initially it shows the string 1-n (where n is the value of the Number of 

Pages field), which implies that all the pages will be printed. It is an 

editable field. You can edit this field if the status of the job is in either 

one of the Holding, Cancel or Error state. If you need to edit this field 

then enter the page numbers and/or page ranges separated by commas. 

For example if a job contains total number of 12 pages and you enter 

the string 1,3,8-12, then following pages will be printed 

1,3,8,9,10,11,12. 

e. Input Color Mode: Specify the input color mode of the job. 

f. Output Color Mode: Specify the output color mode of the job. 

g. Printer: Specifies name of printer to which the print is targeted. 

h. Media Type: Specify the media type on which job was printed. 

i. Ink coverage: Total ink used to print the current job. Ink usage unit is 

shows as per the amount of ink used. It shows the ink amount used for 

all inks individually (Optional feature). 

j. Ink cost: Cost of the ink used. You can change the ink cost by using the 

Option > Ink cost… menu command. Refer page 236. (Optional 

feature). 

k. Additional cost: User defined additional cost. For example here we 

consider pre-treatment as additional cost. You can define additional cost 

by using the Option > Ink cost… menu command. Refer page 236 

(Optional feature). 

 

3) Status Field 

This field specifies the current status of the job, e.g., Holding, Ripping, 

Printing, Saving, Pause, Resume or Error (if some error occurs during the 

processing). 

 

Other states are transient states and their Interpretation is as follows: 

 

a. Printing Composite / Screen I (Page x of n (y %)): This message 

implies that your job contains total number of n pages and page number 

x is currently being printed and y percent of it is done. Composite 

implies that current printing page contains the composite color image.  

b. Waiting to print: This implies that job is waiting for its turn to print as 

Queue Manager is already servicing the maximum jobs possible. 

c. Waiting to rip: This implies that job is waiting for ripping because 

Queue Manager already servicing to the maximum jobs possible. 

d. Waiting to save: This implies that job is waiting for saving because 

Queue Manager already servicing to the maximum jobs possible. 
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e. Printing ( Color layer 1 of Page 1 (600.00 KB/650.00 KB)), 

Spooling Composite ( Color layer 1 of Page 1 of 2 (11%) ): “Color 

layer 1 of Page 1 a (KB/MB) / b (KB/MB)” means „a‟ KB or MB of data is 

printed from total of „b‟ KB or MB of data of color layer 1 of page 1. 

Spooling Composite (Color layer 1 of Page x of n ( y% ) ) means color 

layer 1 of page number „x‟ of the total pages „n‟ is spooled to „y‟ percent. 

 

4) Approximate Print Run Time 

This field shows the approximate print run time of the job. 

 

5) Copies Field 

This field specifies the number of copies of the job to be printed. You can edit 

this field when the job is in one of the following state - Holding, Cancel or 

Error. 

 

6) Port Field 

This field specifies the port on which data will be sent. Left clicking on this 

field a drop down list of ports appears from where you can select any one of 

the port listed for printing. 

 

Refer Port Manager for more details on page 57. 

 

7) Save Location 

This field specifies the path of the file where the printer data can be saved. 

Initially this field displays the default save location. You can change this 

default save location by clicking on save location field. You can now either 

enter the path of the saving location directly in the edit box or you can 

browse for the path by clicking on Save As button as shown in Fig 36. 
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Fig 36. Save Location 

 

On clicking the Save As button a common Save As dialog appears. There you 

can give the path for storing the file. 

 

Tip 
Right clicking on the job in the job queue will give you access 

to options relevant to the current state of the job. 

 

Note 

Some of the options referred in this page (e.g. Ripping option, 

Ink Coverage, Save To File etc) are "Optional features"; so 

they may or may not be present in the software depending 

upon the version you use. 

 

Note 
Information available under several fields of the Queue 

Manager dialog may vary according to the driver selected. 

 

Selective Printing 
Selective printing allows you to print only the selected layers from the print 

job. To use this feature it is necessary to use custom driver for the printer 

and then rip the print job. After ripping the job successfully you can go on to 

print selected layers. 
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Fig 37. Selective Printing 

 

After the job has been ripped, right click on the job and from the menu that 

is displayed select „Print Selection…‟ item. This dialog allows you to select the 

desired layers. 

 

Fig 38. Print Selection 

 

In the above dialog you can select the layers and pages to print by checking 

the corresponding box. 
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Print Queue Manager Preferences 
There are more options Print Queue Manager offers as preferences to make 

printing more yielding. These are available as Print Queue Manager‟s 

Preferences. You can access „Print Queue Manager Preferences‟ by selecting 

the menu command Options > Queue Manager Preferences.  

 

Fig 39. Print Queue Manager Preferences 

 

a. After Print: There are two options either holds the job or remove the 

job from the queue after a job is printed. This field allows you to select 

one of the options either Hold Job or Remove Job. By default Print 

Queue Manager hold the job after print.  
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b. Enable Simultaneous Rip and Print: There are two ways to print a 

job either simultaneous rip and print or print the job after ripping the 

whole job. This check box allows you to enable the simultaneous rip and 

print option. By default Print Queue Manager provides simultaneous rip 

and print.  

c. Show only online/connected ports in the list: When this option is 

checked, „Port Manager‟ shows USB port only on which currently printer 

is connected. If this option is unchecked then „Port Manager‟ shows all 

the available USB printer port into the system.  

d. Use Windows Temporary File Path: Print Queue Manager creates a 

temporary file for its own use when a job is added in the queue. When 

you remove the job from the queue QueueManager removes this 

temporary file. By default Queue Manager chooses the Windows 

temporary file path for these files but you can change this file path also 

by using the browse button. Select this check box if you want Windows 

temporary file path for the creation of these temporary files.  

e. Printing thread count: There are two edit boxes provided in these 

sections which are. 

o Printing thread count: This edit box is used to specify the drive 

number of printers that can be addressed simultaneously. Maximum 

it can be 10. 

o Ripping thread count: This edit box is used to specify the number of 

jobs that can be ripped simultaneously. Maximum it can be 10. 

 

Note 

Printing and ripping thread count are "Optional features", so 

they may or may not be present in the software depending upon 

the version you use. 

 

Note 
The changed made to this dialog takes affect next time software 

is launched. 
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Port Manager 
This tool provides the Print Queue Manager with the support of talking to the 

printing devices. As we have seen in the previous topic in „Print Queue 

Manager‟ the sixth field is for port and the Port manager manages it. 

 

You can access the Port Manager form QueueManager > Port Manager.  

 

Fig 40. Port Manager 

 

a. Add: To add the new port. 

b. Remove: To remove the existing selected port. 

c. Configure: To configure the selected port. 

d. Refresh: To refresh the port tree. 

e. Finish: To close the Port Manager dialog. 

 

Port Manager is responsible to manage the following types of ports. 

a b d e c 
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File Port 
To add a file port in the list of available ports execute the following steps- 

 

i. Select the File child node of the port manager tree. 

ii. Click on 'Add' button. This will open „Add Port‟ dialog as shown in Fig 41. 

iii. Enter the folder path in which you want to generate output file. 

iv. Enter the default file extension of output file. 

v. “Generate filename by user intervention” is checked then software will 

prompt the user to provide file name. If unchecked then software 

automatically generate file name. 

 

Fig 41. Add File Port 

 

 



 

59 

TCP/IP Port 
To add a TCP/IP port in the list of available ports execute the following steps- 

 

i. Select the TCP/IP child node of the port manager tree. 

ii. Click on 'Add' button. This will open „Add Port‟ dialog as shown in Fig 42. 

iii. Select protocol to communicate with your printer. There are three 

different protocols available for the TCP/IP port. Select a protocol that is 

supported by your printer or print server. 

iv. Enter the host name or IP address of the printer / server providing LPD of 

TCP/IP port. The IP address is build by 4 blocks of numbers, which are 

separated by dots. 

v. Enter the port number on which your device listens for communication / 

enter the name of print queue on that server for LPR protocol. 

 

Fig 42. Add TCP/IP Port 

 

Note 

Please consult the manual of your printer or print server for the 

specifications which you have to enter in Port (for RAW / HP 

DirectJet or MSPort), or Name of printer or print queue on that 

server (for LPR). 
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Configuring TCP/IP Port 
You can configure the selected TCP/IP port by using the „Configure‟ button 

available in the Port Manager dialog shown in Fig 40. Configuring of a sample 

TCP/IP port is shown and explained below. 

 

Fig 43. Configuring TCP/IP Port 

 

a. Transmission Retry: This parameter lets the software know for how 

long it should carry out the time outs. 

b. Timeout: This parameter lets the software know the time interval 

between two consecutive attempts to connect to the printer. 

 

Note Transmission retry time is always greater than Timeout time. 

 

 

 

a 

b 
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Configuring USB Port 
You can configure the ports as per your requirement by pressing the 

configure button (labelled „c‟ in Fig 40) for all those ports for which this 

button is enabled. 

 

 

Fig 44. Port Configuration 

 

Timeout Setting: This parameter lets the software know the time interval 

between two consecutive attempts to connect to the printer. 
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Map Port Name 
This tool provides user friendly name to printer device physical port name. 

This is helpful to easily identify the printer port. User has a flexibility to 

specify a user defined name to an existing printer physical port. This user 

defined port name will be shown in addition to the existing ports in all the 

dialogs where printer port is required. The main advantage of this is that a 

user can give a port name which he/she can recognize easily for a given 

printer. This option is mainly useful in cases where user can get different 

port names when the device is connected to different ports (specially in case 

of USB devices.). In such cases if the user has selected the user defined port 

name for the printing port in his/her environments and after connecting the 

printer the USB port changes then if he just changes the Port mapping for 

the user defined port name to this new port then in all the jobs the new port 

will be used. 

 

You can access the Map Port Name form QueueManager > Map Port Name.  

 

Fig 45. Map Port Name 

 

a. Mapped Name: This denotes the name associated with the physical 

port of printer in the second column. It can be edited by first selecting 

the desired name and then clicking on the selected name. 

a b 
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b. Physical Port: This is the physical port of the printer. You can change 

the physical port by click on the physical port. It shows the all the 

available physical port in the drop-down list. 

c. Load port name mapping file: Press this button to load previously 

save port name mapping file (.kpm). 

d. Save port name mapping file: Press this button to save port name 

mapping file (.kpm). 

e. Add: Allows you to add a new mapping name with physical port. 

f. Delete: Allows you to delete selected mapping name from the list. 
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Printer Driver 
This edition of Print Pro offers customized printer drivers for your printing 

needs. Now onwards we will use the term Custom Driver in place of Print 

Pro Driver. 

 

Now, we will look into the details. 

 

What is Custom Printer? 
Custom printer is a collection of printer drivers for which Print Pro does not 

depend on the printer manufacturer driver but has its own driver, which 

drives the printer. Custom printer drivers have been specifically designed for 

the application specific requirements. 

 

Printer setup option for custom driver: 
You can access the „Custom Print‟ dialog by File > Print Setup or 

<Ctrl>+<Shift>+<P>.  

 

The dialog is shown in Fig 46 on the following page: 

 

This dialog has two pages accessible through the tabs named „Print 

Environment‟ and „Summary‟. 

 

Before we move further, a word on a concept called print environment. 

Print environment are the files that saves the snapshots of the settings on a 

Print setup dialog. They can be saved on the disk as „.Env‟ files.  

 

Print environment contains all the information that is needed to print with a 

certain media. It contains among other the printer driver used, Media 

properties, selected port, position from where to print etc. All data are 

selected automatically when you select the appropriate print environment. 
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Print Environment Page 

 

Fig 46. Print Environment Page 
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a. Environment name: It shows the currently loaded environment 

settings. As described earlier you can save the snap shot of a print setup 

as print environment file. Default settings of a printer are always loaded 

as “Custom”. You can select the environment from the drop-down list, 

which shows the environment entries in the tree with group name. 

 

Fig 47. Environment file list in Drop-Down list 
 

b. Manage env: This button enables a user to load to associate a generic 

name with an environment file. The user can then select the name 

associated from the name list to load the environment settings saved in 

the environment file associated with the selected name. Pressing the 

button displays “Manage Environment” dialog. For details see “Manage 

Environment” on page 69. 

c. Manage env Group: On clicking this button enables a user to manage 

the environment file into group. Pressing the button displays the "Manage 

Environment Group" dialog. Refer page 71. 

d. Load env: This button enables a user to load to a previously saved 

environment file. A print environment can only be loaded if the printer 

specified in the environment is currently present in the printer list. 

e. Save env: 'Save env' button enables a user to save all the printing 

settings into a file so that he can use this file to print another image with 

same settings in future. 

f. Printer name: It shows the currently selected driver. User can select 

another driver from the dropdown list. 

g. Properties: On clicking this button lets you to set up the properties for 

printing accessible through 4 different options as follows- 

1. Media. 



 

67 

2. Printing Ink Assignment. 

3. Color Correction. 

4. Device Options. 

 

h. Media size: This field shows the list of media (paper) supported by the 

printer. Here we can specify the page size we want to use. If the printer 

supports custom paper sizes then select one of the “User defined” paper 

sizes from the list whose size can be defined by the user by clicking the 

„User size‟ button. 

i. Source: This part basically determines from where the media is inserted 

for printing. 

j. Selected port:  It contains information about the port to which your 

printer is connected. 

k. Ink layer order: This field specifies the ink layer transfer order, means 

whether you want to print first white layer and then color layer or color 

layer and then white layer. 

l. Platen placement on printing bed: Specify how you want to place 

your platen on the printing bed. You can also specify the 'Left' and 'Top' 

position of the platen by selecting the "Custom" option from the 

dropdown list. 

m. 'Left' and 'Top' position specification of platen when 'Custom' option is 

selected. 

n. Size change caused by addition processing. 

o. Unit: This button allows the user to change the measurement unit of 

various options (like Page size, Margin, Offset…). User can also change 

the unit by clicking the right mouse button on this page and selecting the 

desired unit from the menu. The currently supported units are Inch, 

Centimeter, Millimeter and Points. 

p. Feed adjust between passes: It‟s the offset to be kept between the 

first pass and the subsequent passes. If the subsequent passes are 

having higher offset than the feed adjust will be +ve and if lower offset 

than the feed adjust will be –ve. Availability of this option will depend 

upon the selected printer. 

q.  Set as default printer: Click this button to set the current printer 

setting as the 'default' setting. 

 

Note 
You can change the unit of measurement simply by right clicking 

within the Print Environment Page. 

 



 

68 

Manage Environment  
 

What is an Environment? 
Print Pro offers you the feature of saving the printer related settings in a file 

called an environment file. Print environment contains all the information 

that is needed to print with a certain media. It contains among others the 

printer settings used, printer profile and TRC curves used, information about 

the ink slot order and the inkset used, margins, etc. All data are selected 

automatically when you select the appropriate print environment. 

 

You can save environment files of different configurations and load them 

whenever you need them. You can save environment names for env files 

which makes selecting a set of printing settings just a matter of selecting the 

environment name. This saves a lot of time spent in selecting the different 

options as per requirement every time the media or some other parameter is 

changed.  

 

The dialog shown below allows you to associate generic environment name 

with an environment file. To load the environment you need to select the 

environment name from the list. 
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Fig 48. Manage Environment Dialog 

 

a. Environment Name: This denotes the name associated with the 

environment file in the second column. It can be edited by first selecting 

the desired name and then clicking on the selected name. 

b. Environment File Path: This is the path of the environment file with 

which you wish to associate the environment name. This field can be 

modified in the same way as the environment name can be. 

c. Environment Group: This is the name of the group to which particular 

environment belongs. You can change the environment group by click on 

the group name. It shows the all the available group in the drop-down 

list as shown in Fig 49 given below. 
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Fig 49. List to change the Environment Group 

 

d. Environment File Path Browse button: You can use this button to 

provide the location from where you want to load the environment file. 

e. Environment File Path Edit box: It specifies the location of the 

environment file. You can edit the path if required. 

f. Import environment package: Click this button to invoke “Import 

environment package” dialog. For details see “Import Export 

environment package” on page 73. 

g. Export environment package: Click this button to invoke “Export 

environment package” dialog. For details see “Import Export 

environment package” on page 73. 

h. Reset environment list to factory default: Click this button to reload 

the environment list to software default.  

i. Add Env: Allows you to add a new environment name. 

j. Delete Env: Allows you to delete selected environments from the list. 

 

Right clicking in the environment list will display the following menu which 

allows you to add or delete entries.  
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Fig 50. Right Click Context Menu in Manage Env Dialog 

 

Manage Environment Group 
Manage Environment group is helpful to manage the environment files into 

the group, so you can easily identify the required environment file as per the 

environment group. The dialog used to manage the environment groups is 

shown and its related parameters are explained below. 

 

 

Fig 51. Manage Environment Group Dialog 

 

a. Name of the group.  

b. Environment‟s name present in the group.  

c. Associated group list.  
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d. Press this button to move the environment file into the selected group 

item into the associated group list. This buttons enabled only when 

appropriate environment is selected in 'Environment list' and appropriate 

group is selected in the 'Associated group' list.  

e. Add new group. You can use <Insert> key to add a new group.  

f. Remove the selected group. Environment file present into the group 

which is going to delete are moved into the 'None' group. By using 

<Delete> key you can delete the selected group. 

 

Right clicking in the environment group item or folder will display the context 

menu shown below which allows you to add, delete and rename group item 

and transfer environment into associated group. 

 

Fig 52. Right Click Context Menu in Manage Env Group Dialog 

 

Note 
You can re-group the environment file by using the <Ctrl> + 

Dragging the item and dropping it on to the new group. 

 

Note  You can not delete the item 'None' from the Environment list. 
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Import Export Environment Package  
Environment package is helpful to bundle environment name, environment 

file, associated environment group, printer profile and TRC in single package. 

This is basically used to backup and restore environment file with its 

dependent files like printer profile and TRC. So user can easily setup printing 

environment when user install/uninstall software or transfer software from 

one system to other. The dialog used to import export environment package 

is shown and its parameters are explained below. 

 

 

Fig 53. Import Export Environment Package Dialog 

 

a. Name of the group: Group has one or more environment(s) as child 

node. If you check/uncheck group then its all child node (environments) 

also get check/uncheck. 

b. Environment‟s name: Name of the environment in the group. If this is 

checked then only it will be imported / exported when you perform 

import / export task. 
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c. Printer profile: Printer profile associated with selected environment will 

get imported / exported along with the environment file when you 

import / export environment. 

d. Printer TRC: Printer TRC associated with selected environment will get 

imported / exported along with the environment file when you import / 

export environment. 

e. Import Package: Press this button to import selected environment(s) 

and its associated group, environment file, printer profile and printer 

TRC file to the relevant folder.  

 

If any environment already exists then it will prompt the user as follow: 

 

 

a. Yes: Replace the old environment with new imported 

environment. 

b. No: If you want to keep both environments then modify the 

new environment name. For details see “Modify the importing 

data” on page 75. 

c. Cancel: To skip importing this environment. 

 

Note 

If any imported item like environment file, printer profile and 

printer TRC already exists then it will prompt the user for 

corrective action. 

 

f. Export Package: Press this button to export selected group(s) and 

environment(s) in “Kothari Import Export” (.kie) file.  

g. Load exported package file: Press this button to load previously 

saved “Kothari Import Export” (.kie) file. 

h. Reset package(s) list: Click this button to reload the package list. 
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Modify import item info dialog 
If any imported item already exists in relevant folder and user wants to keep 

both items then following dialog appears: 

 

Fig 54. Modify import item info dialog 

 

a. Original imported item name: 

b. New Name of imported item: Specify the new name of imported item. 

c. Ok: Press this button to import item with specified name. 

d. Skip: Skip importing this item. 

e. Abort: Cancel importing package. 
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Summary Page 
You can take a look at the print settings summary by pressing the 

„Summary‟ tab present in the „Print Environment Page‟ dialog shown on page 

no. 65. 

 

Fig 55. Summary Page of Custom Print 

a 

c 

b 



 

77 

 

a. Summary: Summary of the settings made by the user.  

b. Underbase option: This underbase option will allow you to select 

whether the summary of the settings made by the user is for white 

underbase printing or for color data printing. This option is disabled 

when the printing is on „white printing base. 

c. Remark: Remarks specified by the user while defining the printer 

settings. 

 

Summary page shows the summary of the options selected for printing the 

document. This page shows the current printer selected, paper size used to 

print, print margins, print quality, media type used for printing, print 

resolution, currently loaded printer profile, and user remarks if any specified 

by the user while creating the print environment.  

 

Note 
You cannot change the unit of measurement simply by right 

clicking within this window. 
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Print Properties 
On pressing the button with the caption „Properties…‟ labelled as „g‟ in „Print 

Environment page‟ you will be presented with the Print Properties dialog.  

 

Print properties are grouped under 5 main categories accessible through 

individual tabs on the „Print Properties‟ dialog. These are as follows:  

 

1. Media. 

2. Printing Ink Assignment. 

3. Layers Selection. 

4. Color Correction. 

5. Device Options. 

 

Now let us discuss them one by one in detail. 
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Media Page 

 

Fig 56. Media Properties Page 

 

a. Media size: Media size shows the list of media (paper) supported by the 

printer. Here we can specify the page size we want to use. If the printer 

supports custom paper sizes then select one of the “User defined” paper 
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sizes from the list whose size can be defined by the user by clicking the 

„User size‟ button ( labelled „c‟ )  

b. Source: This is from where the media is to be inserted for printing.  

c. User size...: This button is enabled when the user selects “User 

defined” paper size from the media size list. When you click this button a 

dialog appears asking for the width and height of the new media you 

want to create. To know more refer „User Size‟ on page no. 81. 

d. Add/Remove paper...: This button is used to add the new paper size 

or you can remove the paper size which is newly added by you. For 

more details refer „Add Remove Paper Size‟ on page no. 82. 

e. Media type: It specifies the media on which user wants to print. This 

can be a user created media or a predefined media. Basically by 

selecting a new media user selects a new printer profile and TRC curves 

for printing which was selected by the user while creating that media. 

Media type can be dependant on ink type or can be independent 

depending on the printer selected. If a media type is dependant on ink 

type then only those media are shown which the selected ink type 

supports. User can still override the printer profile or the TRC curve used 

by selecting appropriate files using „Load TRC…‟ and „Load printer 

profile…‟ buttons.  

f. Ink: Ink type shows the list of ink type supported by the printer. Many 

printers have media type dependant on ink type i.e. for one media type 

you may want to select the different TRC curve and printer profile and 

for other ink type a different set.  

g. Create media...: Create media button is used to create a new media or 

remove a media created. For more details refer „Create Media‟ on page 

no. 84. 

h. Check bar options...: Use this button for the alignment of bars. For 

more details refer „Check Bar Options‟ on page no. 87. 

i. Load TRC: Use this option to change the TRC curves used for printing 

an image.  

j. Load White TRC: Use this option to change the TRC curves used for 

printing the white base for an image.  

k. Load printer profile: Use this option to select a different printer profile 

for printing. Remember always load the same number of channel printer 

profile as in the currently loaded inkset.  

l. Printer Profile: Printer Profile shows the currently loaded printer profile 

name. 

m. Intent: It specifies the rendering intent to be used with the printer 

profile. The available rendering intents are as follows. 
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a. Perceptual 

b. Relative Colorimetric 

c. Saturation 

 

n. Left Margin. 

o. Right Margin. 

p. Top Margin. 

q. Bottom Margin. 

r. Remark: Remarks are the user given comments for the given 

environment setting. The user for recalling why he made these settings 

for the environment can use this as a memory aid. 

 

Note 
You can change the unit of measurements simply by right 

clicking within the 'Media Properties' window. 

 

User Size 

Working with Non-Standard Paper Sizes 
Specify a media of a non-standard size. Enter the width and the height of the 

page and press OK denoted by the "tick" marked button. You can change the 

unit of parameters by right clicking in the area of the dialog and change the 

unit to any one of cm, inch, mm, point.  

 

Fig 57. User Size Dialog 
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Add Remove Paper Size 
In addition to that you can also save a specific user sized paper with any 

name you want by pressing the button with the caption “Add/Remove 

Paper..” labeled as „d‟ in Fig 56.  

 

Fig 58. Add / Remove Paper Dialog 

 

a. Media Size: This field shows the name of the user defined paper size.  

b. Width and Height of the media.  

c. Add Paper: Add the user defined paper size in the list. 

d. Remove Paper: Remove the paper size from the list. 

 

Note 
You can change the units of measurement simply by right 

clicking within this window. 

c d 
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Modify Paper Info 
When user selects environment software tries to load its associated paper 

info. If paper already exist with some different settings then software will 

prompt user whether to use the existing settings or overwrite the new 

settings from selected environment into its database. 

 

Fig 59. Modify Paper Info dialog 

 

a. Paper Name: Paper name associated with selected environment. 

b. Original associated info with Paper: Currently present paper info for 

the paper. 

c. New associated info with Paper: New paper info for paper. 

d. Press “Yes” button to modify paper info with the one associated with 

selected environment. 

e. Press “No” button to use existing paper info for selected environment. 
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Create Media 
Media is a combination of a TRC, a printer profile and an inkset (if applicable 

to that printer) that can be saved by the user and utilized later. On selecting 

a particular media, the corresponding TRC and printer profile are both 

loaded.  

 

To create a new media or to alter the settings of an existing media click the 

button labelled as „g‟ in Fig 56. 

  

Fig 60. Create Media Dialog 

 

a. Media type: Name of the media that can be specified by the user or can 

be selected from the drop-down list. Ink type: Name of the media that 

can be specified by the user or can be selected from the drop-down list. 

b. Ink type: Name of the media that can be specified by the user or can 

be selected from the drop-down list. 

c.  Intent: It specifies the rendering intent to be used with the profile. The 

available rendering intents are as follows. 
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o Perceptual 

o Relative Colorimetric 

o Saturation 

d. Load Profile: Specify the path of the suitable printer profile for the 

specified media. 

e. Load TRC: Specify the path of the suitable TRC curve for the specified 

media. 

f. Load White TRC: Specify the path of the suitable TRC curve for the 

specified media for printing using white base. 

g. Add media: Click on this to add the newly specified media. 

h. Remove media: Remove the current media. 

 

Note 
A user can delete all media for a given inkset except the last i.e. 

at least one media should be present for a given ink type. 
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Modify Media Info 
When user selects environment software tries to load its associated media 

info. If media already exist with some different settings then software will 

prompt user whether to use the existing settings or overwrite the new 

settings from selected environment into its database. 

 

Fig 61. Modify Media Info Dialog 

 

a. Media Name: Media name associated with selected environment.  

b. Original associated info with Media: Currently present media info for 

the media.  

c. New associated info with Media: New media info for media. 

d. Press “Yes” button to modify media info with the one associated with 

selected environment.   

e. Press “No” button to use existing media info for selected environment. 
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Check Bar Options 
Check bars are the solid color bars corresponding to each ink present in the 

currently selected inkset. They can be printed on left or right or both sides of 

the media / image while printing. The Check Bar related options can be 

defined by clicking the „Check bar options…‟ button labelled as „h‟ in Fig 56. 

 

Fig 62. Check Bar Options Dialog 

 

a. Align bars to: Select bars to align either to page‟s margin or Image. 

b. Enter the width of the bar and its distance from the image. 

c. Check bar position: Select the position of the bar. The various 

available options are as follows: 

o None: No check bars will be printed. 

o Left: Prints the check bars on the left side of the margin / image as 

specified. 

o Right: Prints the check bars on the right side of the margin / image 

as specified. 

o Both: Prints the check bars on left as well as right side of the 

margin / image as specified. 

d. Unit: Unit of measurement. 

 

Note 
You can right click anywhere within the dialog to change the 

units of measurement. 

a 
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Ink Assignment Page 
Ink assignment page contains the information about the currently loaded 

inkset used for printing. This page will show only those inksets which are 

supported by the printer i.e. if the printer is a 4 channel printer then only 

those inksets will be shown for which the number of inks in the inkset is 

equal to or less than 4. Once a proper inkset has been chosen then always 

remember to choose the corresponding printer profile. Now assign each 

channel with given slot in the printer. If you don‟t want to print using a 

channel then set that channel slot number as „None‟. Color channels marked 

for no use are ignored during printing but each specified color channel has to 

be rasterized. 

 

The page containing the „Ink Assignment Page‟ dialog is shown in Fig 63. The 

various options available in the page are explained below. 

 

a. Predefined Ink sets: List of inkset supported by printer. All the ink 

sets will have same or lesser no. of inks supported in the printer. 

b. List of the inks present in the inkset. This shows the list of available 

slots and the inks present in them according to the currently selected 

inkset. The list contains fields Channel: It specifies the ink present in 

the slot. It can be any of the inks present in the ink slot. 

c. Additional settings: These are the additional settings pertaining to the 

white ink. 

i. White Underbase: You can specify the strength of the white 

underbase along with its generation type. The various generations 

types available are: 

o Automatic: The white underbase generation will be performed 

automatically by the RIP software. 

o Channel based: The white underbase generation will be 

performed based upon some spot channel present in the image. 

The channel to be used for the underbase generation can be 

specified using the channel palette. To know more on how to 

specify the spot channel, go to channel palette on page no. 

198. 

o Combine: The white underbase will be generated by the RIP 

software automatically combining with underbase channels 

defined in the channel palette. To know more on how to specify 

the spot channel, go to channel palette on page no. 198. 

o Transparent Region: Select this option if you want the white 

underbase to be generated based upon the transparent region 

present in the image. 
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o Non Transparent Region: Select this option if you want the 

white underbase to be generated based upon the non-

transparent region present in the image. In case of printing 

from Layout region enclosed by all the images within a platen 

will be considered as a single image, and portion in this region 

not occupied by any of the images will be considered as 

transparent. 

o Full Image: Select this option if you want the white underbase 

to be generated over the entire image. 

o Gray Gradation: In this white underbase data will be generated 

as per its gray value of image data. In image where there is 

white color no white underbase will fired. 

o Inverted Gray Gradation: In this white underbase data will be 

generated as per its inverted gray value of image data. 

ii. White Highlight: You can specify the strength of the white 

highlight to be used while printing. Also how the white highlight is 

to be generated while printing can be specified by you. The 

available generation types are: 

o None: The white highlight won‟t be used during the printing. 

o Channel based: The white highlight will be applied based upon 

the white highlight channel. Fuzziness value is disabled and 

ignored. You can specify which channel to be used as white 

highlight using the channel palette. 

o On the fly: The RIP will generate the white highlight on the fly 

during ripping using the fuzziness value provided. This will 

ignore any highlight channel set otherwise in the channel 

palette. The fuzziness value works similar to the highlight 

channel creation option. 

o Combine: The RIP will generate the white highlight on the fly 

during ripping using the fuzziness value that you supply there 

and will combine it with the highlight channels set in the 

channel palette. 

 

The fuzziness value works similar to the highlight channel creation 

options. This will be disabled in the case of Channel based Highlight 

generator. 

 

iii. Underbase choke: You can specify the strength of the choke mask 

to be applied during the printing. The choke will be applied based 

upon the choke channel selected in the channel palette. 
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Fig 63. Ink Assignment Page 

 

d. Determine Ink Order: Click this button if you don‟t know the ink order 

of the printer and want to print the „Ink Order Test Patches‟. Clicking 

this button opens the dialog to print the Ink Order. For more details 

refer „Determine Ink Order Dialog‟ on page no. 92. 
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e. Restore to factory default: On clicking this option the printer setting 

in the software will restore to the factory default settings. 

f. Restore to last settings: On clicking this option the last settings that 

were set by the user, as the default will be restored. 

g. Set as default: when user clicks this button then the current setting 

will be set as the last used settings and these settings will be loaded 

automatically when the user selects this printer next time or clicks the 

button “Restore to last setting”. 

 

Note 
When the specified color order does not meet the actual color 

order in your printer "false" colors will be printed. 

 

Note 

This feature ("Ink Assignment Page") may not be available in 

some cases depending upon whether your printer supports 

modifying of printing ink assignment or not. 
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Determine Ink Order 
If you are not sure about the „Ink Order‟ of the printer then you can 

determine it using the “Determine Ink Order” button as shown in Fig 63. You 

can use this dialog to print the „Ink Order Test‟ using which the Ink order of 

the printer can be determined. 

 

Fig 64. Determine Ink Order Dialog 

 

a. Page Dimension: Specifies the dimension of a single page of the 

media. It is normally same as the size of the media on which profiling is 

being done. 

b. Patch size: Specifies the size of a single patch. 

c. Gap Dimension: Specifies the gap to be left between the consecutive 

patches in the horizontal and the vertical directions. 

d. Page offset: Specifies the offset to be left at the starting of the page 

from where the printing of the patches will start. 

e. Unit: Specifies the current unit in which the values are being shown. 

You can select any one of the available units from the drop-down list. 

f. Print: Starts the printing of the patches. 

 

Note 
Values of parameters „a‟, „b‟, „c‟ and „d‟ are in the currently 

selected unit (indicated as „e‟). 

 

In the „Ink Order Test‟ print you will observe a patch for every ink present in 

the inkset of the printer and a number printed alongside each patch. These 

numbers actually represent the „Printer slot number‟ present in the „Ink 

Assignment‟ page. So, you can assign the inks in the ink-slots according to 

the order obtained in the print. 

a d 
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Color Correction Page 
 

Fig 65. Color Correction Page 

 

a. Printer Name: Displays the name of the selected printer. 

b. Edit Profile for primaries: Check this to edit manually change the 

blends of the selected profile. 
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c. Adjust Primaries: This button pop ups the dialog which lets you adjust 

the blend manually. 

d. Printer color adjustment: Check this for color adjustment. 

e. Sliders: Use these sliders for color correction. 

f. Color booster: Adjust the percentage to increase the amount of color 

depth. 

g. Color Strength: As the name suggests it specifies the strength of the 

color you wish to use during printing. To use the full strength of the 

color set it to 100%. Otherwise you can use any intermediate value 

between 0% and 100% for your optimum quality. 

 

Note 
'Edit profile for primaries' option is only enabled when you have 

opened any image document. 

 

Primary Adjustment 

 

Fig 66. Primary Adjustment Dialog 

 

a. Manually adjust the blend of the selected profile. 

b. On clicking this button will automatically estimate the amount of color 

used for any primaries. 

c. Load the primary adjustment. 

d. Save the changes made in the primary adjustment. 

a 

b c d 
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Device Options (Epson based) 

 

Fig 67. Device Options page (Epson based) 

 

a. Printer name. 
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b. Underbase option: This underbase option will allow you to select 

whether the printing is for white underbase printing or for color data 

printing. This option is disabled when either the printing is on „white 

printing base‟ (see 'b') or „Use same settings for white base and color‟ 

(see 'p') has been set. 

c. Printing background: It allows you to select the color of the printing 

base. It can be one of the following: 

o White  

o Black  

o Color  

o Dark Color 

 

d. Resolution: This option will specify the resolution at which the user 

wants to print with his printer. The resolution is displayed in DPI. Here 

the string specifies horizontal and vertical resolution. If only one is given 

then in those cases both horizontal and vertical resolution are same. 

Higher resolutions produce graphic images that are sharper and show 

finer detail. 

e. Color appearance: Select the output color mode which is by default 

selected as 'Colored'. 

f. Microweaving: This option allows the printer to generate superior 

output because graphics data is reordered and is printed in finer 

increments. It reduces the possibility of banding, the light horizontal 

lines that can mar an image. 

g. Print Direction: This option allows you to set the printing direction. It 

can be unidirectional or bidirectional or automatic. 

h. Dot size: Using this option you can set the size of the dot for printing.  

i. Dots used: Specify the combination of dots to be used for generating 

printing data. Availability of this option depends upon “Dot size” 

selected. 

j. Wet on wet passes: Number of passes to be printed on same position. 

k. Weave overlap (in %): Specify in percentage by how much amount 

you want to overlap two passes. Specifying value greater than zero will 

reduce the banding between the passes (resulting in improved print 

quality) but will also increase the print time.  

l. Optimize Ripping: Checking this option will increase the ripping speed. 

m. Layering: Specifies the layering method. It can be any of the options 

mentioned below. 

o Multi Pass: Each layer will be printed in a separate pass. 
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o Wet On Wet OnePass: All the layers will be printed simultaneously 

in a single pass, (i.e. the layers will be printed when the other 

layers are wet and not dried yet). 

o Wet On Dry (Adaptive) OnePass: All the layers will be printed in 

a single pass, but there would be enough time for the layers to get 

a bit dried before the other layers are printed on them. 

This normally gives better results than the „Wet On Wet OnePass‟ 

method in which layers are printed even when other layers are wet. 

 

n. Layers count: Enter the no. of layers of white underbase or color data 

to be printed depending on the option selected currently. This option will 

only be enabled if you are printing layers in multiple passes. 

o. Secondary Resolution: When layers are to be printed simultaneously 

i.e. using wet on wet or wet on dry One Pass methods, the printing 

settings of each pass can‟t be specified separately. This option enables 

you to specify the resolution of the secondary passes. The available 

secondary resolutions are based upon the primary resolution set for the 

printing of the combined pass.  

p. Advanced head control (Nozzle utilization in %): This option is 

used for masking the nozzles to use for printing. By using this option we 

can disable starting and trailing nozzles of the print-head from printing. 

This option is useful in mainly 2 cases. 

o  Some of the starting or trailing nozzles are blocked, and then 

the user can mask this area and can use rest of the printhead 

for printing. 

o In case of printing on Rotary devices only small middle region 

of print-head is required for printing and in this cased user can 

mask unwanted top and trailing nozzles. 

q. Banding correction: Perform settings for media feed compensation. 

This corrects the errors in the amount of feed of the grit rollers due to 

the type of media used. Correcting the amount of feed improves the dot 

positioning accuracy in the feed direction, which can help in enhancing 

the image quality.  

r. Feed Registration offset (in mm): Registration offset (in mm) 

specifies the feed direction offset between the white ink layer and the 

color ink layer. 

s. Scan Registration offset (in mm): Registration offset (in mm) 

specifies the scan direction offset between the white ink layer and the 

color ink layer. 
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t. Dry time per scan: Specify the time (in milliseconds) for which the 

head waits before printing each line. 

u. Dry time before reprint: This setting allows the control of the amount 

of time (in seconds) after which the next layer is to be printed. 

v. Restore to factory default: On clicking this option the printer setting 

in the software will restore to the default settings.  

w. Restore to last settings: On clicking this option the last settings that 

were set by the user as the default will be restored.  

x. Set as default: When user clicks this button then the current setting 

will be set as the last used settings and these settings will be loaded 

automatically when the user selects this printer next time or clicks the 

button „Restore to last settings‟. 

 

 

 

Note 

Some of the options referred in the device options page (e.g. 

Banding Correction, Dry Time etc.) may be available / 

unavailable in your software depending upon the version you 

use. 

Note 
Wet On Dry (Adaptive) OnePass method will be available only if it 

is supported by the selected printer. 
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Device Options (File Based) 

 

Fig 68. Device Options Page (File Based) 

 

a. Printer name. 
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b. Underbase option: This underbase option will allow you to select 

whether the printing is for white underbase printing or for color data 

printing. This option is disabled when either the printing is on „white 

printing base‟ (see 'b') or „Use same settings for white base and color‟ 

(see 'p') has been set. 

c. Printing background: It allows you to select the color of the printing 

base. It can be one of the following: 

o White  

o Black  

o Color  

o Dark Color  

 

d. Resolution: This option will specify the resolution at which the user 

wants to print with his printer. The resolution is displayed in DPI. Here 

the string specifies horizontal and vertical resolution. If only one is given 

then in those cases both horizontal and vertical resolution are same. 

Higher resolutions produce graphic images that are sharper and show 

finer detail. 

e. Color appearance: Select the output color mode which is by default 

selected as 'Colored'. 

f. Compression: Compression specifies the type of compression which we 

want to apply on the files generated as the output.  

g. Dot size: Using this option you can set the size of the dot for printing.  

h. Dots used: Specify the combination of dots to be used for generating 

printing data. Availability of this option depends upon “Dot size” 

selected. 

i. Optimize Ripping: Checking this option will increase the ripping speed. 

j. Save as: This button is enabled when you have not selected “Use path 

same as that of source”. When the user selects this button then a dialog 

appears that asks you to enter the save location. 

k. Use path same as that of source: If this option is checked then the 

output files are stored in the same directory as that of the source file. 

The output file name is set as follows: <Source file name>_<source file 

extension>_<page number>_<Channel short name>.tif when this check 

is disabled then user can specify his own file name by clicking the “Save 

as” button.  

l. Create Directory for files: Check this option to create separate 

directory for the files to be saved. 

m. Overwrite old files: If the user wants to overwrite the old files 

generated then he should check this box. If the user has disabled this 

button and the file is sent for printing then if previously files with the 
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given name existed then the creation of the file will stop with an error 

message that the following files already existed.  

n. Generate unique file names in case of name clashing: This option 

is only enabled if „Overwrite Old files‟ option is disabled. It will generate 

a unique file name for saving in case of file clashing found while 

generating the files for output. 

o. Create temporary file in case of network path:  When output file 

path is network path at that time printed file is first created into the 

local system and after printing is finished that file(s) is transferred to the 

network path. Temporary file(s) is created into the folder specified in the 

„Print Queue Manager Preferences‟ (on page 55). 

p. Create compressed file for final output: Check this option if you 

want to compress the files generated as output into a single (*.ZIP) file. 

This option is very useful in saving the disk space as well as grouping of 

similar output files. 

q. Restore to factory default: On clicking this option the printer setting 

in the software will restore to the default settings.  

r. Restore to last settings: On clicking this option the last settings that 

were set by the user as the default will be restored.  

s. Set as default: When user clicks this button then the current setting 

will be set as the last used settings and these settings will be loaded 

automatically when the user selects this printer next time or clicks the 

button „Restore to last settings‟. 

  

Note 

Some of the options referred in the device options page (e.g. 

Banding Correction, Dry Time etc.) may be available / 

unavailable in your software depending upon the version you 

use. 

 

Note 
Wet On Dry (Adaptive) OnePass method will be available only if it 

is supported by the selected printer. 

 

 



 

102 

Device Options (Mutoh based) 

 

Fig 69. Device Options Page (Mutoh based) 

 

a. Printer name. 
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b. Underbase option: This underbase option will allow you to select 

whether the printing is for white underbase printing or for color data 

printing. This option is disabled when either the printing is on „white 

printing base‟ (see 'c'). 

c. Printing background: It allows you to select the color of the printing 

base. It can be one of the following: 

o White  

o Black  

o Color  

o Dark Color  

 

d. Resolution: This option will specify the resolution at which the user 

wants to print with his printer. The resolution is displayed in DPI. Here 

the string specifies horizontal and vertical resolution. If only one is given 

then in those cases both horizontal and vertical resolution are same. 

Higher resolutions produce graphic images that are sharper and show 

finer detail. 

e. Color appearance: Select the output color mode which is by default 

selected as 'Colored'. 

f. Print Direction: This option allows you to set the printing direction. It 

can be unidirectional or bidirectional or automatic. 

g. Quality: Allows the user to select the number of passes required to lay 

down one line of image on the printer. The greater the number of 

passes, the better the quality of the image. However, increasing the 

number of passes also increases the amount of time required to print 

the image. 

h. Overlay: Select predefined passes overlay effect.  

i. Dot size: Using this option you can set the size of the dot for printing.  

j. Dots used: Specify the combination of dots to be used for generating 

printing data. Availability of this option depends upon “Dot size” 

selected. 

k. Dot type: The printer firmware can automatically adjust the dot size to 

the specified resolution. But you may specify the dot size yourself using 

one of available sizes. 

l. Optimize Ripping: Checking this option will increase the ripping speed. 

m. Layering: Specifies the layering method. It can be any of the options 

mentioned below. 

o Multi Pass: Each layer will be printed in a separate pass. 

o Simultaneously: All the layers will be printed simultaneously in a 

single pass. 
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n. Layers count: Enter the no. of layers of white underbase or color data 

to be printed depending on the option selected currently. This option will 

only be enabled if you are printing layers in multiple passes. 

o. Secondary Resolution: When layers are to be printed simultaneously 

i.e. using wet on wet or wet on dry One Pass methods, the printing 

settings of each pass can‟t be specified separately. This option enables 

you to specify the resolution of the secondary passes. The available 

secondary resolutions are based upon the primary resolution set for the 

printing of the combined pass. 

p. Media type: Specifies the media type according to which correction 

value will be used. 

q. Correction: When selected media type is user defined then you can 

specify the correction value in steps of 0.01 mm. 

r. Feed Registration offset (in mm): Registration offset (in mm) 

specifies the feed direction offset between the white ink layer and the 

color ink layer. 

s. Scan Registration offset (in mm): Registration offset (in mm) 

specifies the scan direction offset between the white ink layer and the 

color ink layer. 

t. Restore to factory default: On clicking this option the printer setting 

in the software will restore to the default settings.  

u. Restore to last settings: On clicking this option the last settings that 

were set by the user as the default will be restored.  

v. Set as default: When user clicks this button then the current setting 

will be set as the last used settings and these settings will be loaded 

automatically when the user selects this printer next time or clicks the 

button „Restore to last settings‟. 

  

Note 

Some of the options referred in the device options page may be 

available / unavailable in your software depending upon the 

version you use. 
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Device Options (Generic) 

 

Fig 70. Device Options Page (Generic) 

 

a. Printer name. 
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b. Underbase option: This underbase option will allow you to select 

whether the printing is for white underbase printing or for color data 

printing. This option is disabled when either the printing is on „white 

printing base‟ (see 'c'). 

c. Printing background: It allows you to select the color of the printing 

base. It can be one of the following: 

o White  

o Black  

o Color  

o Dark Color  

 

d. Resolution: This option will specify the resolution at which the user 

wants to print with his printer. The resolution is displayed in DPI. Here 

the string specifies horizontal and vertical resolution. If only one is given 

then in those cases both horizontal and vertical resolution are same. 

Higher resolutions produce graphic images that are sharper and show 

finer detail. 

e. Color appearance: Select the output color mode which is by default 

selected as 'Colored'. 

f. Print Direction: This option allows you to set the printing direction. It 

can be unidirectional or bidirectional or automatic. 

g. Quality: Allows the user to select the number of passes required to lay 

down one line of image on the printer. The greater the number of 

passes, the better the quality of the image. However, increasing the 

number of passes also increases the amount of time required to print 

the image. 

h. Print Mode: Allows the user to select printing mode like print for high 

quality or print for high speed. 

i. Dot size: Using this option you can set the size of the dot for printing.  

j. Dots used: Specify the combination of dots to be used for generating 

printing data. Availability of this option depends upon “Dot size” 

selected. 

k. Optimize Ripping: Checking this option will increase the ripping speed. 

l. Layering: Specifies the layering method. It can be any of the options 

mentioned below. 

o Multi Pass: Each layer will be printed in a separate pass. 

o Simultaneously: All the layers will be printed simultaneously in a 

single pass. 

m. Layers count: Enter the no. of layers of white underbase or color data 

to be printed depending on the option selected currently. This option will 

only be enabled if you are printing layers in multiple passes. 
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n. Secondary Resolution: When layers are to be printed simultaneously 

i.e. using wet on wet or wet on dry One Pass methods, the printing 

settings of each pass can‟t be specified separately. This option enables 

you to specify the resolution of the secondary passes. The available 

secondary resolutions are based upon the primary resolution set for the 

printing of the combined pass. 

o. Feed Registration offset (in mm): Registration offset (in mm) 

specifies the feed direction offset between the white ink layer and the 

color ink layer. 

p. Scan Registration offset (in mm): Registration offset (in mm) 

specifies the scan direction offset between the white ink layer and the 

color ink layer. 

q. Restore to factory default: On clicking this option the printer setting 

in the software will restore to the default settings.  

r. Restore to last settings: On clicking this option the last settings that 

were set by the user as the default will be restored.  

s. Set as default: When user clicks this button then the current setting 

will be set as the last used settings and these settings will be loaded 

automatically when the user selects this printer next time or clicks the 

button „Restore to last settings‟. 

  

Note 

Some of the options referred in the device options page may be 

available / unavailable in your software depending upon the 

version you use. 
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Device Options (Aeoon based) 

 

Fig 71. Device Options Page (Aeoon) 
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b. Underbase option: This underbase option will allow you to select 

whether the printing is for white underbase printing or for color data 

printing. This option is disabled when either the printing is on „white 

printing base‟ (see 'c'). 

c. Printing background: It allows you to select the color of the printing 

base. It can be one of the following: 

o White  

o Black  

o Color  

o Dark Color  

 

d. Resolution: This option will specify the resolution at which the user 

wants to print with his printer. The resolution is displayed in DPI. Here 

the string specifies horizontal and vertical resolution. If only one is given 

then in those cases both horizontal and vertical resolution are same. 

Higher resolutions produce graphic images that are sharper and show 

finer detail. 

e. Color appearance: Select the output color mode which is by default 

selected as 'Color'. 

f. Quality: Allows the user to select the number of passes required to lay 

down one line of image on the printer. The greater the number of 

passes, the better the quality of the image. However, increasing the 

number of passes also increases the amount of time required to print 

the image. This option allows the printer to generate superior output 

because graphics data is reordered and is printed in finer increments. It 

reduces the possibility of banding, the light horizontal lines that can mar 

an image. 

g. Print Direction: This option allows you to set the printing direction. It 

can be unidirectional or bidirectional or automatic. 

h. Dot size: Using this option you can set the size of the dot for printing.  

i. Optimize Ripping: Checking this option will increase the ripping speed. 

j. Layers count: Enter the no. of layers of white underbase or color data 

to be printed depending on the option selected currently. 

k. Registration offset (in mm): Registration offset (in mm) specifies the 

offset between the white ink layer and the color ink layer. 

l. Dry time per scan: Specify the time (in milliseconds) for which the 

head waits before printing each line.  

m. Dry time before reprint: This setting allows the control of the amount 

of time (in seconds) after which the next layer is to be printed. 

n. Strength: As the name suggests the strength option is to control the 

amount of application of each individual option. 0% means no strength 
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and 100% means full strength. In past whatever you may have created 

and used with the software was at full strength 100%. Now you could 

control the application of the amount of the feature. For example, if you 

use the Choke Strength to be 50% then the choking will be applied by 

50% amount of the gray value in the corresponding channel. Similarly, if 

you use the Underbase Strength to be 50%, the underbase that will be 

printed will be half the strength that otherwise would be printed when 

this value is 100%. 

o. Use Same Settings: Allows you to set the same settings for white 

underbase and color layer(s). The option will be enabled only if you are 

printing on black or colored printing base. 

p. Highlight Generator: There are four options- 

o None: If you don't want to use "Highlight Generator" 

during printing then select this option.  

o Channel Based:  Highlight option will work as usual using 

the channels. Fuzziness value is disabled and ignored.  

o On the fly: The RIP will generate the white highlight on 

the fly during ripping using the fuzziness value that you 

supply there. This will ignore any highlight channel set 

otherwise in the channel palette. The fuzziness value works 

similar to the highlight channel creation option. 

o Combine: The RIP will generate the white highlight on the 

fly during ripping using the fuzziness value that you supply 

there and will combine it with the highlight channels set in 

the channel palette. The fuzziness value works similar to 

the highlight channel creation option. 

 

q. Highlight Fuzziness: The fuzziness value works similar to the highlight 

channel creation options. This will be disabled in the case of Channel 

based Highlight generator. 

r. Allows you to set the settings back to factory default.  

s. Allows you to restore the last settings.  

t. Allows you to set the current settings as default settings. 

  

Note 

Some of the options referred in the device options page may be 

available / unavailable in your software depending upon the 

version you use. 
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Print Settings 
Print Pro offers comprehensive control over print settings. Print setting is 

accessible through File > Print Option from the Application Window or by 

using the shortcut <Ctrl> + <T>.  

 

Fig 72. Print Options Dialog 

 

a. As in document: The image in output print is exactly of the same size 

as the document‟s dimension.  

b. Fit to page: Selecting this option results in Print Pro scaling the image 

to fit the page size. In case of Page Layout, set job sizes same as platen 

size. This option fit the job size into platen. 

c. Custom: Selecting this option allows you to adjust size or scale factor of 

the image or job.  

d. Maintain aspect ratio: Checking this option forces Print Pro to 

maintain the aspect ratio of the image. 

a 
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e. Resampling: The following resampling methods are available:  

1. Stretch and truncate: Fastest method for expansion or reduction 

of images.  

2. Bilinear: Little slower, but produces better images than stretch and 

truncate.  

3. Bicubic: Expensive, but produces best results of the three available 

methods. 

 

f. Image positioning: Use one of the predefined positions or supply the 

custom position to place the print‟s Top Left on the output. In case of 

Page Layout negative placement is allowed when 'Custom' option is 

selected in position. 

g. Mirror Image: Checking this option will mirror the image about the 

vertical axis in the print.  

h. Invert Image: Checking this option inverts the colors of the image in 

the print. 

 

 

Note 

In case of 'Page Layout' you can set placement position within 

the allowed range such that job does not goes out side the 

platen rectangle. 

 

Note 
Pixel unit is defined in the image space and appropriate scaling 

is done before printing to the printer.  
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Print Previewing 
This feature allows user to view what each page will carry when it is printed. 

User can change the settings and Preview the effect immediately. 

 

 

Fig 73. Preview Window 

m 
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Fig 74. Print Preview Toolbar 

 

a. Print the document.  

b. Printer settings.  

c. Print options.  

d. Advance to the next page.  

e. Go back to previous page.  

f. Preview single page at a time.  

g. Preview two pages at a time.  

h. Zoom In.  

i. Zoom Out.  

j. Click here to change the Background color for print previewing. After 

selecting the color background the image will look as in Fig 75. The 

background color is applied all over in the transparency part of the 

image.  

k. Context sensitive help.  

l. Cancel preview. 

 

a b c d e f g h i j k l 
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Fig 75. Image after Applying Background Color 

 

Note 
Right click anywhere inside the window to access the list of 

commonly used commands as shown below. 

 

 

 

Fig 76. Right Click Commands in Print Preview Mode 
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Page Layout 

(Optional Feature) 

 

The Print Pro RIP offers you a very reliable and handy “Page Layout” feature 

which allows the use of predefined templates for job placements. Using this 

feature you can print on white, color and black media at the same time! 

 

What is 'Page Layout'? 
There can be times when the jobs to be printed are much smaller than the 

print bed of the printer. Thus multiple such jobs can be printed at the same 

time to boost the productivity. Usually the placement of such jobs is fixed on 

the print bed. Such placements can be specified in the form of predefined 

templates (please see “Platen Organizer” on page 257). Page layout allows 

using such layout templates to do job placements. 

 

With in the same layout, the jobs placed can have input images having 

various color spaces, e.g. CMYK, sRGB, AdobeRGB, Lab etc. 

 

Page layout feature handles transparent areas of images as well (available 

with PSD or PNG). This means the images can be targeted for different 

colored backgrounds. 

 

Note 
The layout is displayed on pressing <Ctrl>+<L> or by selecting 

Layout > Open Page Layout. 
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More details on what you can do with ‘Page 
Layout’ are given below 
1. Arrange images in a single page regardless of its file format. 

2. Layout images/ jobs each having with its own color profile and color 

space (Like CMYK, RGB, Lab and Multi Channel etc). 

3. Layout the jobs on the page with more accuracy and ease with the help 

of rulers and guidelines. 

4. Open as many numbers of different page layouts template and print 

them one by one with great ease. 

5. Each job in the layout can have its own output parameters (profile, TRC, 

etc), its own underbase settings and its own white highlight settings.  

6. Allows setting placement position for film with in the job platen. If Job 

size is larger than the platen size then job is clipped as per the 

placement settings. 

7. Allows the free movement of job within the platen with keyboard and 

mouse. 

8. Allows placement of multiple job(s) within a single platen. 



 

119 

Open Layout Template 
You can create new layout only by opening the saved layout template file, 

created using “Platen Organizer” application. Refer page 257. 

 

You can open layout template file by following ways, 

 

1. Select 'Open layout template‟ from Layout setting toolbar combo. 

 

 

Fig 77. Layout List Drop Down Box 

 

2. By selecting Layout > Open layout template command from menu or 

right click context menu > Open layout template in layout view.  

3. By selecting managed layout template file list, which appears clicking on 

quick open button marked as 'C'. You can manage this list using 'Layout 

Template Management', which appears when you click on Template 

management button Marked as 'A'. You can also manage the group of 

templates using the button marked as „B‟. 

 

Fig 78. Managed Layout List 

Open Layout Template 

Active Layout 

List of Opened 
layout template 

A B 

C 
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Page Layout Controls 

 

Fig 79. Page Layout 

 

a. Layout Job Transformation toolbar. Refer page 121.  

b. Layout Job Adjustment: Refer page 123. 

c. Layout setting toolbar:  We‟ll see detail about it later in this section. 

Refer page 124 for details. 

d. Properties window: Refer page 126. 

a 

b 

c 

d 

e 

f 
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e. Job list view: Job list view contains list of jobs. We‟ll see more about it 

later in this section. Refer page 127. 

f. Layout view: Layout view is the preview of the current layout. It is the 

main working area of the page layout window. We‟ll see more about it 

later in this section. Refer page 128. 

 

Note 

You can create as many layouts as you would like and traverse 

through them using the „layout name‟ combo box in the layout 

tool bar. 

 

Layout Job Transformation Toolbar 

 

Fig 80. Layout Job Transformation Toolbar 

 

a. Add new Job in layout. The selected Job in the layout list view will be 

added. 

b. Delete selected Job(s).This will delete the all selected Jobs of layout.  

c. Link / Unlink the selected Jobs : 

 

 

When selected Job(s) are linked with native document then icon marked 

as 'a' is set and if not then icon marked as 'b' is set for button. In 

multiple selection if some Jobs are linked and some are not then icon 

marked as 'c' is set for button. 

a b c d e f g h i j k l m n o 
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d. Show/ Hide the bounding box: 

 

When bounding box around the selected Job(s) are visible then icon 

marked as 'a' is set and if not then icon marked as 'b' is set for button. 

In multiple selections, if bounding box of some jobs is visible and in 

some jobs is not visible not then icon marked as 'c' is set for button.  

e. Mirror the selected Job(s). 

f. Scale the selected Job. 

g. Change Job printing setup to custom. 

h. Change Job placement and other settings. 

i. Color substrate background visualization color.  

j. Rotate job(s) by 90 degree clockwise.  

k. Rotate job(s) by 90 degree counter clockwise.  

l. Rotate job(s) by 180 degrees. 

m. Make Same Height: Makes the height of the selected jobs in the same 

platen as equal. 

n. Make Same Width: Makes the width of the selected jobs in the same 

platen as equal. 

o. Make Same Size: Makes the width and height of the selected jobs in 

the same platen as equal. 

 

Note You can not delete or move the platens in the Page Layout. 
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Layout Job Adjustment 

 

Fig 81. Layout Job Adjustment Toolbar 

 

a. Brings the focused Job forward by one level within the platen. 

b. Brings the focused Job backward by one level within the platen. 

c. Makes the focused Job topmost (i.e. above all the other job(s)) within 

the platen. 

d. Makes the focused Job bottom most (i.e. below all the other job(s)) 

within the platen. 

e. Align left: Aligns the selected job(s) with respect to the left side of the 

focused job within the platen. 

f. Align right: Aligns the selected job(s) with respect to the right side of 

the focused job within the platen. 

g. Align top: Aligns the selected job(s) with respect to the top side of the 

focused job within the platen. 

h. Align bottom: Aligns the selected job(s) with respect to the bottom 

side of the focused job within the platen. 

i. Align center vertically: Aligns the selected job(s) with respect to the 

vertical center of the focused job within the platen. 

j. Align center horizontally: Aligns the selected job(s) with respect to 

the horizontal center of the focused job within the platen. 

k. Center vertically: Aligns the selected job(s) with respect to the vertical 

center of the platen. 

l. Center horizontally: Aligns the selected job(s) with respect to the 

horizontal center of the platen. 

 

Note 

Alignment operations „e‟ to „j‟ will be applied on the selected jobs. 

Operations „e‟ to „j‟ will be applied with respect to the focused 

job. You need to select atleast two jobs to enable the 'Alignment' 

operations. 

 

Note 
For options „a‟ to „d‟, you need overlapped images to view the 

effects after any of these are applied. 

a b c d e f g h i j k l 
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Layout Setting Toolbar 

 

Fig 82. Layout Setting Toolbar 

 

a. Open the Layout Template. 

b. To save the Layout Template. 

c. To remove layout. 

d. To change the default name of the layout. Clicking this, you will be 

presented with „Layout Rename Dialog‟. Use it to rename the layout. 

 

Fig 83. Rename Dialog 

 

e. To print the layout by Queue Manager. You can‟t modify the layout 

till it is in the queue manager. 

f. Layout current printing background type: The following drop-down 

list will appear when you click the button. 

By selecting any printing background type print setting option you can 

make it as current printer settings for layout, so when new job is 

inserted then it takes default printer settings from that current layout 

printing settings. 

 

a b c d e f g h i k l m j 
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g. Zoom In. 

h. Zoom Out. 

i. Opens Platen Organizer for template creation. 

j. Layout Name. 

k. Layout template management: It associate generic name with the 

layout template file. For more details please refer „Layout Template 

Management‟ on page no. 138. 

l. Layout Template Group management: It manages the layout 

template groups. For more details please refer „Layout Template Group 

Management‟ on page no. 141. 

m. Quick open for managed layout template file(s): The following 

drop-down list will appear as you click the button. 

 

 

This command shows the managed template file list. You can quickly 

open layout template file by selecting given generic name to template 

file path. Also you can browse the template file by selecting 'Open 

Layout Template‟. 

 

Note 
Option to open Platen Organizer may be enabled / disabled 

depending upon the version of the Print Pro you use. 

 

A B 

C 
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Properties View 

 

Fig 84. Properties View 

 

a. Platen Name. 

b. Current unit of the platen. The various dimension values will be shown 

in this unit. 

c. Left-top coordinates of the platen. 

d. Dimension of the platen. 

e. Current cursor position. 

f. The ruler offsets are the horizontal and vertical offset of the layout 

rulers from left top margin of the page. 

 

Property window shows some important properties of the selected platen in 

the layout. 

 

At the top it shows the platen name. If multiple or none of the platens are 

selected then it shows appropriate message as per selection type. 

 

Then comes the unit in which all other elements are displayed. Here in this 

example the unit used is inch. You can change unit by selecting required unit 

from right click context menu. 

Next, Left and Top offset of the selected platen is displayed. These offsets 

are from the left of margin and top margin of the layout template page. Then 

height and width of the selected platen is shown. 

 

Cursor position shows the current cursor position with respect to the ruler. 

The left and top offset of the current platen is also in ruler co-ordinate space. 
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Job List View 
The job list view on the lower left side of the page layout window shows all 

the jobs present in currently opened documents in Print Pro. This list gets 

updated automatically whenever you open a new document or close an 

already existing one. This view shows only relevant jobs. 

 

Fig 85. Job List View 

 

In the list a document with „*‟ after its name denotes that it is an imported 

document or Unlinked document. 

 

If you try to close a document, which has at least one job present in any of 

the page layouts, Print Pro will warn you about the same and ask for 

permission to close it any way. If you close the document, the jobs from this 

document in all the layouts in which it is present will be removed. 

 

The fly-over tip in the job list view shows the respective job size in inches 

apart from job name and type if the cursor is placed above the job‟s name.  

 

When the cursor is above a document name then fly-over tip shows the full 

path name of the document. If this document is created by Print Pro and you 

have not saved it yet, the tool tip will say that this is „Not a disk file‟. 

A number inside the braces beside the job name indicates how many copies 

of this job are in the current layout. E.g., “TCROPSEP1.psd (2)” tells that the 

job named „TCROPSEP1‟ has got two copies in the current layout. 
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Layout View 

 

Fig 86. Layout View 

 

The layout view shows preview of the current layout. This shows all the 

job(s) in the page at their respective positions with thumbnail. The gray 

rectangle inside the page indicates the page margin. 

 

To select a job by the platen or to toggle among several jobs in the layout 

view you can either click on the Job or use the <Tab> key. 

 

To move a job, drag the job while holding the <Ctrl> key. You can also use 

< Up > or <Down> or <Left> or <Right> keys for moving the job(s). Note 

that a job will be move with respect to the top-left of the platen in which it is 

present. E.g. consider the third platen. If you press the <Up> and <Down> 

A 

Platen 

Job(s) 

Margin 

Empty 
Platen 

Guide 
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keys, then the selected job(s) will move in the horizontal direction rather 

than the vertical direction, because its top-left corner is rotated by 90 

degrees and the movement of the job(s) is done with respect to that corner. 

Similarly the movement of jobs(s) within different platens are dependent on 

the top-left corner of the individual platens. 

 

To change print options Use <Alt> + <Enter> keys simultaneously to get the 

print option property sheet of the selected job. You can also double click on 

the job with <Shift> key pressed to open the same. In this property sheet 

only those options relevant to the layout is enabled. 

 

By right clicking on the job you can scale, translate and rotate in steps of 

90°. (Popup menu > Scale This Job…). Use the handles around the job to 

move its edges. Drag inside the bounding box to move the job. While 

dragging to restrict the movement to steps of 45° hold <Shift>. While 

dragging an edge of the bounding box use <Shift> to maintain the aspect 

ratio and use <Alt> to get reflection around the center. You can also move 

the center if you want. 

 

Fig 87. Transformation of Job 

 

Film in 

transforming 
state 
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You can scale the image on a selected platen by double clicking on it while 

holding the <Ctrl> key. 

 

During transformation operation you can cancel it by pressing <Esc> key or 

using menu command   Right click > Cancel Transformation. To commit a 

transformation use <Enter> key or double click inside the bounding box or 

use command Right click > Apply Transformation. 

 

You can also select the job(s) from one platen and copy them to any other 

platen by dragging them onto the other platen keeping the <Ctrl> + <Alt> 

keys pressed together. The top-left of the copied job(s) will be updated as 

per the new platen to which the job(s) are copied. 

 

Job in the layout can be rotated in steps of 90°. To rotate a job use the right 

click menu commands or during transformation of job rotate using mouse 

move. 

 

Initially the ruler origins are aligned with page margins (left and top). You 

can change this origin by dragging the cursor from the box marked as „A‟ in 

Fig 86. To reset the origin to the left top of page margin double click in „A‟.  

 

To create guide Drag the cursor from the horizontal or vertical ruler and drop 

in position where you want the guide. You can use <Alt> key to rotate the 

guide 90°. You can also add a guide by using the menu command View > 

Guides > New Guides…  

 

To move a guide Drag the guide while holding <Ctrl> key.  

 

To delete a guide move the guide out of the page. To delete all the guides 

use menu command View > Guides > Clear Guides. 

 

Moving in between job list view & layout view 
 

Using Keyboard:  

 

Use <Spacebar> + <Tab> keys to move to and fro.  

 

Using Mouse:  

 

Click on the appropriate view. 

 

Note You can not Move, Delete or Copy platen(s) in layout view. 
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Using Layout Option 

 

Fig 88. Layout Option Dialog 

 
a. Check to show bounding box around the platen. 

b. Normal: Non-selected platen bounding box color. 

c. Selected: Selected platen bounding box color. 

d. Focused: Focused platen bounding box color. 

e. New Job remains linked to native document or unlinked when inserted 

into layout. 

f. Show unlinked document into tree: This option allows you to show 

or hide unlinked document into the job list view. When unlinked 

document is visible into job list view you can add new Jobs of that 

unlinked document into another layout. 
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Menus and Submenus for Page Layout 

 

Fig 89. Layout Menu 

 

a. Printer Setup: Using this command you can change printing settings for 

each background type. 

b. Job Print Setup: Using this command you can synchronize selected jobs 

with any of the printing background type printing settings or set 

customized printing settings. 

c. Open/Close Page Layout: To show and hide the page layout. Shortcut 

<Ctrl>+<L>. 
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d. Add Job: Clicking on this menu will add a single copy of the selected 

original image into all the selected platen(s) in current Layout. Refer to 

Fig 90 for better understanding. If you want to add the image two times, 

you have to click on this menu two times. This function can also be 

achieved by pressing the <Insert> key. 

 

Fig 90. Job List View for Composites 

 

e. Delete Job: To delete the job/s in your layout, press <Ctrl> and left 

click on the image that you want to remove/ delete from layout. The 

particular image will be selected. Then, press „Delete‟ button. The job 

will be removed from the layout. You can also press the <Del> key. 

f. Unlink from native doc: Using this command you can link/unlink the 

selected job(s) with the native doc. 

g. Show/Hide Bounding box: Using this command you can show/hide 

bounding box of selected platens. 

h. Rotate: Using this command option you can rotate selected job(s) in 90 

degree clock wise, 90 degree anti clock wise and 180 degree. 

i. Arrange Jobs: Using these commands you can bring the selected job 

one to the above or below of the other job(s) present in the same 

platen. 

j. Align Jobs: Using these commands you can align the jobs with respect 

to the focused object and the platen as per your requirement. 

k. Layout Print Setup: When you click on this menu item it shows the 

current printing base type printer setup settings. 
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l. Layout Template Manager: When you click on this menu item it 

shows Layout Template Management dialog. 

m. Layout Template Group Manager: When you click on this menu item 

it shows Layout Template Group Management dialog. 

n. Open Layout Template: Using this command you can open saved 

layout template file. 

o. Save layout Template: This command saves the current layout 

template in *.klt format. 

p. Delete Layout: This command delete the current layout. 

q. Select Layout: When you click on this menu item it drop down the 

layout list combo in Layout setting tool bar. 

r. Layout Option: Refer “Using Layout Option” on page 131. 
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  Commands   Short Keys 

Open / Close Page Layout  Ctrl + L 

Open Layout Template  Ctrl + Shift + O 

Adding up job in layout  Insert 

Delete a job  Del 

Select a job in layout  Ctrl + Left Click on that particular job 

Select layout  Ctrl + F 

Zoom In  Ctrl + + 

Zoom Out  Ctrl + -- 

Print Layout  Ctrl + P 

Layout Print Setup  Ctrl + Shift + P 

Job Property  Alt + Enter or Shift + Double click on job  

Select All job(s)  Ctrl + A 

Deselect all job(s)  Ctrl + D 

Bring to Front Shift + Ctrl + ] 

Bring Forward Ctrl + ] 

Send Backward Ctrl + [ 

Send to Back Shift + Ctrl + [ 

Align left Shift + Ctrl + Left Arrow 

Align Right Shift + Ctrl + Right Arrow 

Align Top Shift + Ctrl + Up Arrow 

Align Bottom Shift + Ctrl + Bottom Arrow 

Fig 91. List of Shortcuts 
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Adding jobs to the Layout 
By dropping the necessary files from the Windows Explorer or from the „File 

Browser‟ tab into the layout. This will add job into job list view. 

 

New job is added into all the selected platen(s). 

 

a. By double clicking on the appropriate job from the list on the left pane. 

b. Selecting the job and clicking „Add‟ button on the layout tool bar. 

c. Selecting the job and pressing <Enter>. 

d. Selecting the Job and pressing <Insert>. 

e. By Dragging the Job from Job list view and Dropping on the Platen. 

 

These controls will remain disabled initially because there are no jobs 

selected in the job list. You can determine a job‟s size in inches from the fly-

over tip by placing the mouse cursor above the job name in the job list view. 

 

Note 
If any job is already present into platen and you add new job on 

that platen, then previous job is automatically deleted. 

 

Placing a job in the Layout View 
Adding a job places it in selected platen. Then you can move it to anywhere 

within the platen rectangle. 

 

Use zoom-in and zoom-out commands on the layout tool bar to get a proper 

view of the page in use. 

 

To move a job by using the keyboard, you need to select it first. Then use 

the arrow keys in your keyboard to move the selected job in appropriate 

direction. For faster displacement, use <Shift> key in combination with these 

keys. 

 

If you want to use the mouse, click the left mouse button inside the desired 

job rectangle and drag it with mouse button still down to the location of your 

wish. 

 

Note 
Print Pro constraints the placement of the jobs within the platen 

rectangle. 
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Selecting a job in the Layout View 
Using Keyboard: 

 

You can navigate through the jobs by pressing the <Tab> key. Press <Shift> 

+ <Tab> to navigate in the opposite direction. 

 

Using Mouse:  

 

Click inside the rectangle that represents the desired job. Press <Shift> key 

along while clicking to select a job that is hidden (overlapped) by another 

job. 

 

Selecting multiple jobs: 

 

Press <Shift> key along with <Ctrl> and mouse click to select multiple jobs. 

 

You can also use <Ctrl>+<A> to select all the jobs in the layout. You can 

use <Ctrl>+<D> to deselect the jobs. 

 

You can also select multiple jobs by drawing a selection rectangle starting 

form the blank space in the layout while holding the <ctrl>key down. All the 

jobs having at least 8% of their area in the selection rectangle get 

selected. 

 

You can also toggle the selection status of the jobs inside the selection 

rectangle by holding the <Shift> key down in the operation as described 

above. 

 

While performing any select operation with <Shift> key down, it results in 

toggling the selection status of the job in question. 

 

Multiple selections allow you to align various jobs with respect to each other. 

 

Note You can delete selected job(s) by using the <Del> key. 
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Snapping 
To place job(s) and guides easily Print Pro snaps the moving guide to the 

nearest hot edge. In case of guide movement this hot edge is the nearest 

border or halfway mark of a Platen. This snapping facility for the current 

moving object can be overridden by holding <Shift> key while dragging the 

guide. 

 

Layout Template Management 
Layout template management feature allows you to manage list of saved 

layout template file for quick access. 

 

When ever you click on the button layout management button in layout 

setting tool bar, shown as „A‟, it will show the dialog shown in Fig 93 for 

maintaining the template file list. Dialog to manage the group of templates is 

shown when you click on button shown as 'B'. Managed list of template is 

shown in pop up menu when you click on button shown as 'C'. 

 

Fig 92. Template Management in Layout Setting Toolbar 

A B 

C 
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Fig 93. Layout Template Management Dialog 

 

a. List of managed template files: It shows Template name in first 

column and template file path in second column. You can edit the 

information by double clicking on the item. When you double click on 

template file path column it shows edit box with browse button.  

b. Template Path: Specifies the path where the template is located. 

c. Template Group: Specifies the group to which the selected template 

belongs. You can select any group from the available list of groups. 

d. Export Layout Template Package: Click this button to invoke “Export 

layout template package” dialog. For details see “Import Export 

environment package” on page 73. 

e. Import Layout Template Package: Click this button to invoke “Import 

layout template package” dialog. For details see “Import Export 

environment package” on page 73. 

b 

a c 

h g f e d 
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f. Reset layout template management info to the factory defaults. 

g. Add new layout template: Adds new layout template information.  

h. Delete layout template: Deletes selected layout template information. 

 

Right clicking in the list will display the following menu to delete and add 

layout templates. 
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Layout Template Group Management 

 

Fig 94. Layout Template Group Management Dialog 

 

The dialog used to manage the group of templates is shown above. The 

dialog can be obtained by choosing the menu command Layout > Layout 

Template Group Manager. The various options available in the dialog are 

explained below. 

 

a. Template Group: It is the tree like structure containing the groups and 

the templates belonging to those groups. The different branches of the 

tree indicate the group‟s name and the leaves of the branch indicate the 

templates contained within the group. 

b. Context Menu: It contains the various options pertaining to the group 

which are: 

o Add Group: Adds a new layout template group. 

o Delete Group: Deletes the selected template group from the groups‟ 

list. 

b 

a 

c 

e d 
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o Rename Group: Enables you to rename the selected template 

group. 

o Transfer Template: It enables you to transfer the templates within 

groups. 

c. Associated groups list: It shows the list of all the added template 

groups. 

d. Add layout template group: Adds a new layout template group. 

e. Delete layout template group: Deletes the selected template group 

from the groups‟ list. 
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Open Document from Job List View 
When ever you are importing image or unlink job(s) from native document in 

layout the newly imported/created document is shown into job list view 

(Unlinked shown only when 'Show unlinked document into tree' option is 

checked in Layout Option). But if you want to perform operation(s) on that 

document, like applying filter, changing printer settings, then you need to 

open that document. 

 

Fig 95. Open Document from Job List View 

 

To open imported document or unlinked document (marked with '*' in Job 

list view), right click on the document name shown into the job list 

view. This will show the context menu to open document. 

 

By selecting menu item 'Open Document', the selected document will be 

opened into the application. 

 

This feature is helpful when you have applied some filters on job and that job 

is unlinked. Now you want that document for further use, then by opening 

document from job list view you can perform operation on it. 
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Channel Palette in Layout 
By using channel palette in layout you can change the channel visibility, 

channel type related data of the selected job(s). 

 

 

Fig 96. Channel Palette in Page Layout 

 

You can change channel type of selected job(s) by selecting option from the 

right click context menu on the channel in channel palette. 

 

Note 

Support for “Direct channel firing” is an optional feature that 

may or may not be available in your software depending upon 

the version you use. 
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Printing a Layout 
To print the currently active layout, click „Print  the layout‟ on the layout 

toolbar or Right click on active layout and select Print layout command. 

 

Print Option for Layout 
Print option allows you to set placement setting, size and other printing 

related option for selected job. 

 

Fig 97. Print Option Dialog 

 

a. As In Document: Set job sizes same as document size. 

a 

b 

c 

h 

d 

e 

f 

g 
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b. Fit to page: Set job sizes same as platen size. This option fit the job 

size into platen. 

c. Custom: You can set size, scale factor manually. 

d. Maintain aspect ratio: Checking this option forces Print Pro to 

maintain the aspect ratio of the job. 

e. Position: Placement position of job. 

f. Custom Placement Position: You can set placement settings as per 

your requirement. In layout negative placement is allowed. You can set 

placement setting within the allowed range such that job does not goes 

out side the platen rectangle. 

a. Mirror Image: Checking this option will mirror the job about the 

vertical axis in the layout. 

g. Invert Image: Checking this option inverts the colors of the job in the 

layout. 

 

Layout Print Settings 
Printing setting of each background type need to set appropriately otherwise 

you are not able to print layout. 

 

Here you can change each base printer settings by selection appropriate 

base settings option from menu.  If you select option from Layout setting 

tool bar button then current printer setting base is changed and it shows on 

the button.  But if you select option from right click context menu then active 

base type setting is not changed. 

 

Here, Black Base, White Base, Color Base and Dark Color Base settings 
options are available for substrate printing. 

 

In each background base settings printing base in device option tab must be 

set as per the option name. 

 

Note 

If you change inkset related settings, port settings and other 

printing parameters then it is reflected into other three printing 

background printer settings. 

 

There are four different kinds of print settings as you click on the „Print 

Setup‟ button on the layout setting toolbar. 
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Fig 98. Print Setup Button on Layout Setting Toolbar 

 

a. Black base settings: Change the print settings for black substrate.  

b. White base settings: Change the print settings for white 

substrate.  

c. Color base settings: Change the print settings for color substrate.  

d. Dark Color base settings: Change the print settings for dark color 

substrate. 

 

Whenever you are printing layout and if printing settings are not appropriate 

then you will get the error message and based on that error message you 

can identify which printing background settings are not matched and which 

field is not appropriate in that printing settings. 

 

Here from printing settings dialog you can not change the page size and 

other parameters which affect the page size. 

 

Note 

In case of „Page Layout‟ you can not change the Page size of 

layout any way. All the controls in „Print Setup‟ will remain 

disabled which affects the page size of the layout. 

 

Job Printing Settings 
Job print settings command allows you to set printing settings for job as per 

printing background type. 

Job print settings allows you to set printing background, printing Media type, 

Printer profile, TRC curves, color correction data and printing background 

related data for each job. 

 

You can use printer settings of layout for job directly, by selecting printing 

background type settings option from job print settings menu as per required 

printing background type. 

a 

b 

c 

d 
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If you are using any layout printer settings for job then when any change 

made in the printing settings of layout then it is automatically reflected into 

the job print settings. E.g. Job is using white base type settings and you 

change any parameters in white base type print settings of layout then it is 

reflected into job printing settings. 

 

Fig 99. Screen Print Setup Option in Menu 

 

If you select custom print settings for job then you can specify printing 

related parameters individually for each job. 

 

You can set custom settings by selecting 'Use custom print setup...' from 

menu or clicking on the layout job transformation button, shown below with 

circle around it. 

 

 

Fig 100. Custom Print Setup for Job 

 

When you select 'Use custom print settings' it shows the printing setting 

dialog. Using that dialog you can change printing related settings for job. 
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Custom Print Properties for Job 

 

Fig 101. Print Environment Page for Job Print Setup 

 

a 
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a. Printer name: Selected printer name. 

b. Media type: Specifies the media on which user wants to print. This can 

be a user created media or a predefined media. Basically by selecting a 

new media user selects a new printer profile and TRC curves for printing 

which was selected by the user while creating that media. Media type 

can be dependent on ink type or can be independent depending on the 

printer selected. If a media type is dependent on ink type then only 

those media are shown which the selected ink type supports. User can 

still override the printer profile or the TRC curve used by selecting 

appropriate files using „Load TRC…‟ and „Load Printer profile…‟ buttons.  

c. Ink type: Shows the list of ink type supported by the printer. Many 

printers have media type dependent on ink type i.e. for one media type 

you may want to select the different TRC curves and printer profile and 

for other ink type a different set.  

d. Create Media: This button is used to create a new media or remove a 

media created. Refer page 84. 

e. Check bar options: Use this button for the alignment of bars. Refer 

page 87. 

f. Load TRC: Use this option to change the TRC curves used for printing 

an image. 

g. Load Printer Profile: Use this option to select a different printer profile 

for printing. Remember always load the same number of channel printer 

profile as in the currently loaded inkset. 

h. Load White TRC: Use this option to change the TRC curves used for 

printing the white base for an image. 

i. Printer Profile: It shows the currently loaded printer profile name.  

j. Intent: It specifies the rendering intent to be used with the profile. The 

available rendering intents are as follows. 

o Perceptual 

o Relative Colorimetric 

o Saturation 

 

k. Horizontal Size change by addition processing. 

l. Vertical Size change by addition processing. 

m. Use default: This command loads the default settings, which are same 

as the layout printer settings as per the current printing background 

type. 
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Ink Settings 

 

Fig 102. Ink Settings Job for Job Print Setup 

 

a 
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a. Additional white ink settings: These are the additional settings 

related to the white ink. You can specify the strength, generation type 

and fuzziness (where applicable) for white underbase, white highlight 

and underbase choke. 

 

For more details please refer page no. 90. 

Color Correction Page 
See “Color Correction Page” for more detail on page 93. 
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Device Options for Job Printer Settings 

 

Fig 103. Device Options for Job Print Setup 

 

a 
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a. Printing Background: It allows you to select the color of the printing 

base. It can be any one of the following. 

o White 

o Black 

o Color 

o Dark Color 

 

Note 

If multiple Jobs are selected then focused job's printing data is 

filled into above dialogs for displaying. Also when settings are 

applied then all the selected job's printing settings changed as 

per the new settings. 
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Filters 

What are Adjustment filters? 
These filters make adjustments in the pixel color, based either some 

statistical property of the image or on its color value or a combination of 

both. 

 

Print Pro offers the following two types of filters: 

 

A. Based on statistical information of the image: 

1. Levels 

2. Auto Levels 

3. Auto Contrast 

4. Curves 

5. Equalize 

6. Threshold 

 

B. Based on the pixel color value: 

1. Brightness / contrast 

2. Color Balance 

3. Hue / Saturation / Lightness 

4. Desaturate 

5. Channel Mixer 

6. Invert 

7. Posterize 

8. White Highlight Channel 

9. White Underbase Choke Mask 

10. Add Transparency channel 

 

C. Assign Profile: It‟s not a filter. It is used to apply an ICC profile to the 

image using which the image is displayed and printed. 

 

D. Histogram: Technically not a filter, but only displays the statistical 

information of the image. 
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In General, filters with tuneable properties will show an options dialog, where 

you can fine tune the filter‟s specific option(s). Each such options dialog will 

have a preview check box in common as shown in the figure below. 

 

 

Check this box to view the effect of the settings in the options box online. 

 

Making Color Adjustments 
You can access these filters by invoking the appropriate submenu from the 

Adjustment menu or alternatively by using the appropriate shortcut key. 

 

Fig 104. Adjustment Menu 

 
The following details regarding each of these filters will help you in choosing 

what filter to apply. 
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Levels 
You can correct the tonal range and color balance of an image by adjusting 

the levels of intensity of the image‟s shadows, midtones and highlights. 

Levels dialog can visually guide you to adjust the important tones in an 

image. You can also save and load a particular set of levels parameters from 
within the dialog. 

 

Choose Adjustment > Levels… or the keyboard shortcut <Ctrl>+<E> to 

open the levels dialog.  

 

Fig 105. Level Adjustment Dialog 

 

a. Output slider  

b. Image level histogram 

c. Input slider 

 
Using Levels to set highlights, shadows, and midtones: 

 

a 

b 

c 
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By moving the inputs sliders, you can set the highlights and shadows in an 

image to the first group of pixels on both ends of the Levels histogram. This 

results in the mapping of these pixels (the darkest and the lightest) to black 

and white, increasing the tonal range of the image and improving the overall 

contrast. For making adjustments to the midtones intensity values use the 

middle Input slider. 

 

Fig 106. Levels Filter Sample 

 

To adjust tonal range using levels: 

 

1. Invoke the levels dialog. 

2. To adjust tones for a specific color channel, choose an option from the 

Channel menu.  

3. To adjust the shadows and highlights, do one of the following:  

 Drag the black and white Input Levels sliders to the edge of the first 

group of pixels on either end of the histogram. You can also enter 

values directly into the first and third Input Levels text boxes. 

 Drag the black and white Output Levels sliders to define new 

shadow and highlight values. You can also enter values directly in 

the output levels text boxes.  

 

For example, suppose your image pixels cover only the range 0-X for 

some X < 255. If the input slider is dragged to X, pixels with intensity 

values of X and higher are mapped to 255; pixels with lower intensity 

values are mapped to corresponding lighter values. This normalization 

lightens the image, increasing the contrast in highlight areas. 
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Suppose instead you want to decrease the contrast in the image then 

you will have to drag the Output Levels slider to X, pixels with intensity 

values of 255 are remapped to X, and pixels with lower intensity values 

are mapped to corresponding darker values. By doing this, you will 

darken the image because of decrease in contrast in the highlight areas. 

4. Click OK.  

5. To view the adjusted histogram, reopen the Levels dialog or open the 

Histogram Dialog. 

Auto Levels 
This filter will automatically set the shadows and highlights in an image. It 

defines the lightest and darkest pixels in each color channel as white and 

black and then redistributes intermediate pixel values proportionately. Since, 

this filter manipulates each channel individually it might introduce or 

eliminate color casts.  Auto Levels gives good results when an image with an 

average distribution of pixel values needs a simple contrast adjustment or 

when an image has an overall color cast. 

 

Choose Adjustment > Auto Levels or keyboard shortcut <Shift> + <Ctrl> + 

<E> to apply auto-levels to an image. 

 

The effect of applying the Auto Levels is shown below. 

 

Fig 107. Auto Levels Filter Sample 
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Auto Contrast 
The Auto Contrast command adjusts the overall contrast and mixture of 

colors in an image automatically. Since auto contrast filter does not 

manipulate individual channels it won‟t eliminate or introduce color casts. 

After applying this filter, highlights will become lighter and shadows will 

become darker. 

 

Auto Contrast can improve the appearance of many photographic or 

continuous-tone images. It does not improve flat-color images. 

 

To use the Auto Contrast command, choose Adjustment > Auto Contrast or 

the keyboard shortcut <Alt> + <Shift> + <Ctrl> + <E>. 

 

The effect of applying the Auto Contrast is shown below: 

 

Fig 108. Auto Contrast Sample 
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Curves 
Like the Levels dialog, the Curves dialog lets you adjust the entire tonal 

range of an image. However, instead of making adjustments using only three 

variables (highlights, shadows, midtones), with Curves you can adjust any 

point along a 0-255 scale while keeping up to 16 other values constant. 

Using curves you can make accurate changes to individual color channels in 

an image. You could save the currently defined curve or load a previously 

saved curve from within the dialog. 

 

Choose Adjustment > Curves... or the keyboard shortcut <ctrl> + <shift> + 

<M> to invoke the curves dialog. 

 

Fig 109. Curves Dialog 

 

a. Click here to select a particular channel.  

b. Click here to draw the curve in free hand using the mouse. 

 

a 

b 
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To adjust the color balance of the image, choose the channel (or channels) 

you want to adjust from the Channel menu. 

Do any of the following to adjust the curve: 

 

1. Click on the curve to define the point and move the points around for 

changing the shape of the curve. 

2. You can use the pencil tool provided in the dialog to draw the curve 

using the mouse. 

 

Equalize 
The Equalize command redistributes the brightness values of the pixels in an 

image so that they more evenly represent the entire range of brightness 

levels. 

 

You might use the Equalize command when a scanned image appears darker 

than the original and you want to balance the values to produce a lighter 

image. You could use equalize and histogram in combination to compare the 

brightness before and after applying equalize filter. 

 

To use the Equalize command: 

 

Choose Adjustment > Equalize… 

 

Threshold 
The Threshold command converts grayscale or color images to high-contrast, 

black-and-white images. You can specify a certain level as a threshold. All 

pixels lighter than the threshold are converted to white; all pixels darker are 

converted to black.  

 

To use this command, choose Adjustment > Threshold…. This opens the 

Threshold dialog. 

 

The Threshold dialog displays a histogram of the luminance levels of the 

pixels in the current image. 
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Fig 110. Threshold Dialog 

 

Drag the slider below the histogram until the threshold level you want 

appears at the top of the dialog, and click OK. 
 

Brightness / Contrast 
The Brightness / Contrast command lets you make simple adjustments to 

the tonal range of an image. Unlike Curves and Levels, this command makes 

the same adjustment to every pixel in the image. The Brightness / Contrast 

command does not work with individual channels and it is advisable not to 

use it for high-end output because there could be a loss in the image details.  

 

To use the brightness/contrast command: 

 

Choose Adjustment > Brightness/Contrast... 
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Fig 111. Brightness / Contrast Dialog 

 

Color Balance 
The Color Balance command changes the overall mixture of colors in an 

image for generalized color correction. 

 

Fig 112. Color Balance Dialog 

a 
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a. Select the tonal range to be changed from here. 

 

Choose Adjustment > Color Balance… or use the keyboard short-cut <Ctrl> 

+ <B> to use the Color Balance command: It opens the Color Balance 

dialog. 

 

 Make sure the composite channel is selected in the Channels palette. 

This command is available only when you're viewing the composite 

channel e.g. RGB and not R & B alone.  

 Open the Color Balance dialog. 

 Select Shadows, Midtones, or Highlights to select the tonal range on 

which you want to focus the changes. 

 Select Preserve Luminosity to prevent changing the luminosity values in 

the image while changing the color. This option maintains the tonal 

balance in the image. 

 Drag a slider toward a color you want to increase in the image; drag a 

slider away from a color you want to decrease in the image. 

 You can also provide values for the parameters in the text box provided 

alongside every slider. 

 

Hue/Saturation/Lightness Adjustment 
The Hue/Saturation command lets you adjust the hue, saturation, and 

lightness of the entire image or of individual color components in an image. 

There are two ways this filter could be used: 

 

1. To give a tint to the whole image.  

2. To adjust the hue/saturation.  

 

To use this filter: 

 

Choose Adjustment > Hue/Saturation… or use the keyboard short-cut <Ctrl> 

+ <U>. It opens the Hue/Saturation/Lightness dialog. 
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Fig 113. Hue/Saturation/Lightness Dialog 

 

To use the Hue/Saturation/Lightness command: 

 

1. Open the „Hue/Saturation/Lightness‟ dialog. The two color bars in the 

dialog represent the colors in their order on the color wheel. The upper 

color bar shows the color before the adjustment; the lower bar shows 

how the adjustment affects all of the hues at full saturation. 

2. For Edit, choose which colors to adjust:  

 Choose Master to adjust all colors at once.  

 Choose one of the other preset color ranges listed for the color you 

want to adjust. An adjustment slider appears between the color 

bars, which you can use to edit any range of hues.  

 If you tick the colorize option, you won‟t be able to make 

adjustments for individual hue areas.  

 

3. Tick the colorize option to give a tint to the image. 

4. For Saturation, enter a value or drag the slider to the right to increase 

the saturation or to the left to decrease it. Values can range from -100 

to +100. 
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5. For Lightness, enter a value or drag the slider to the right to increase 

the lightness or to the left to decrease it. Values can range from -100 to 

+100. 

 

To modify the range of an adjustment slider: 

 

1. Choose an individual color from the Edit menu in the dialog.  

2. Do any of the following to the adjustment slider:  

 Drag one of the white bars to adjust the amount of color fall-off 

without affecting the range.  

 Drag the area between the triangle and the vertical bar to adjust 

the range without affecting the amount of fall-off.  

 Drag the center area to move the entire adjustment slider, selecting 

a different color area.  

 Drag one of the vertical white bars next to the dark gray area to 

adjust the range of the color component. Increasing the range 

decreases the fall-off, and vice versa.  

 Ctrl-drag the color bar so that a different color is in the center of 

the bar. 

Fig 114. Adjustment Slider Dialog 

 

a. Adjusts fall-off without affecting range.  

b. Adjusts range without affecting fall-off. 

c. Moves entire slider. 

d. Adjusts range of color component. 

 

3. To edit the range by choosing colors from the image, select the 

eyedropper tool  in the dialog and click in the image. Use the 

eyedropper + tool to add to the range; use the eyedropper - tool to 

subtract from the range. 

 

Note 
Always select the Eyedropper from the Tool Palette before 

editing the range of colors from the image. 
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Desaturate 
The Desaturate command converts a color image to a grayscale image in the 

same color mode. For example, it assigns equal red, green, and blue values 

to each pixel in an RGB image to make it appear grayscale. The lightness 

value of each pixel does not change. 

 

This command has the same effect as setting Saturation to -100 in the 

Hue/Saturation dialog. 
 

To use the Desaturate command: 

 

Choose Adjustments > Desaturate or the keyboard shortcut <shift> + 
<ctrl> + <U>. 

 

Channel Mixer 
The Channel Mixer command lets you modify a color channel using a mix of 

the current color channels. With this command, you can do the following: 

 

 Make creative color adjustments not easily done with the other color 

adjustment tools. 

 Create high-quality grayscale images by choosing the percentage 

contribution from each color channel. 

 Create high-quality tinted images. 

 Swap or duplicate channels. 

 

To mix color channels 

1. In the Channels palette, select the composite color channel. 

2. Choose Adjustment > Channel Mixer…. The „Channel Mixer‟ dialog 

appears on the screen. 
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Fig 115. Channel Mixer Dialog 

 

3. For Output Channel, choose the channel in which to blend one or more 

existing (or source) channels. 

4. Drag any source channel's slider to the left to decrease the channel's 

contribution to the output channel or to the right to increase it, or enter 

a value between -200% and +200% in the text box. Using a negative 

value inverts the source channel before adding it to the output channel. 

5. Drag the slider or enter a value for the Constant option. This option adds 

a black or white channel of varying opacity; negative values act as a 

black channel, positive values act as a white channel. 

6. Select Monochrome to apply the same settings to all the output 

channels, creating a color image that contains only gray values. 

 

Use the Channel Mixer with the Monochrome option applied to control the 

amount of detail and contrast in the images you plan to convert to grayscale.  

 

If you select and then deselect the Monochrome option, you can modify the 

blend of each channel separately, creating a tinted appearance. 



 

170 

Invert 
The Invert command inverts the colors in an image. You might use this 

command to make a positive black-and-white image negative or to make a 

positive from a scanned black-and-white negative. 

 

When you invert an image, the brightness value of each pixel in the channels 

is converted to the inverse value on the 256-step color-values scale. For 

example, a pixel in a positive image with a value of 255 is changed to 0, 

and a pixel with a value of x to 255-x. 

 

To use the Invert command, choose Adjustment > Invert or by using 

keyboard shortcuts as <Alt> + <Ctrl> + <I>. 

 

Posterize 
The Posterize command lets you specify the number of tonal levels (or 

brightness values) for each channel in an image and then maps pixels to the 

closest matching level. For example, choosing two tonal levels in an RGB 

image gives six colors, two for red, two for green, and two for blue. 

 

This command is useful for creating special effects, such as large, flat areas 

in a photograph. Its effects are most evident when you reduce the number of 

gray levels in a grayscale image. But it also produces interesting effects in 

color images. 

 

Fig 116. Posterize Dialog 

 

To use the Posterize command, choose Adjustment > Posterize...  and enter 
the number of tonal levels you want and click OK. 



 

171 

White Highlight Channel Creator 

 

Fig 117. White Highlight Channel Creator 

 

To use the White Highlight Channel creator command: 

 

Choose Image > Add White Highlight Channel....  
 

Strength as the name suggests the amount by which to reduce the gray 

value representing the amount of white ink for the pixel under consideration. 

This value is constant for all the pixels of the image. 100% represents full 

strength, whereas 0% represents no inking. 

 

Fuzziness determines the selection of the colors that are near to white. Large 

value will include more colors that are away from white. 

 

Tip 
Usually a Fuzziness value of 15 and strength value of 255 

works well for most classes of images. 
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White Underbase Choke Channel 
Choking / shrinking white underbase choke could be required while printing 

on non-white background (like black or colored or dark colored 

substrates). In these cases, the white underbase layer sometimes peeks 

through the color layer printed above it causing objectionable image quality. 

This is more visible at the image edges. The reason may be related to ink 

spreading or chemical composition of inks or mechanical limitations or 

incorrect layer gap between the white & color ink layers. So it becomes 

necessary to shrink this white ink layer by some amount so that it never 

peeks beneath the color layer. To shrink this white ink layer we apply 

the white underbase choke. 

 

To use the choke feature: 

1. Load any image. 

2. Select the correct printing mode. Please note in case of black 

background, profile also has an impact on the choke mask generated. 

 

Choose Image > Add WhiteUnderbase choke.... You will get the dialog shown 

below that will help you create the boundaries. 

 

Fig 118. White Underbase Choke Channel Creator 

 

Choke boundary can be defined as number of pixel wide. This number can be 

in fraction of the pixel. The white pixels edges in the image are however 

spared from being choked. See the example shown below. 
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Fig 119. Sample Test Image 

Advance Dialog 
By default white pixels are defined as RGB 255,255,255. You can specify the 

starting values in the Advance dialog. In that case the white pixels will be 

defined as per range from the RGB value defined in the Advance dialog to 

RGB 255, 255, 255. 

 

Fig 120. White Area Cut Offset 

 

Note 

On the Device Option tab of the printer properties dialog, there is 

a setting that can be used to control the strength of the choke. 

The range is between 0....255. 255 is the maximum choke 

strength. 
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Note 

You can create multiple choke channels and combine them by 

setting their visibility on. Print Pro will combine these channels 

into the single choke channel during the print. 

 

White Underbase Choke Mask Channel 
In some portion of the artwork where the elements of the design are very 

thin, applying choke could remove the white all together from the underbase 

and as a result color data printed will not be visible depending upon the color 

of the substrate. In such cases, you would want not to apply choke in these 

areas or in other words mask the white underbase in such portion of image 

from Choking. This is where „White underbase choke mask‟ is useful.  

 

The use is simple. Create a spot channel in your design software with 

completely white background. On the portion of the image, where you do 

not want to apply the choke mark the portion in „Black‟ color. The 

shades of gray will mask the choke partially.  

 

Ensure that you mark this channel as “White underbase choke mask” in Print 

Pro. 

 

 
 

 

 

Fig 121. White Underbase Choke Mask Channel 

 

Note 
Make sure to designate this channel as “White underbase choke 

mask” in Print Pro. 

 

(Image type where Choke 

Mask may be needed) 

 

(This is how Choke Mask 

Channel may look like) 
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Note 
You can‟t create this channel in Print Pro. This Channel needs 

to be created as Spot Channel inside Image editing software. 

 

Add Transparency Channel 
Transparent images are useful when you are not certain of the page 

background color on which your image will be displayed, or you intend to 

display your image in front of a complex background rather than a single 

background color. It also helps you to knock out some colors which you don‟t 

want to print on image without the intervention of other software. 

 

To use this tool, either go to Image > Add Transparency Channel or press   

<Ctrl> + <Shift> + <T>.  

 

Fig 122. Add Transparency Channel 

 

In this dialog, you can select the color that you want to make transparent by 

clicking on the color bar shown in the dialog. The color picker dialog will be 

popped-up in which you can select the color from the color window, or 

manually enter the color values. Instead of remembering the color values, 

simple press the <Ctrl> key. The eyedropper is ready to pick the color from 

the image and drag it on the color bar of the dialog. 

 

Strength: Strength is defined as transparency depth. Using this you can 

make the selected color portion 100% transparent by entering 100 in 
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strength edit box or semi – transparent by entering 50 in the strength edit 

box. 

 

Fuzziness: Enter the value for color distance from 0 to 200. Enter the low 

value (say 0) to match the exact color value that you want to make 

transparent. Higher value will make the broader range of selected color to be 

transparent. 

 

On pressing the “OK” button, one channel named as “Transparency1” will be 

created in the channel palette.  

 

Consider the image shown below. 
 

Fig 123. Image With Transparent Channel 

 

If you want to print on any color substrate, the white background will be 

printed which looks like the patch in the printing. To avoid this type of the 

printing problem, knock off the white background using this tool. 
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Histogram 
Other than Filters the Adjustment menu has one more command of 

“Histogram”. 

 

A histogram illustrates how pixels in an image are distributed by graphing 

the number of pixels at each color intensity level. This can show you whether 

the image contains enough detail in the shadows (shown in the left part of 

the histogram), midtones (shown in the middle), and highlights (shown in 

the right part) to make a good correction. 

 
Choose Adjustment > Histogram... 
 

The histogram gives a quick picture of the tonal range of the image. Below 

figure shows an image and its corresponding histogram. If you hover the 

mouse pointer over the histogram you will see the corresponding statistics of 

that portion of histogram. You can also select a portion of the histogram to 
see the statistics of that selected portion. 

 

Fig 124. Histogram 

 

Statistical information about the intensity values of the pixels appears below 

the histogram: 

 

1. Mean: Represents the average intensity value. 

2. Standard deviation (Std Dev): Represents how widely intensity values 

vary. 

3. Median: Shows the middle value in the range of intensity values. 
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4. Level: Displays the intensity level of the area underneath the pointer. 

5. Count: Shows the total number of pixels corresponding to the intensity 

level underneath the pointer. 

6. Percentile: Displays the cumulative number of pixels at or below the 

level underneath the pointer. This value is expressed as a percentage of 

all the pixels in the image, from 0% at the far left to 100% at the far 

right. 

7. Pixels: Represents the total number of pixels used to calculate the 

histogram. 

8. Cache Level: Shows the setting for the image cache. If the Use Cache 

for Histograms option is selected in the Memory and Image Cache, the 

histogram displays more quickly and is based on a representative 

sampling of pixels in the image (based on the magnification), rather 

than on all of the pixels (equivalent to a cache level of 1). Deselect this 

option if you want to check for posterization in the image. 
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Assign Profile 
The Assign Profile command lets you choose the ICC profile using which the 

image is to be rendered, both while displaying and printing the image. This 

option is only available for the images having RGB or CMYK color modes. 

This command is very useful when you want to see the result of applying 

different profiles to the image and then choosing the most suitable profile for 

the image according to your requirement. 

 

To use the Assign Profile command, choose Adjustment > Assign Profile….  

 

 

Fig 125. Assign Profile Dialog 

 

a. Don‟t manage document‟s colors: Ignores the ICC profile embedded 

in the image document and displays the image according to the default 

working RGB profile if the image is in RGB color mode and CMYK profile 

if the image is in CMYK color mode. 

b. Working profile: Displays the image according to working RGB profile 

if the image is in RGB color mode and CMYK profile if the image is in 

CMYK color mode. 

c. Profile: Shows the list of ICC profiles currently installed on the system 

and also the ICC profile embedded in the image if any. The user can 

select any of the profile present in the list or can also load an ICC profile 

from any other location. 

b 

a 

c 
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The Application Interface 

In this chapter, we will look at the general interfaces and other features 

offered by Print Pro for carrying out the task of printing images. 
 

The Application Window 

 

Fig 126. Application Window 

a b c d e f 
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a. Menu bar. 

b. Tool bar. 

c. Tool Palette (Eye Dropper, Selection Tool, Pan tool, Zoom tool). 

d. Design Window: Shows the composite design output. Right click 

anywhere in the window to access the list of commonly used commands. 

e. Application background: Double click here to get the „File Open 

Dialog‟. 

f. Channel Palette: Lists all the channels present in the design. 

 

Menu Bar 
List of commands offered by Application „Menu bar‟. 

 

File Menu Commands 

 

Fig 127. File Menu 

a 

b 

c 

d 

e 

f 

g 

h 

i 

j 

k 

l 



 

183 

a. Open: Open a design document. Refer „Supported File Formats‟ on page 

239. 

b. Save As: Save the design document in either of bmp, Jpeg, Pcx, Png, 

Psd, Psb Tiff or Tga format. 

c. Close: Close the active design document. 

d. Load Print Settings: Load Printer settings from the file for the active 

design document. 

e. Save Print Settings: Save Printer settings of the active design 

document to a file. Refer „About PST Files‟ on page 240. 

f. Save Print Settings As: Enables saving printer settings with another 

name. Refer „About PST Files‟ on page 240. 

g. Print: Print the active design document.  

h. Print Preview: Preview the active design document, with page layout 

etc.. 

i. Print Options: Print settings for the active design document.  

j. Print Setup: Printer settings. 

k. Recent active windows: Last accessed design documents. 

l. Exit: Exit Print Pro. 

 

Edit Menu Commands 

 

Fig 128. Edit Menu 

 

a. Undo / Redo: Use this command to restore the change, when any filter 

is applied on the image.  

b. Step Forward: To get the next series of changes applied by filters on 

any image.  

c. Step Backward: To get the previous series of changes applied by filters 

on any image. 

 

a 

b 
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Image Menu Commands 

 

Fig 129. Image Menu 

 

a. Rotate 90 CW: Rotate the image by 90 degrees in Clock Wise 

direction. A new document is created in this case.  

b. Rotate 90 CCW: Rotate the image by 90 degrees in Counter Clock 

Wise direction. A new document is created in this case.  

c. Rotate 180: Rotate the image by 180 degrees. A new document is 

created in this case.  

d. Rotate...: Rotate the image by user specified angle and options. A 

new document is created in this case.  

e. Flip Horizontal: Flip the image horizontally. A new document is 

created in this case.  

f. Flip Vertical: Flip the image vertically. A new document is created 

in this case.  

g. Skew Horizontal: Skew the image horizontally by desired degree. 

A new document is created in this case.  

h. Skew Vertical: Skew the image vertically by desired degree. A new 

document is created in this case. 

i. Add White highlight channel. Refer page 171. 

j. Add White Underbase Choke. Refer page 172. 
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k. Add Transparency channel. Refer page 175.  

Adjustment Menu Commands 
See „Making Color Adjustments‟ on page 156. 

 

Selection Menu Commands 

 

Fig 130. Selection Menu 

 

a. Create/ Delete selection: To Create/ Delete the selection.  

b. Show / Hide selection: To Show / Hide the selection.   

c. Crop: Crop the selected portion as a new document.  

d. Transform Selection: Resize the selection. 

 

Color Menu Commands 
See „Color Management Options‟ on page 29. 

 

a 
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Queue Manager Menu Commands 

 

Fig 131. Queue Manager Menu 

 

a. Show/Hide Queue Manager: To Show/ Hide the Queue 

Manager interface.  

b. Add The Active Document: To add the active document to the print 

queue.  

c. Add All Opened Documents: To add all the opened documents to the 

print queue.  

d. Load Job...:  To load a job from the disk.  

e. Port Manager...:  To access the port manager. 

f. Map Port Name:  Opens the „Map Port Name‟ dialog. For more details 

on the dialog refer page no. 62. 

 
Note See also Chapter on „Printing‟ on page 47. 
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Options Menu Commands 

  

Fig 132. Options Menu 

 

a. Print preferences: These are the settings that are assigned by default 

to a job whose print settings are not set even once. See also „Using Print 

Preferences‟ on page 231. 

b. General Preferences: Settings for cache and scratch space. See also 

„General Preferences‟ on page 10. 

c. Queue Manager Preferences: See „Print Queue Manager Preferences‟ 

on page 55. 

d. Default Post script settings: See „Default Post script settings‟ on page 

233. 

e. Custom Printer Preferences: Check details on page 232. 

f. Change custom printer list:  

g. Ink Cost: Refer page 236 for more details. 

h. User default folder path: Refer page 235 for more details. 

 

Note 

Support for PDF and PS file formats is an optional feature that 

may or may not be available in your software depending upon 

the version you use. 
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View Menu Commands 

 

Fig 133. View Menu 

 

a. Toolbar: Shows or hides the toolbar. 

b. Custom Print Toolbar: Shows or hides the Printer settings toolbar.  

c. Layout Job Transformation Toolbar: Shows or hides the Layout Job 

Transformation Toolbar. Refer page no. 121 for more details. 
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d. Layout Job Adjustment Toolbar: Shows or hides the Layout Job 

Adjustment Toolbar. Refer page no. 123 for more details. 

e. Layout setting Toolbar: Shows or hides the Layout Setting Toolbar. 

Refer page no. 124 for more details. 

f. Status Bar: Shows or hides the status bar. 

g. Channel Palette:  

 

Fig 134. Channel Palette in View Menu 

 

 Show/Hide the channel palette. 

 Show/Hide the channel thumbnail view. 

 

h. Show/hide Tool Palette: See „tool palette‟ on page 197. 

i. Show/hide Notepad: See „Notepad‟ on page 216. 

j. Show/hide Info palette: See „Info palette‟ on page 201. 

k. Show/hide Q Rip: See „Q Rip‟ on page 229. 

l. Show/hide File browser: See „file browser‟ on page 217. 

m. Show/hide Passive Queue: See „Passive Queue on page 218. 

n. Zoom to Fit: Zoom the active design to fit the window size that is 

containing it. 

o. Zoom In: Zoom in the active design. 

p. Zoom Out: Zoom out the active design. 

q. Image Info: Image related information. See also „Image Info‟ on page 

206. 

r. Show Rulers: Show / Hide the rulers for the current document. 

s. Show Current Operation InfoTip: Show / Hide the current operation 

info tip. Refer „Current Operation InfoTip‟ on page no. 209. 

t. Guides:  

 

Fig 135. Guides in View Menu 
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i. Lock Guides: Locks all the guides in the document. 

ii. Show Guides: Shows / Hides the guides in the document. 

iii. Clear Guides: Removes all the guideline(s) from the document. To 

clear an individual guideline, drag and drop the guideline over the 

ruler. 

iv. New Guide: Adds a new guide line at the specified position in the 

layout. 

 

Fig 136. Add New Guide Dialog 

 

you can specify the position at which you want to add the new 

guideline along with the orientation of the guideline. 

 

u. Reset Toolbars: Resets the position, visibility state and floating state of 

all toolbars. 
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Language Menu Commands 
The Language menu offers the following commands, which enables you 

to run the application in different languages as per your choice: 

 

Fig 137. Language Menu 

 

As shown in the above dialog, the 'Language menu' may offer several 

languages from which you can select any one in which you would prefer to 

run the Print Pro application. 

 

Note  

The "Language Menu" command will be available only when 

your version of software supports multiple languages.  

Options in this menu may differ according to the languages 

supported by your version of software. 
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Window Menu Commands 

 

Fig 138. Windows Menu 

 

The Window menu offers the following commands, which enable you to 

arrange multiple views of multiple documents in the application window:  

 

a. Close: Close the current file in use.  

b. Close All: Close all the opened files.  

c. Cascade: Arranges windows in an overlapped fashion.  

d. Tile: Arranges windows in non-overlapped tiles.  

e. Arrange Icons: Arranges icons of minimized windows.  

f. Window 1, 2...: It shows the list of all the opened documents. You can 

go to any of the opened windows by clicking on it. 
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Help Menu Commands 

 

Fig 139. Help Menu 

 

The Help menu offers the following commands, which provide you assistance 

with this application: 

 

 Help Topics: Offers you an index to topics on which you can get help. 

 Print Pro Manual: Opens the Print Pro user manual. 

 About Print Pro...: Displays the copyright notice and version number of 

this application. 
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Toolbar 
Toolbar provides shortcuts to the most commonly used menu commands. 

 

Fig 140. Application Window Toolbar 

 

a. Open a design document. 

b. Print the active design document. 

c. Printer settings. 

d. Print options for the active design document. See also chapter on 

„Printing‟ on page 47. 

e. Preview the active design document, with page layout etc. See also 

chapter on „Printing‟ on page 47. 

f. Image related information. See also „Image Info‟ on page 206. 

g. Settings for cache and scratch space. See also „General Preferences‟ 

on page 10. 

h. Color management settings. See also chapter on „Color Management‟ 

on page 20. 

i. Spot color gain. See „Specifying Spot Color Gain‟ on page 24. 

j. Click here to set the color in which you want to view the white 

highlight channel data. 

k. Open or close the Layout session interface. 

l. About Print Pro. 

m. Context sensitive help. 

n. Exit Print Pro. 

a b c d e f g h i j k l m n 
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Printer Settings Toolbar 

 

Fig 141. Custom Print Toolbar 

 

a. Choke. 

b. Underbase Choke. 

c. White Highlight. 

d. Color Strength. 

 

„a‟, „b‟, „c‟ and „d‟ options are strength related options. Color strength is 

used to control the amount of application of each individual option. 0% 

means no strength and 100% means full strength. In past whatever 

you may have created and used with the software was at full strength 

i.e. 100%. Now you could control the application of the amount of the 

feature. For example if you use the Choke Strength to be 50% then the 

choking will be applied by 50% amount of the gray value in the 

corresponding channel. Similarly, if you use the Underbase Strength to 

be 50%, the underbase that will be printed will be half the strength that 

otherwise would be printed when this value is 100%. 

 

e. Highlight Generator: It can be any of the four available options. 

i. None: If you don't want to apply 'Highlight Generator' feature, then 

select this option. 

ii. Channel Based: Highlight option will work as usual using the 

channels. Fuzziness value is disabled and ignored. 

iii. On the fly: The RIP will generate the white highlight on the fly 

during ripping using the fuzziness value that you supply there. This 

will ignore any highlight channel set otherwise in the channel 
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palette. The fuzziness value works similar to the highlight channel 

creation option. 

iv. Combine: The RIP will generate the white highlight on the fly 

during ripping using the fuzziness value that you supply there and 

will combine it with the highlight channels set in the channel 

palette. The fuzziness value works similar to the highlight channel 

creation option. 

 

f. Highlight Fuzziness: The fuzziness value works similar to the highlight 

channel creation options. This will be disabled in the case of Channel 

based Highlight generator. 

g. Color booster: Adjust the percentage to increase the amount of color 

depth. 

h. Horizontal Position: specifies the offset with which the page will be 

printed. 

i. Vertical Position: specifies the offset with which the page will be 

printed. 

j. Pallet Size: specifies the currently selected pallet size. 

k. Environment: Environment name shows the currently loaded 

environment settings. As described earlier you can save the snap shot of 

a print setup as print environment file. Default settings of a printer are 

always loaded as “Custom”. 

l. Manage env: Manage env button enables a user to load to associate a 

generic name with an environment file. The user can then select the 

name associated from the name list to load the environment settings 

saved in the environment file associated with the selected name. 

Pressing the button displays “Manage Environment” dialog. Refer page 

68 for more details. 

m. Manage env Group: Manage env Group button enables a user to 

manage the environment file into group. Pressing the button displays 

the „Manage Environment Group‟ dialog. Refer page 71 for more details. 
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Tool Palette 

 

Fig 142. Tool Palette 

 

a. Eye Dropper Tool: The eyedropper tool samples color to designate a 

new foreground or background color.  

b. Selection tool: Use this tool to create a selection (Use <Shift> + 

<Click> to open „Creating Selection‟ dialog).  

c. Pan tool: Use this tool to navigate through the design.  

d. Zoom tool: Zoom in or out the design. Press <Alt> key along with the 

mouse click to zoom out. 

 

a b c d 
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Channel Palette 

 

Fig 143. Channel Palette 

 

a. Channel Information.  

b. Channel Visibility.  

c. Channel Thumbnail.  

d. Channel Name.  

e. Channel Type*.  

f. Channel Color. 
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g. Right click Context Menu: It is the context menu obtained on right 

clicking on any of the channels of the image. Using this menu you can 

specify the channel type. The available channel types are as follows:  

o Default: The channel will act same as that in the original image 

without any modification done for the printing. 

o Transparency: The channel will act as a transparent channel. 

o White highlight: The channel will be used for printing the white 

highlight. 

o White Underbase: The channel will be used for printing the white 

underbase. 

o White Underbase Choke: The channel will be used for printing the 

white underbase choke. 

o White Underbase Choke Mask: The channel will be used for printing 

the white underbase choke mask. 

o Modify channel options: Choose this option to modify the selected 

channel related options. You can specify the solidity (strength) of 

the selected channel using this dialog. 

 

Fig 144. Channel Options Dialog 

 

a. Name: Name of the channel you clicked. 

b. Solidity: Select the solidity (or, „Channel fill opacity‟ or simply „Opacity‟) 

that you wish to provide to the selected channel. If you wish to convert 

a particular spot(S)/ transparency(T) channel into a direct firing 

channel(D), then channel solidity (opacity) must be equal to „0 (zero)‟. 

A layer's opacity determines to what degree it obscures or reveals the 
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layer beneath it. A layer with 1% opacity appears nearly transparent, 

while one with 100% opacity appears completely opaque. 

 

* Legends: A- Alpha, + - Additive (e.g. RGB), - - Subtractive (e.g. CMYK), E 

– Encoded (e.g. LAB), T - Transparent, H - White Highlight, W – White 

Underbase , C - White Underbase Choke, M – White Underbase choke mask, 

S – Spot. 
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Info Palette 
Info palette lets you know the color value of the pixel below the mouse 

pointer when the mouse hovers over the image. The info palette also shows 

a visual color sample of that pixel color and much more. Info palette lets you 

compare the color value of a pixel in two different color spaces 

simultaneously. 

 

Info palette is capable of providing all of the following information: 

 

 The numeric value (Grayscale, RGB, HSB, CMYK, Lab and LCH) of the 

color beneath the mouse pointer in two different color spaces 

simultaneously. 

 The opacity value for the pixel below the pointer. 

 The x and y-co-ordinates (in inch/cm/mm/points/pixels) of the pointer. 

 The width, height and the anchor point, when a region of the image is 

selected using the selection tool. You can view this information in all 

basic units (inch, cm, mm, points and pixels). 

 

When you use any color adjustment dialog (for example, Curves), the Info 

palette displays the before and after color values of the pixels beneath the 

pointer. 

 

You can view the info palette by choosing the command View > Show Info 

from the menu. 

 

You can use the info palette to see the color value of pixels of the image 

under the pointer. It also shows the width and height of the selected portion 

in units that are being used in the rulers. 
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Fig 145. Info Palette 

 

The info palette is shown above along with the details of the information 

available from the info palette. 

 

a. Tracks actual color value.  

b. Tracks user chosen color value.  

c. Shows a visual sample of the pixel color.  

d. Tracks cursor co-ordinates below mouse pointer.  

e. Tracks selection width and height.  

f. Shows anchor position of the selected area. 

 

By default the top-left cell shows the color value in the color mode of the 

image and the top-right cell displays in Lab. 
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Info palette after applying color adjustments filters: 
The info palette lets you know the current pixel color as well as the pixel 

color before applying filters ( if applied ) simultaneously. A sample palette 

window after making color adjustments is shown below. 

 

Fig 146. Info Palette after Applying the Filters 

 

The color sample patch is divided into two parts. The left part of the sample 

box shows the original color and the right part shows the color after the 

adjustment. The numeric values also denote the color value in 

“original/current” format. 
 

Using different options in info palette: 
a. You could change the color space in which the numeric values of the 

color are displayed at any point of time using the menu provided with 

these cells. The menu will be presented to you when you press the   

button in the cells denoting the color values. 
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Fig 147. Info Palette with Menu 

 

The menu has the items listed below: 

 

1. Actual color: This selection will show the color value in the current 

color mode of the image. 

2. Different color spaces: You are also given the option to view the 

color value in grayscale, RGB, HSB, CMYK, Lab and LCH mode. 

3. Opacity: You can select this option if you want to view the opacity 

of the pixel below the pointer. 

 

b. You will see a tick mark besides the option using which the color value is 

being viewed currently. You can change the units in which you are 

viewing the mouse co-ordinates, the width and height of selection and 

the anchor point of the selection. You need to click on the button 

provided in their respective cells to change the units. You are provided 

the options to view them in inches, cm, mm, points and pixels. You can 

click on the buttons ,  and   in the window to view the units 

menu. Changing the units using any of these buttons will change the 

units in all the cells. 
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Fig 148. Info Palette with Unit Menu 
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Other Features 
Let‟s take a closer look at the other features that provide useful support to 

rest of the application components. 

 

Image Info 

 

Fig 149. Image Information Dialog 

 

The information about the design selected for printing can be obtained 

collectively from the Image information dialog which can be accessed from 

View > Image Info. This information includes file name along with the path, 

file type, dimensions of the design, design resolution and design mode. 

 

Note Right mouse click allows the dimension unit to be changed. 
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Creating Selection 

 

Fig 150. Selection Tool 

 

a. Style: You can select either the normal style in which the selection box 

is of any size and the other style is „Fixed‟ style in which the selection 

rectangle is of fixed size. Another one is „Fixed Aspect Ratio‟ style in 

which you have to specify the aspect ration in X and Y direction and 

selection rectangle will increase as per that aspect ratio. 

b. Height and Width of the selection rectangle when the fixed style is 

selected and Aspect ratio in case of „Fixed aspect ratio‟ style. 

c. Unit: It specifies the unit of measurement. 

 

Note 

You can open this selection box either by <Shift> + <Click> 

on Selection tool in the tool palette or by going as Selection > 

<Shift> + New Selection i.e. <Shift> + <Click> inside the 

selection while transform selection is being applied. 
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Color Picker 
You can use the Color Picker to select the foreground or background color by 

choosing from a color spectrum or by defining colors numerically. 

 

Fig 151. Color Picker 

 

a. Currently selected color: It indicates the currently selected color. You 

can drag the slider anywhere within the colored area. 

b. Slider: You can use this slider to move within the range of the selected 

color component in „e‟. 

c. Currently selected color: It indicates the color selected in „a‟. 

d. Previously selected color: This box indicates the previous color which 

is to be replaced with the selected color. 

e. Numerically select the color based on the HSV, Lab, RGB and CMYK 

color spaces. 
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Current Operation InfoTip 
When performing various operations using mouse in Print Pro, a small 

window as shown below appears on the screen and remains nearby the 

mouse till the operation is completed. This is called Current Operation 

InfoTip, as it gives the information about the parameters related to the 

currently ongoing mouse operation. 

 

Fig 152. Current Operation InfoTip Window 

 

To enable the infotip, go to View > Show Current Operation InfoTip. 

 

A typical infotip window is divided into blocks in rows and columns. Each 

block has the following components. 

 

a. Icon: This indicates value of which parameter of the operation is shown 

in the block. Each icon is self explanatory and can be easily understood 

in regards to the operation being performed. 

b. Value: This indicates the exact value of the parameter indicates by the 

icon shown on the left side. 

c. Unit: This indicates the unit of the value. It‟s same as the currently 

selected unit in the image. 
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Rotate 
Rotation of the image by a user specified angle and background color. A new 

document is created in this case. 

 

Fig 153. Rotate Parameters 

 

You can rotate the image either clockwise (select CW) or Counter clockwise 

(select CCW). 

 

You can skew the image either horizontally or vertically by desired degree. A 

new document is created in this case also. 

 

Note You can access Rotate feature by going as Image > Rotate... 
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File Saving Options 

Bmp Options 

 

Fig 154. BMP Save Option Dialog 

 

While saving the file in the BMP format, you can select whether the file 

should be compressed or not. 

 

Tiff Options 

 

Fig 155. Tiff Save Option Dialog 

 

Many file formats use compression to reduce the file size of images. You can 

select any of the given compression scheme while saving the file in “.tiff” or 

“.tif” format. 
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Jpeg Options 

 

Fig 156. Jpeg Save Option Dialog 

 

a. Image Quality: To specify the image quality, choose an option from 

this menu.  

b. Format options: You can select any of the following format options: 

1. Select Baseline (“Standard”) to use a format recognized by most 

Web browsers. 

2. Select Baseline Optimized for optimized color and a slightly smaller 

file size. 

3. Progressive to display a series of increasingly detailed scans (you 

specify how many) as the image downloads. 
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File Opening Options 

PDF Properties 

 

Fig 157. PDF Properties Dialog 
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The dialog shown above will appear while loading the PDF file. You can set 

the following properties. 

 

a. Resolution Property: This section will let you set at what resolution 

you want to load the file. You can select any of the given color modes 

i.e. select either RGB or CMYK or Gray or Lab. Check the 

'Transparent document' option for the transparency while loading the 

PDF file. 

b. Rasterization Property: This displays the total number of PDF pages 

while loading the selected document. Either you can load all the pages 

or pages of your choice.  

c. Smoothening Property: Specify whether you want to smooth texts, 

line-arts or images.  

d. This gives the preview of the file to be loaded.  

e. Enter the page number you want to see in the preview.  

f. Page Matrix Property: Specify the option how you want multipage 

document to be opened. „As separate docs‟-each page as separate 

document or „As page matrix‟ - open all pages in single document as 

page matrix. 

 

Post Script Properties 
The dialog shown in below will appear while loading the PS or EPS file. You 

can set the following properties. 

 

a. Resolution Property: This section will let you set at what resolution 

you want to load the file. You can select any one of the given color 

modes i.e. select either of RGB or CMYK or Gray or Lab. Check the 

'Transparent doc' option for the transparency while loading the Post 

script file. Checking 'Pages to channels' option will divide the pages 

into channels.  

b. Page Matrix Property: Specify the option how you want multipage 

document to be opened. „As separate docs‟-each page as separate 

document or „As page matrix‟ - open all pages in single document as 

page matrix. This is disabling if you checked 'Pages to channels' 

option. 

c. Paper Size Property: This section will let you change the document 

size. You can customize the document size. Enter the width and height 

of the document in points.  
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d. Rasterization Property: This displays the total number of post script 

pages while loading the selected document. You can load all the pages 

or selected pages of your choice.  

e. This gives the preview of the file to be loaded. 

f. Smoothening Property: Specify whether you want smoothen texts, 

line-arts or images. 

 

 

Fig 158. Post Script Properties Dialog 

 

Note 

Support for PDF and PS file formats is an optional feature that 

may or may not be available in your software depending upon 

the version you use. 
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Notepad 

 

Fig 159. Notepad 

 

Notepad can be used to write comments related to a design, and these 

comments are automatically saved in the PST file on close of the image next 

time these comments will be automatically loaded. 
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File Browser 

 

Fig 160. File Browser 

 

a. List of the files in a folder that can either be opened inside Print Pro or 

can be imported directly into the page layout by drag and drop. Files 

shown in the bold letters indicate that a corresponding .PST files exists. 

.PST for 106.jpg, 108.jpg and 11.jpg. 

a 
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Passive Queue  
Passive Queue is a collection of folders having images, which needs to be 

processed by the Print Pro. Each folder is linked with the unique member of 

Passive Queue. These members are arranged group wise. 

 

Each folder is monitored by Passive Queue for following operations: new 

image file addition, image file deletion, renaming of image file. You can 

change these settings that either you want to monitor specified folder of 

passive queue or not.  

 

Each member of Passive Queue is associated with single print environment. 

Images from the associated folder of this member will be opened with this 

related print environment. Passive Queue manages the state of images 

within the folder, whether it has been processed by the Print Pro or not. 

 

Fig 161. Passive Queue 
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a. This is a group of Passive Queue members. It has been displayed in 

normal text as it is in expanded state and displaying all of the members 

within the group. 

b. These are the images within the folder associated with Passive Queue 

member. These files can either be opened by the Print Pro or can be 

imported directly into the page layout by drag and drop. It has been 

displayed in bold text as this images are still not processed i.e. not 

opened within the Print Pro. 

 

Right clicking on the image file name in passive queue will display the 

menu as shown below 

 

Fig 162. Image file context menu  

o Open file: it allows a user to open selected image file directly 

to the Print Pro. File will be opened with the environment 

associated with related Passive Queue member as default 

settings. 

o Delete file: It allows a user to delete selected image file 

directly from the Print Pro. File will be removed from Disk. User 

can also use <Delete> key to use this option.  

o Move to processed folder: It allows a user to move selected 

image file within the sub folder of related folder which is named 

as Processed. 

 

Note 

Whenever user Add, remove, delete or rename the image file 

within the folder associated with Passive Queue member being 

scanned then this image file list is automatically updated by the 

Print Pro. For the folders whose associated Passive Queue 

member is not being scanned by the Print Pro then user should 

have to update the image file list manually by clicking the 

“Refresh Passive Queue” button. 
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c. This is the Passive Queue member within the associated group. It has 

been displayed in normal text as it is in expanded state and displaying 

all of the images within the folder associated to it. 

 

Right clicking on member will display the menu, 

 

Fig 163. Passive Queue member context menu 

 

o Open all files from selected folder: It allows a user to open 

all the image files within the associated folders of selected 

Passive Queue members directly to the Print Pro. Files will be 

opened with the environment associated with related Passive 

Queue member as default settings. 

o Delete all files from selected folder: It allows a user to 

delete all the image files within the associated folders of 

selected Passive Queue members directly from the Print Pro. 

Files will be removed from Disk. User can also use <Delete> 

key to use this option. 

o Move all files to processed folder: It allows a user to move 

all the image files within the associated folders of selected 

Passive Queue members to the sub folder of related folder 

which is named as Processed. 

  

d. This is the Passive Queue member within the associated group. It has 

been displayed in bold text indicating that some of the images within the 

linked folder are not yet processed by the Print Pro and it is not showing 

the list of images within the associated folder. 
e. This is the image within the folder associated with Passive Queue 

member. It has been displayed in normal text as this image is processed 

i.e. opened within the Print Pro. 

 

 

 

Note 
Whenever any image file, from the passive queue member 
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associated folder, being opened within the Print Pro or being 

loaded into the Queue-manager, then image file name is 

displayed into the normal text indicating that the file is now 

processed by the Print Pro. 

 

f. This is the Passive Queue member group. It has been displayed in bold 

text indicating that some of the members do have images which are not 

yet processed by the Print Pro and it is not showing the list of members 

within the group. 
g. Refresh Passive Queue: Click this button to refresh the folder contents 

which are not being monitored by Passive Queue. This helps the user to 

synchronize with latest contents of the folder for which contents are not 

being synchronized automatically by Passive Queue.  

h. Manage Passive Queue members: This button enables a user to 

manage “Passive Queue members” data through a dialog as 

explained on page 222. 

i. Manage Passive Queue Group members: This button enables a user 

to “Manage Passive Queue member Group” through a dialog as 

explained on page 224. 

 

e f 
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Manage Passive Queue members 

 

Fig 164. Manage Passive Queue members 

 

a. Name: This denotes the name associated with the Passive Queue 

member. It can be edited by first selecting the desired name and then 

clicking on the selected name. 

b. Folder path: This is the path of the folder with which you wish to 

associate the Passive Queue member. This field can be modified in the 

same way as the Passive Queue member name can be. 

c. Passive Queue member associated folder path Edit box. 

d. Passive Queue member associated folder browse button. 

e. Environment: This is the environment which you wish to associate to 

the Passive Queue member. This field can be modified in the same way 

as the Passive Queue member name can be. It shows the all available 

environments within the Print Pro as shown below. User can also load 

the custom environments by using the browse button. 

f. Passive Queue member group: This is the name of the group which 

particular Passive Queue member belongs. You can change the Passive 

c 

 
d 
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223 

Queue member group by clicking on the group name. It shows all the 

available group in the drop-down list as shown in the figure below. 

g. Scanning state: This is the state of the Passive Queue member 

whether related folder is being scanned by the Print Pro or not. You can 

change its state by clicking on the related scanning state. 

 

Note 

If the folder is being scanned by the Print Pro then image file 

list within the folder, associated with the member, is always 

synchronized with the actual folder on the disk. For members 

which are not being scanned by the Print Pro, user should use 

Refresh Passive Queue button as shown in Fig 161 to have the 

latest file list of the folder. 

 

h. Add Passive Queue member: Allows you to add a new Passive Queue 

member. 

i. Delete Passive Queue member: Allows you to delete selected entries 

from the list.  

 

Right clicking in the list shown in the dialog of Fig 161 will also allows 

addition and deletion of entries using context menu shown below. 
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Manage Passive Queue members group 

 

Fig 165. Manage Passive Queue Member Group 

 

a. Name of the group. 

b. Passive Queue member name present into the group. 

c. Associated group list. 

d. Press this button to move the Passive Queue member into the 

selected group item into the associated list. This button enabled 

only when appropriate Passive Queue member is selected in 

„Passive Queue member list‟ and appropriate group is selected in 

the „Associated groups list‟. 

e. Add new group. You can use <Insert> key to add a new group. 

f. Remove the selected group. Passive Queue members presents into 

the group which is going to delete are moved into the „None‟ group. 

By using <Delete> key you can delete the selected group. 

f e 

c 

b 

a 
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Right clicking in the Passive Queue member group item will display the 

following menu which allows you to add, delete, rename group item and 

transfer Passive Queue member into new associated group. 

 

 

 

 

Note 
You can re-group the Passive Queue member by using the 

<Ctrl> + dragging the item and dropping on to the new group. 

 

Note 
You can not delete the item „None‟ from Passive Queue member 

list. 
 

Job addition in layout from Passive Queue 

User can add jobs from Passive Queue management window as shown in Fig 

161 window to the layout by dragging the image files from the list and 

dropping on the layout or load the files into the Print Pro by normal file 

opening procedure and then adding the loaded image file into the layout. 

 

Since image file loaded from the folder associated with passive queue does 

have the associated default environment settings, User can only add the 

images having same environment as of layout, or he/she has to use the 

layout environment for the loaded images. This condition is described below. 

 

In this case suppose user have created a layout for black media for some 

printer as shown below and Passive Queue member named as „Member 4‟ is 

associated with the environment of white media of same printer. 
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Fig 166. Passive Queue with Layout 

 

Now if user tries to add the image named „Embedded profile_1.psd‟ to the 

layout then Print Pro will show the message indicating that both the 

environments are not same (one is of image loaded from Passive Queue and 

second is of platen of layout) and asks for the user confirmation to use 

platen environment for the loaded image else image cannot be loaded into 

the respected platen as shown below. 
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Environment association with image file 

Suppose Passive Queue member named „Member-2‟ is associated with 

Environment of Black media for some printer. Now the associated folder of 

this member, which is „D:\temp\temp2\‟, contains an image file named 

„image test_1.psd‟.  

If this image is opened in Print Pro (by normal file opening procedure or from 

passive queue directly), then the default environment of this opened image 

will be of „Black media‟ of that printer (Environment associated with the 

Passive Queue member). 

 

Fig 167. Info tip of Image file in Passive Queue 
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Fig 168. Environment association with image file 
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Quick RIP 

 

Fig 169. Quick RIP 

 

a. Q Rip Settings: Commonly used settings for a print job including its 

size, position in page layout, mirroring the image about the vertical axis 

and inverting the colors of the image in the print. See also „Print 

Settings‟ on page 111.  

b. Print Setup: Access to printer setup.  

c. Print: Print the active document / job. 

 

a 

b c 



 

230 

Using Memory and Scratch Space Settings 

 

Fig 170. Memory and Scratch Space Adjustment Dialog 

 

To know the available options in details please refer „General Preferences‟ on 

page no. 10. 

 

a 

b 
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Using Print Preferences 

 

Fig 171. Print Preferences 

 

a. Print Buffer Size: The amount of design data transferred to the printer 

in single shift (W x H = Size x Size). 

b. Standard Prepress values: These values are to be used when loading 

the file and no previous settings are present. For more details 'Print 

Options'. 

c. Use application wide same unit: Check this box to preserve same 

unit for whole application.  

 

These default settings are used for the designs that are opened for the first 

time or the one‟s having no equivalent .PST files. See also „About PST files‟ 

on page 240. 

 

a 

b 

c 
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Using Custom Print Preferences 

 

Fig 172. Custom Print Preferences 

 

a. Specify the segment size checkbox: Check this button to specify the 

segment size. This option is not available in Microsoft® Windows® 98 & 

Microsoft® Windows® ME systems.  

b. Segment size (in MB): Maximum size for the each segment which you 

want to allow. In the Windows® 98 & ME systems, the maximum size 

allowed for file is 2GB. If you are saving the kprn file which is more than 

2GB & if your operating system is Windows® 98 & ME, then that kprn 

file will not be saved. To overcome this problem we are allowing you to 

specify the maximum size of each segment so that your kprn file will be 

saved & gets loaded properly. By default we are keeping the segment 

size as 2GB for Windows® 98 & ME systems. 

  

a 

b 
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Using Default Post-Script Settings 

 

Fig 173. Default Post-Script Properties Dialog 

 

a. Enter the mode of the image for printing.  

b. Check whether the pages to be converted to channels or not. 

c. Check whether the document open as transparent document or not.  

d. Check this to get the same size as in document over the fixed size.  

a 
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e. Select the size of the media. You can customize the size of the media 

by selecting „Custom‟ from the list of the media given.  

f. Enter the height and width of the media if you select media type is 

„Custom‟.  

g. Enter resolution to be used. 

h. Select whether you want to print the „1st page only‟ or all pages or 

every time you want to get notified that which page is to be 

printed next. 

i. Select the items to be printed smoothly. 

j. Browse to search for fonts in additional folders. 

k. Specify the option how you want multipage document to be opened. „As 

separate docs‟-each page as separate document or „As page matrix‟ 

- open all pages in single document as page matrix. 

 

Note 

„Using Default Post-Script Settings‟ is an optional feature that 

may or may not be available in your software depending upon 

the version you use. 
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Using User Default Folder Path 
The dialog used for defining user default folder path settings can be accessed 

using the menu command Options > User default folder path…. 

 

Fig 174. User Default Folder Path Dialog 

 

a. Print environment files (.env): Specify the print environment files 

default path. You can change this file path also by using the browse 

button. 

b. Printer profiles (.kcm, .icm, .icc): Specify the printer profiles files 

default path. You can change this file path also by using the browse 

button. 

c. Linearization / Transfer function files (.trc): Specify the printer trc 

files default path. You can change this file path also by using the browse 

button. 

d. Images files: Specify the images files default path. You can change this 

file path also by using the browse button. 

  

Note 

Application will search into user default folder path if provided 

path is relative path. If file not found in user default folder path 

then it will search into application installation path. 

a 
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Ink Cost 

 

Fig 175. Ink Cost Dialog 

 

a. Ink cost per litre: Ink cost per litre for the individual ink. If any ink 

present other than the CMYK, White and Clear then set cost into the 

„Other‟. You can enter or modify the cost of any ink by double clicking on 

its corresponding cell. 

 

Use the dialog shown above to specify the ink cost per liter of ink. This 

cost is used to compute the cost of the print. 

 

b. Additional Cost: Add additional cost which has occurred during 

completion of the printing process of the single job.( e.g. Pre treatment, 

Maintenance etc.).  

To add additional cost provide following input    

o Name: Specify meaning full name for the additional cost so that it 

will be easy to understand the cost. 

o Cost: Specify ink cost in respective currency. 

o Type: Specifies on what bases of measure cost needs to be 

calculated. Select from the available options. 

i. Per page 

a 
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ii. Per Area(Sq. mm)  

iii. Per Area(Sq. cm) 

iv. Per Area(Sq. inch) 

 

c. White, Black, Color and Dark: Check indicates the printing 

background for which this cost is applicable. 

d. Add New Additional Cost: Click this to add additional cost field. 

e. Remove Selected Additional Cost: Click this to remove selected 

additional cost entry. 

f. Load: Click this to load ink cost settings from (.kic) file. 

g. Save: Click this to save ink cost settings in to the file. 

 

The currency for the cost is taken from the regional settings. Regional 

settings for modifying the currency can be accessed from Control Panel. The 

path to change the currency depends upon the operating system. 

 

 For Windows-7: Control Panel > Regional & Language. Press the 

„Additional Settings…‟ button, go to „currency‟ tab and change the 

currency symbol as desired. 

 For Windows XP/Vista:  Control Panel > Regional & Language Options 

> press the 'Customize this format' button, Go to 'currency' tab and 

change the currency symbol as desired 

 For Windows 95, 98, ME and 2000: Control Panel > Regional Options 

> Go to 'currency' tab and change the currency symbol as desired. 

 

Cost of the print is available for viewing in the "Print Queue" as shown in Fig 

176. You can view these details after the job is saved, ripped or printed. 

Following are the details displayed. 

1. Individual ink coverage (Optional feature). 

2. Ink Cost (Optional feature). 

3. Additional cost(Optional feature). 

4. Total cost(Optional feature). 
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This cost analysis is for single copy irrespective of the total number of copies 

entered in queue manager. However this does include the number of passes 

of underbase layer, color layer, and white highlight layer if any. 

 

Fig 176. Ink Coverage & Cost of the Print in the 'Print Queue' 

 

Note 
This dialog ("Ink Cost") is marked as the Optional feature; so it 

may or may not be present in the basic version of the software. 
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Supported Image File Formats 
Print Pro supports only raster file formats. The formats recognized by Print 

Pro are as follows. 

 

1. BMP:  It doesn‟t support files with Jpeg and ICC extensions.  

2. GIF: Version 89a.  

3. JPG: Version 1.02. It does not support YcbCr, YCCk color spaces.  

4. PCX: Version 3.0.  

5. PNG: It does not support 2 bit per pixel PNG.  

6. TGA: Version 2.0.  

7. TIF:  It doesn‟t support files with Jpeg and Zip compression.  

8. PSD. 

9. PSB. 

 

Other File Formats 
1. *.kcm : Kothari Color Management files  

2. *.env : Kothari Environment files  

3. *.kpa : Kothari Primary Adjustment files  

4. *.pst : Printer settings files  

5. *.trc : Tone Reproduction Curve files  

6. *.lin : Linearization files  

7. *.fcm : Channel Mixer files  

8. *.fsc : Selective Color files  

9. *.fhs : Hue Saturation files  

10. *.flv : Level files  

11. *.fcv : Curve files  

12. *.fcb : Color Balance files  

13. *.icc, *.icw : ICC Color Profiles  

14. *.prn, *.kprn : File format to save ripped data 

15. *.klt : Kothari Layout Template 

16. *.kic : Kothari Ink cost settings 

1. *.kpm Kothari Port Mapping files. 

17. *.kie Kothari Import Export files. 

 

Note 
Supported file formats will depend on the software version you 

use and vary accordingly. 
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About PST Files 
PST is Print Pro‟s file format for storing the print options that you may 

specify for the document in Print Pro. Since none of the image file formats 

mentioned above supports the features offered by Print Pro, therefore Print 

Pro makes a file with the same path, name and .PST extension when you 

close the design. Next time when you open the same design Print Pro will 

read these options automatically, so as you don‟t have to remember and re-

enter those options. 
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Productivity Features 

Print Pro‟s user interface has been designed to boost your productivity.  

 

General Patterns 
Commonly needed tasks are either accessible through right button click „List 

of commands‟ or keyboard shortcuts. 

 

Shortcuts 
The „Application Window‟ provides the following keyboard shortcuts, 

 

 Open : <Ctrl> + <O>  

 Print : <Ctrl> + <P>  

 Print Preview : <F9>  

 Print Options : <Ctrl> + <T>  

 Print Setup : <Ctrl> + <Shift> + <P>  

 General Preferences : <Ctrl> + <K>  

 Color Management : <Ctrl> + <Shift> + <K>  

 Spot Color Gain : <Ctrl> + <G>  

 Image Info : <Ctrl> + <Shift> + <I>  

 Zoom In : <Ctrl> + <+>  

 Zoom Out : <Ctrl> + <->  

 Help : <F1>  

 Context Sensitive Help : <Shift> + <F1>  

 Next Pane : <Ctrl> + <F6>  

 Previous Pane : <Shift> + <Ctrl> + <F6> 
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The „Adjustment Interface‟ provides the following keyboard shortcuts, 

  

 Levels : <Ctrl>+<E>  

 Auto Levels : <Shift>+<Ctrl>+<E>  

 Auto Contrast : <Alt>+<Shift>+<Ctrl>+<E>  

 Curves : <Ctrl>+<Shift>+<M>  

 Color Balance : <Ctrl>+<B>  

 Hue / Saturation : <Ctrl>+<U>  

 Desaturate : <Shift>+<Ctrl>+<U> 

 

The „Print Preview Interface‟ provides the following keyboard shortcuts, 

 

 Print : <Ctrl> + <P >  

 Print Setup : <Ctrl> + <Shift> + <P>  

 Print Options : <Ctrl> + <T>  

 View Next Page : <Ctrl> + <PgDn>  

 View Previous Page : <Ctrl> + <PgUp>  

 View One Page : <Ctrl> + <1>  

 View Two Pages : <Ctrl> + <2>  

 Zoom In : <Ctrl> + <+>  

 Zoom Out : <Ctrl> + <->    

 Close Print Preview : <Esc> 

 

The "Edit Menu" provides the following keyboard shortcuts, 

 

 Undo : <Ctrl> + <Z>  

 Step Forward : <Shift> + <Ctrl> + <Z>  

 Step Backward : <Alt> +  <Ctrl> + <Z> 
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Right click ‘List of Commands’ 
 

For Application Window 

 

Fig 177. Right Click Options Available in Application Window 

 

For Print Preview 

 

Fig 178. Right Click Options Available in Print Preview 

Interface 
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Others 
1. Whenever you need to change units, right click option to change the 

units is available. 

2. In every value edit box along with a spin control, values can be 

incremented or decremented by using <Up> and <Down> keys 

respectively. 
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Common messages and 
trouble-shooting  

Messages 
 

Printing Related 
"Print settings have changed. Save new settings?" 

 

Print Pro will ask you this question before closing a document, if it finds print 

options for this document has changed. Upon confirmation it saves the 

modified print options in a file on the disk with name same as that of the 

document but with the extension PST. 

 

"There is nothing to print. Please make a selection for printing." 

 

If there is no job selected for printing Print Pro will issue this message. It is 

possible that you may have forgotten to select the job that you want to print.  

 

“There are no channels visible in the document. So the document will be 

blank.” 

 

Make at-least one channel visible by selecting it on the channel palette. This 

message generally appears when no channel is visible and user is trying to 

print a composite/color image. 

 

"Failed to acquire printer. Check the printer availability." 

 

Print Pro issues this message when it fails to get handle to the printer driver. 

There may be no printer driver installed on the system. If so, install the 
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driver for the printer you want to work with. If driver is already installed, 

then restart the system. 

 

"Not a valid media Info" 

 

TRC and printer profiles as specified in the media definition are missing.

  

 

"Ink Type not present" 

 

Ink type for the given media type is not present. Remedy is to reinstall the 

software. 

 

"Media Type not present" 

 

Current selected media type definition cannot be found. Remedy is to 

reinstall the software. 

 

"Loaded Env file <name> is empty" 

"Environment file <name> is damaged" 

 

Currently loaded environment file is empty/ damaged. Load correct/different 

environment file. 

 

"Loaded Kprn file <name> is empty" 

"Kprn file <name> is damaged" 

 

„.Kprn‟ file contains the ripped data. Currently loaded ripped file is empty/ 

damaged. Load correct/different ripped file. 

 

"Error in RTL Writer" 

"Custom writer has performed an illegal operation" 

"CustomPrint has performed an illegal operation" 

 

Error occurred while converting the data to the printer format. We 

recommend you to save all the data and restart your computer. 

 

"Error in writing printer data" 
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There was some error while writing the ripped data to the temporary file. We 

recommend you to increase the free disk space and restart the job. 

 

"Error in transforming image data" 

 

There was some error while converting the given image data into the desired 

mode. We recommend you to save all the data and restart your computer. 

 

“The margins overlap or they are off the paper. Enter a different margin 

size.” 

 

Margins of the paper are overlapping i.e. very less effective page size is 

remaining for printing. So either increase the page size or decrease the 

margin. 

 

“White base is present in more slots than allowed.” 

 

The number of ink slots assigned to the white under base ink is more than 

the maximum permissible slots for the white under base. The maximum 

value is the difference between the total ink slots in the printer and  

 

“Selected port is not a valid port name.”  

“Default printer is not found”  

“Error in starting the print job.”  

“Cannot read from the Spot Gain file. Using default value instead. Choose 

the appropriate setup using the Spot gain setup dialog.” 

 

When the spot gain file is corrupted for some reason the default gain file is 

utilized. This message conveys the same.  

 

“Too small page size to hold a single calibration bar.” 

 

When the calibration bar cannot be printed within a single selected page size.  

 

“Error in generating patches.” 

 

When some error occurs while creating test patches for printing.  
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“The margins overlap or they are off the paper. Enter a different margin 

size.” 

 

The margins are not valid for the selected paper size. 

 

“Error while generating printing data” 

 

Some error occurred while generating printing data.  

 

“Error while resampling image data.” 

 

Error occurred while applying the sampling method to the data.  

 

“<name> is not a valid port name.” 

 

Port selected for printing is invalid. 

 

Color Management Related 
"Error in color profile" 

"Doesn't recognize this printer profile" 

 

Currently selected printer profile for printing the image data is not valid. 

Select a valid printer profile. 

 

"Error in initializing the TRC Curves" 

"Error in reading the TRC Curves" 

 

There was some error in reading the TRC Cures. We recommend you to 

check the TRC Curves file. If problem persist then restart your computer. 

 

"Didn‟t got the Working RGB profile" 

 

We recommend you to select a valid RGB profile from color management 

dialog.  
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KDEF Related 
"Media is Already Present" 

 

Informs that an exact media is already present for the printer selected, when 

a new one of same name and settings is added. 

 

"Not a valid media Info" 

 

The settings for the media were invalid.  

 

"Ink Type not Present" 

 

The ink type requested is not present. 

 

"Media Type not Present" 

 

The media type requested not present. 

 

"Last media entry cannot be deleted." 

 

The media that the user is trying to delete is the last user, hence cannot be 

deleted. There has to be at least one media present.  

 

"Damaged KDF File" 

"KDF file for printer <printer name> is damaged" 

"KDF file for printer <printer name> is empty" 

"File <filename> is not a valid KDF File." 

 

Printer definition file for the Print Pro‟s custom driver is damaged. Remedy is 

to reinstall the software. 

 

"Not a valid paper Info" 

 

Information provided for paper is invalid.  

 

"Last paper entry cannot be deleted" 
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The paper info that the user is trying to delete is the last user, hence cannot 

be deleted. There has to be at least one user-defined paper info present. 

 

"Paper Size not present" 

 

Requested paper size is not available. 

 

“Unable to Add/Remove paper size as other properties dependant on it.”  

 

It is not possible to modify paper info since there are other dependents on it.  

 

"Kdef file reader has performed an illegal operation" 

 

There was some error while interpreting the data for custom printer driver. 

We recommend you to save all the data and restart the application. If the 

problem persists then restart the computer. 

 

Standard Error Messages 
"Low on memory" 

 

The system is low on memory. 

 

"Error in Tiff Separation Writer" 

 

Error in tiff writer. 

 

"Error while halftoning the image data" 

 

Error occurred while halftoning the data. 

 

"Error in color profile" 

 

Error occurred because of some problem in color profile.  

 

"Error in writing printer data" 

"Error in transforming image data" 
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Error occurred while applying transformation to the image data. 

 

"Error in initializing the TRC Curves" 

 

TRC curves could not be initialized. 

 

"Error in reading the TRC Curves" 

"Didn‟t get the SRGB profile" 

 

The sRGB profile is unavailable. 

 

"Didn‟t got the Working RGB profile" 

 

The working RGB profile is unavailable. 

 

"No printer selected" 

"No printer to remove" 

"No printer is selected to be added" 

"Default printer is not present in the selected printer list."  

"Damaged CustomPrint.ini file" 

 

The .ini file for Print Pro is damaged. 

 

Resources Related 
"System is low resources. We recommend you to shut down and start again." 

"Low on memory" 

“Not enough memory to complete the operation” 

 

This message is issued typically when the RAM available to Print Pro is very 

less, or Print Pro fails to acquire the required resources to carry out the 

requested operation. It is a general indication of system getting unstable.  

  

“Lower RAM than minimum required for working of the application. 

Upgradation of RAM suggested." 

   

This message is issued at the time of application initialization, if the available 

RAM is less than that instructed to use for Image management. Remedy is to 
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add more RAM to the system. Print Pro needs minimum of 4 MB physical 

RAM for its image handling system. 

 

"Low RAM available than requested. Trying with maximum available RAM." 

 

This message is issued at the time of application initialization, if the available 

RAM is less than that instructed to use for Image management. Print Pro 

continues initialization with whatever amount of physical RAM available. 

 

File Reading / Writing Related 
"Could not read the file. An error occurred while reading." 

 

The file may be corrupt.  

 

"Could not write the file. An error occurred while writing." 

 

Disk may be full. Free some space on the disk and try again. Or you may be 

trying to write on a read only media. 

 

“Unable to read/write ICC profile.” 

  

The given ICC profile may be either corrupt or may not be compatible with 

Print Pro. 

 

Application Related 
"Application could not be initialized properly .We recommend you to reinstall 

the application." 

 

Initialization file/s may have got corrupted. Reinstall the application. 

 

Page Layout Related 
"Layout is empty nothing will be printed." or "There are no jobs in the layout 

to print." 
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Print Pro will issue this message when the page layout being printed is 

empty. 

 

"The following layout(s) contain(s) screen or composites from this document. 

If you close this document these screens will be removed from respective 

layout" "DO you still want to CLOSE?" 

 

Print Pro issues this message when you are closing an open document and 

jobs from that document are present inside a page layout. 

 

“Error in rotating the image buffer for printing.” 

 

When some error occurs in rotating the image while printing the layout. 

 

“Template file <file name> is invalid.” 

“Error in reading layout template file <file name>.” 

 

Template file you are trying to open is invalid or corrupted. 
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Section 3 

P L A T E N  O R G A N I Z E R





 

257 

Platen Organizer 

(Optional Feature) 

 

What is 'Platen Organizer'? 
Platen Organizer allows to place multiple platens in a single page. Through 

use of platen organizer one can avoid wastage of printing material as well as 

time by efficient placement of platens. Platen is used to hold the print job 

within the platen bounding rectangle. 

 

Platen Organizer allows you to create layout template using various page 

size and printer combinations as you want and that designed template is 

used into Print Pro to print the composed design. 

 

To launch the Platen Organizer application click on the 'Open Platen 

Organizer' button in 'Layout Setting' toolbar of Print Pro. 

 

Fig 179. Launch Platen Organizer button in Print Pro 

 

Another ways to launch the platen organizer is Start > Programs > Print Pro 

WIGA > Platen Organizer. 
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More details on what you can do with ‘Platen 
Organizer’ 
1. Arrange platens in a single page with different page size and printer 

combinations.  

2. Layout the platens on the page with more accuracy and ease with the 

help of rulers and guidelines.  

3. Automatic spacing between different platens on the page at equal or any 

other distance as desired.  

4. Layout and nest multiples copies of the original platen in fraction of a 

second.  

5. With Multiple selections of the platens in the platen organizer, replicating 

each job is easy.  

6. Arrange the bunch of designs in exact center of the page and also align 

other platens as per the focused platen placement.  

7. It allows you to specify printer settings for white, black, color and dark 

color background substrates.  

8. Manage list of platens with various size as per requirement.  

9. Saving/Loading of layout template. 

10. Manage list of saved layout template files for quick open. 
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Application Window 

 

Fig 180. Application Window 

 

a. Menu bar. 

b. Layout template setting tool bar. 

c. Layout platen adjustment tool bar. 

a 

b 

c 

d 
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g 
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d. Job properties view shows properties of the currently selected platen.  

e. Custom print quick settings tool bar. 

f. Job list view contains list of available platens to add into the layout. 

g. Layout view is the preview of the current layout. It is the main working 

area of the platen organizer. 

 

Menu Bar 
List of commands offered by Application „Menu bar‟. 

 

File Menu 
The File menu offers the following commands: 

 

Fig 181. File Menu 

 

a. New Layout Template: Create a new layout template. 

b. Open Layout Template: Open a saved layout template file. 

c. Save Layout Template: Save the designed template into file. 

d. Merge Platen settings and positions: Refer „Merge Platen settings 

and positions‟ on page 311. 

e. Exit: Exit from the application. 

a 

b 

c 

d 

e 
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Layout Menu 
The Layout menu offers the following commands: 

 

Fig 182. Layout Menu 

 

a. Add Platen in Template: Clicking on this menu will add a single copy 

of the selected original platen in current Layout. If you want to add the 

platen two times, you have to click on this menu two times. 

 

Fig 183. Job List 

 

Alternatively, you can press on „Add‟ button on the page layout window 

to add a copy of the selected platen. 

a 
b 
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b. Delete Platen(s) from Template: To delete the platens in your layout, 

press <Ctrl> and right click on the platen that you want to 

remove/delete from layout. The particular platen will be selected. Then, 

press „Delete‟ button. The platen will be removed from the layout. You 

can also press the <Del> key. 

c. Ups: Clicking on this menu will display the dialog shown below. Enter 

the number of copies of original platen wanted and press OK button. 

Automatically all the copies will be placed in the layout page 

immediately. 

 

Fig 184. Ups Dialog 

 

d. Auto Arrange: Selection of this menu will automatically guide the 

software to arrange platen in the layout while optimizing media space. 

Alternatively, you can right click on your layout and select the option 

„Auto Arrange‟ from the menu bar.  

e. Layout White Background Print Settings: This option is allowed to 

change the print setup for the current background print settings.  

f. Print Setup: Change the print setup as per the selected print 

background type. 

g. Insert New Platen in List: Allows adding new platen into the job list 

view. 

h. Rotate Platen(s) 90 CW: Rotate the selected platens in 90 degree 

clock wise.  

i. Rotate Platen(s) 90 CCW: Rotate the selected platens in 90 degree 

counter clock wise. 

j. Rotate Platen(s) 180: Rotate the selected platens in 180 degree.  

k. Check Overlaps: This menu will help to ascertain if there is any platen 

overlaps in the current layout. When you will click on this menu, it will 

show message box „Overlap found‟ OR „No overlap found‟ for the current 
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page layout. If there will not be any overlaps in your layout, it will show 

message – "No overlap found". 

 

Fig 185. Check Overlaps 

 

This feature is very useful when you place multiple copies of the 

platen in your layout and do not specify any gap in between the 

platens. 
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l. Align Platen(s): Align selected platen left, right, top, bottom as per the 

focused platen. To put selected platen horizontally and vertically center 

in page select Horz. Center and Vert. respectively. 
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View Menu 
The View menu offers the following commands: 

 

Fig 186. View Menu 

 

a. Layout Platen Adjustment Toolbar: Shows or hides the layout platen 

adjustment toolbar. 

b. Layout Settings Toolbar: Shows or hides the layout settings toolbar.  

c. Custom Print Quick Settings Toolbar: Shows or hides custom print 

toolbar. 

d. Layout Options..: These are the various settings like spacing between 

the platens and color of the bounding rectangle for the platens etc. that 

can be specified by the user.  

e. Zoom In: Zoom in the active design. 

f. Zoom Out: Zoom out the active design.  

g. Show Current Operation InfoTip: Shows or hides the infotip shown 

during the mouse operations. 

h. Guides: Shows the list of operations which can be performed on 

guidelines. For more details please refer page no. 189. 

i. Snap: Checking this option results in snapping of the objects while 

dragging/moving. 

j. Snap To: Using these options you can enable/disable the snapping from 

the guideline as well as the bounding box of the platens. 

a 
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k. Reset Tool bars. 

Help Menu 
The Help menu offers the following commands: 

 

Fig 187. Help Menu 

 

The Help menu offers the following commands, which provide you assistance 

with this application: 

 

 Help Topics: Offers you an index to topics on which you can get help.  

 About Platen Organizer: Displays the copyright notice and version 

number of this application. 

 

Layout Template Setting Toolbar 

 

Fig 188. Layout Template Setting Toolbar 

 

a. Create new layout template. 

b. Open saved layout template file (*.klt). 

c. Save layout template into template file (*.klt). 

d. Add new platen into job list view. 

a 

j l m n k 

b c d e f g h i 

o 
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e. Change the page printer settings of this layout. Here when you click 

on the arrow button the following options are shown. 

 

f. Automatically arranges the present platens in the layout to 

optimize the space used by them in the layout. If required it will also 

rotate the platen in order to optimize the space consumed. This also 

takes into account the default spacing between the platens as specified 

in the “Layout options”. 

g. Zoom in. 

h. Zoom out. 

i. Context Help. 

j. Open layout template manager for maintaining the templates. 

k. Open layout template manager for maintaining the template groups. 

l. Opens layout template from managed files. 

m. Currently selected printer name. 

n. Open layout option dialog. 

o. Check to find overlap. 

 

Layout Platen Adjustment Toolbar 

 

Fig 189. Layout Platen Adjustment Toolbar 

 

a. Add a platen in layout. See „Adding Platens into Layout‟ on page 302. 

a b

  

c d e f g h i j k l m n 
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b. Delete selected layout platen(s).  

c. Duplicate the selected platen(s).  

d. Align the selected Platen(s) to the left of the focused Platen.  

e. Align the selected Platen(s) to the right of the focused Platen.  

f. Align the selected Platen(s) to the top of the focused Platen.  

g. Align the selected Platen(s) to the bottom of the focused Platen.  

h. Align the selected Platen(s) to the vertical center of the focused 

Platen.  

i. Align the selected Platen(s) to the horizontal center of the focused 

Platen.  

j. Align the selected Platen(s) to the vertical center of the page.  

k. Align the selected Platen(s) to the horizontal center of the page.  

l. Rotate platen(s) by 90 degrees clockwise.  

m. Rotate platen(s) by 90 degrees counter clockwise.  

n. Rotate platen(s) by 180 degrees. 
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Custom Print Quick Setting Toolbar 
Refer “Printer Settings Toolbar” on page 195. 

 

Properties View 

 

Fig 190. Properties View 

 
a. Platen name. 

b. Unit: Unit in which values are shown.  

c. Left (L)-top (T) position of the platen in the layout.  

d. Current cursor (XY) position.  

e. Ruler offsets: The offset of the origin of the ruler with respect to the 

origin of the printable area of the page (margins excluded from the 

physical page size). 

 

Property window shows some important properties of the selected platen in 

the layout. 

 

At the top it shows the platen name.  

 

Then comes the unit in which all other elements are displayed. Here in this 

example the unit used is inch. This unit is always same as that of the layout 

ruler. This can be changed by right clicking on the layout ruler.  

 

a 

b 

c 

d 

e 



 

270 

Next Left and Top offset of the selected platen is displayed. These offsets are 

from the left of margin and top margin of the page. 

 

Cursor position shows the current cursor position with respect to the ruler. 

The left and top offset of the current platen is also in ruler co-ordinate space. 
 

Job List View 
The job list view on the lower left side of the platen organizer shows all the 

available platen. This list gets updated automatically whenever you add a 

new platen. 

 

Fig 191. Job List View 

 

Whenever platen organizer application is started, standard platens managed 

by user are automatically added into job list view. 

 

When template file is opened in platen organizer, platens present into the 

template file are added into the job list view. 

 

Layout View 
The layout view shows preview of the current layout. This shows all the 

platens in the page at their respective positions. The gray rectangle inside 

the page indicates the page margin. Platen cannot move beyond this 

rectangle. The margin can be changed by changing printer options. 
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Fig 192. Layout View 

 

To select a platen you can either click on the platen or use <Tab> key. In 

case of overlapped platen you can click by holding <Shift> key to select a 

platen below the selected platen. 

 

To move a platen, drag the platen while holding <Ctrl> key. Or use <Up> or 

<Down> or <Left> or <Right> keys. You can move a copy of the selected 

platen by holding the <Alt> key. 

 

Platen in the layout can be rotated in steps of 90°. To rotate a platen uses 

right click menu commands. 

A 

Ruler 

Guide 

Platens 

Page 
Margin 
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Initially the ruler origins are aligned with page margins (left and top). You 

can change this origin by dragging the cursor from the box marked as „A‟ in 

Fig 192. To reset the origin to the left top of page margin double click in „A‟. 

 

To create guide Drag the cursor from the horizontal or vertical ruler and drop 

in position where you want the guide. You can use <Alt> key to rotate the 

guide 90°. You can also add a guide by using the menu command Layout > 

Guides > Create Guides…. 

 

To move a guide Drag the guide while holding <Ctrl> key. 

 

To delete a guide Move the guide out of the page. To delete all the guides 

use menu command View > Guides > Clear Guides. 

 



 

273 

Right Click Context Menu 

 

Fig 193. Right Click Context Menu 



 

274 

 

Commands  Short Keys 

 Insert new platen in job list view  Ctrl + S 

 Close Page Layout  Ctrl + L 

 Ups  Shift + Insert 

 Adding up platen in layout  Insert 

 Insert New Platen In List Ctrl + Shift + N 

 Delete a platen  Del 

 Select a platen in layout 
 Ctrl + Left Click on that particular 

platen   

 Align left  Ctrl + Shift +  Left Arrow 

 Align right  Ctrl + Shift + Right Arrow 

 Align Top  Ctrl + Shift + Up Arrow 

 Align Bottom  Ctrl + Shift + Down Arrow 

 Select all platens  Ctrl + A 

 Deselect all platens  Ctrl + D 

 Change printer settings  Ctrl + Shift + P 

 Check overlap  Ctrl + C 

 Zoom In  Ctrl + + 

 Zoom Out  Ctrl + -- 

 

Fig 194. List of Shortcuts 
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Creating New Layout Template 
You can create the new layout template by using the „New Layout Template‟ 

wizard. It will guide you throughout the wizard that how to create new layout 

template with required settings. 

 

To open a layout template wizard click on the 'New Layout Template' button 

in layout setting toolbar or select new layout template option from the File > 

New Layout Template menu. 

 

Fig 195. New Layout Template Wizard 
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Step 1. Define Printer Settings. 

 

In this step specify that, how do you want to begin. By loading printer 

settings for all background type from existing template file or continue with 

the default print settings. 

 

Fig 196. Define Printer Setting 

 

a. Showing the short description about the current step.  

b. Load printer settings from an existing template file: By selecting 

this option you can load printer settings from the existing template (.klt) 

files which are previously saved.  

c. Start with default printer settings: You can continue with the default 

settings which are previously saved default settings by you.  

a 

b 

c 

d 

e f 
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d. Set Settings as default: This option is used to set the configured 

printer settings as default for the current printer when you finished the 

wizard. This option will become enabled only when the last page comes. 

So next time print settings will be automatically loaded into wizard when 

particular printer is selected.  

e. Moves to the previous step.  

f. Moves to the next step. 

 

Step 2. Loading Printer Settings from the Existing Template. 

 

This page is visible only when you select the „Load settings from existing 

template‟ in step 1.  

 

Fig 197. Loading Printer Setting from an existing template 

 

You can load printer settings of existing template (klt) file for create new 

wizard. 

a 

b 
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a. List showing the list of template file which are managed using the 

layout template manager. 

b. Click on the open button to load template file from the disk. 

 

Step 3. Specify Printer, Printer Port and Ink Layer Order. 

 

Fig 198. Specify Printer and Printer Port 

 

In this step you can specify the printer and port on which printer is 

connected. 

 

a. Printer:  This shows the list of available printers. Whenever you change 

the printer, default settings for that printer are loaded. 

b. Printer Port: This shows the list of available printer ports. Select printer 

port from the list on which the printer is connected. 

c. Feed Adjust between passes (in mm): It‟s the offset to be kept 

a 

b 

c 
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between the first pass and the subsequent passes. If the subsequent 

passes are having higher offset than the feed adjust will be +ve and if 

lower offset than the feed adjust will be –ve. 

 

Step 4. Specify Media Size and Margins. 

 

Fig 199. Specify Media Size and Margins 

 

In this step you can specify the media on which the printing is to be done 

and the margins to be left on the four sides of the media if needed. 

 

a. Media size: This field shows the list of media (paper) supported by the 

printer. Here we can specify the page size we want to use. If the printer 

supports custom paper sizes then select one of the “user defined” paper 

sizes from the list whose size can be defined by the user by clicking the 

„User size‟ button.  

b. Source: It determines from where the media is inserted for printing.  
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c. User size: This button is enabled when the user selects “User defined” 

paper size from the media size list. When you click this button a dialog 

box appears asking for the width and height of the new media you want 

to create. 

d. Check bar options: Opens the dialog to modify the check bar related 

options. 

e. Add/Remove paper: This button is used to add the new paper size or 

you can remove the paper size which is newly added by you. 

f. Margins: From this field you can specify the left, right, top and bottom 

margin for the paper. Specify margins such that they does not overlap 

or go off the paper. 

 

Step 5. Specify Printer Ink Slots. 

 

Fig 200. Specify Printer Ink Slots 

 

a 

b 
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Ink assignment page contains the information about the currently loaded 

inkset used for printing. This page will show only the inkset which are 

supported by the printer i.e. if the printer is a 4 channel printer then only 

those inkset will be shown for which the number of inks in the inks set is 

equal to or less than four. 

 

a. Predefined Inksets: List the inkset supported by the currently selected 

printer. 

b. Entries of the selected inkset: These fields are used to specify colors 

for every channel slot as present on the printer i.e. specify on which slot 

which ink is present for the concerned printer. If your printer has white 

inks, specify which slots have those. If you do not want to print using a 

channel, set that channel slot number as 'None'. 

 

Step 6. Specify Supported printing base type. 

 

Fig 201. Specify supported printing base type 
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In this step you can choose which printing backgrounds you want to be 

present in your template. You should select the background types which you 

will need during the printing and ignore the rest by deselecting them. 

 

Later, you need to define the settings related to only the background types 

you have selected here. 

 

Note 
At least one printing background must be selected in the template 

file. 

 

Step 7. Media type, Printer Profile and TRC for White background. 

 

In this step you can specify the media type, profile and TRC settings for the 

white background substrate. 

 

Fig 202. Specify Media type, Printer Profile and TRC For White 
Background 
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a. Media type: It specifies the media on which user wants to print. This 

can be a user created media or a predefined media. Basically by 

selecting a new media user selects a new printer profile and TRC curves 

for printing which was selected by the user while creating that media. 

Media type can be dependent on ink type or can be independent 

depending on the printer selected. If a media type is dependent on ink 

type then only those media are shown which the selected ink type 

supports. User can still override the printer profile or the TRC curve used 

by selecting appropriate files using „Load TRC…‟ and „Load Printer 

Profile…‟ buttons.  

b. Ink type: This field shows the list of ink type supported by the printer. 

Many printers have media type dependent on ink type i.e. for one media 

type you may want to select the different TRC curves and printer profile 

and for other ink type a different set.  

c. Create media: To create a new media or remove an existing media. 

d. Load TRC: To change the TRC curves used for printing an image.  

e. Load printer profile: Use this option to select a different printer profile 

for printing. Remember always load the same number of channel printer 

profile as in the currently loaded inkset.  

f. Load White TRC: Use this option to change the TRC curves used for 

printing the white base for an image. For white background white TRC is 

not required, so this button will remains disabled.  

g. Printer Profile:  It is the currently loaded printer profile name. 

 

Step 8. Specify Media type, Printer Profile and TRC for Black 

background. 

 

In this step you can specify the media type, profile and TRC settings for the 

black background substrate. 
 

In this step all the input remains same as the „Step - 6‟ except „Load White 

TRC…‟ button remains enabled to specify the White TRC for white layer 

labeled as „f‟. 

 

Step 9. Specify Media type, Printer Profile and TRC for Color 

background. 

 

In this step you can specify the media type, profile and TRC settings for the 

color background substrate. 
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In this step all the input remains same as the „Step - 6‟ except „Load White 

TRC…‟ button remains enabled to specify the White TRC for white layer 

labeled as „f‟. 

 

Step 10. Specify Media type, Printer Profile and TRC for Dark color 

background. 

 

In this step you can specify the media type, profile and TRC settings for the 

dark color background substrate. 

 
In this step all the input remains same as the „Step - 6‟ except „Load White 

TRC…‟ button remains enabled to specify the White TRC for white layer 

labeled as „f‟. 

 

Note 
Some of these steps may not be present in your wizard 

depending upon the backgrounds selected in previous step. 
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Step 11. Specify Additional Ink Settings For White background. 

 

Fig 203. Specify Additional Ink Settings For White background 

 

In this step you can specify the additional settings related to the special ink 

and white background. 

 

a. Additional white ink settings: These are the additional settings 

pertaining to the white ink. 

i. White Underbase: You can specify the strength of the white 

underbase along with its generation type. The various generations 

types available are: 

o Automatic: The white underbase generation will be performed 

automatically by the RIP software. 

o Channel based: The white underbase generation will be 

performed based upon some spot channel present in the image. 

a 

b 
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The channel to be used for the underbase generation can be 

specified using the color palette. 

o Combine: The white underbase will be generated by the RIP 

software automatically combining with underbase channels 

defined in the channel palette. 

o Transparent region: The white underbase will be generated 

based upon the transparent region present in the image. 

o Non Transparent region: The white underbase will be generated 

based upon the non transparent region present in the image.  

o Full Image: The white underbase will be generated based upon 

the entire image. 

o Gray Gradation: The white underbase will be generated based 

upon gray value of image data. 

o Inverted Gray Gradation: The white underbase will be 

generated based upon inverted gray value of image data. 

ii. White Highlight: You can specify the strength of the white 

highlight to be used while printing. Also how the white highlight is 

to be generated while printing can be specified by you. The 

available generation types are: 

o None: The white highlight won‟t be used during the printing. 

o Channel based: The white highlight will be applied based upon 

the white highlight channel. Fuzziness value is disabled and 

ignored. You can specify which channel to be used as white 

highlight using the channel palette. 

o On the fly: The RIP will generate the white highlight on the fly 

during ripping using the fuzziness value provided. This will 

ignore any highlight channel set otherwise in the channel 

palette. The fuzziness value works similar to the highlight 

channel creation option. 

o Combine: The RIP will generate the white highlight on the fly 

during ripping using the fuzziness value that you supply there 

and will combine it with the highlight channels set in the 

channel palette. 

 

The fuzziness value works similar to the highlight channel creation 

options. This will be disabled in the case of Channel based Highlight 

generator. 
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iii. Underbase choke: You can specify the strength of the choke mask 

to be applied during the printing. The choke will be applied based 

upon the choke channel selected in the channel palette. 

 

b. Use same settings for all printing backgrounds: Check this option if 

you want the same settings for all the selected backgrounds. 

 

Step 12. Specify Additional Ink Settings For Black background. 

 

In this step you can specify the additional settings related to the special ink 

and black background. All the settings are similar to those of white 

background. 

 

Step 13. Specify Additional Ink Settings For Color background. 

 

In this step you can specify the additional settings related to the special ink 

and colored background. All the settings are similar to those of white 

background. 

 

Step 14. Specify Additional Ink Settings For Dark Color background. 

 

In this step you can specify the additional settings related to the special ink 

and dark colored background. All the settings are similar to those of white 

background. 

 

Note 

If you have specified the additional settings to be same for all the 

backgrounds in the previous step, then these steps will not be 

present in the wizard. 

 

 

Note 
Some of these steps may not be present in your wizard 

depending upon the backgrounds selected in the earlier step. 
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Step 15. Specify Color Correction Settings for White background. 

 

Fig 204. Specify Color Correction Settings For White 
Background 

 

a. Printer color adjustment: Check this for color adjustment.  

b. Sliders for color correction.  

c. Use Color booster: Check this to enable color booster.  

d. Color booster value: Adjust the percentage to increase the amount of 

color depth. 

e. Color Strength: As the name suggests it specifies the strength of the 

color you wish to use during printing. To use the full strength of the 

color set it to 100%. Otherwise you can use any intermediate value 

between 0% and 100% for your optimum quality. 

f. Use same settings for all printing backgrounds: Check this option 

to use same color correction settings for all the selected backgrounds. 
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Note 

Make changes only if you desire or this will affect the output 

image.  Leave these settings as it is to avoid any changes in the 

input image. 

 

Step 16. Specify Color Correction Settings for Black background. 

 

In this step you can specify the color correction settings for the black 

background. All the settings are similar to those of white background. 

 

Step 17. Specify Color Correction Settings for Color background. 

 

In this step you can specify the color correction settings for the colored 

background. All the settings are similar to those of white background. 

 

Step 18. Specify Color Correction Settings for Dark Color 

background. 

 

In this step you can specify the color correction settings for the dark colored 

background. All the settings are similar to those of white background. 

 

 

Note 

If you have specified the color correction settings to be same for 

all the backgrounds in the previous step, then these steps will not 

be present in the wizard. 

 

Note 
Some of these steps may not be present in your wizard 

depending upon the backgrounds selected in the earlier step. 
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Step 19. Specify Print Quality Settings for Individual Layer(s) 

(Epson based). 

 

Fig 205. Specify Print Quality Settings For Individual Layer(s) 
(Epson Based) 

 

a. Resolution: Select the resolution at which you wish to print. 

b. Color appearance: Select the output color mode. Colored or 

monochrome. 

c. Micro weaving: This option allows the printer to generate superior 

output because graphics data is reordered and is printed in finer 

increments. It reduces the possibility of banding, the light horizontal 

lines that can mar an image. 

d. Print Direction: This option allows you set the printing direction. It can 

be unidirectional or bidirectional. 

e. Dot size: Using this option you can set the size of the dot for printing.  
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f. Wet on wet passes: Number of times the same row to be printed. 

g. Weave Overlap (in %): Specify in percentage by how much amount 

you want to overlap two passes. Specifying value greater than zero will 

reduce the banding between the passes (resulting in improved print 

quality) but will also increase the print time. 

h. Wet on wet passes: Checking the Optimize Ripping will increase the 

ripping speed. 

i. Layering: Specifies any of the below mentioned layering methods. 

o Multi Pass: Each layer will be printed in a separate pass. 

o Wet On Wet OnePass: All the layers will be printed simultaneously 

in a single pass, (i.e. the layers will be printed when the other 

layers are wet and not dried yet). 

o Wet On Dry (Adaptive) OnePass: All the layers will be printed in 

a single pass, but there would be enough time for the layers to get 

a bit dried before the other layers are printed on them. 

 

j. Layers count: Enter the no. of layers of white underbase or color data 

to be printed depending on the option selected currently. This option will 

only be enabled if you are printing layers in multiple passes. 

k. Secondary Resolution: When layers are to be printed simultaneously 

i.e. using wet on wet or wet on dry One Pass methods, the printing 

settings of each pass can‟t be specified separately. This option enables 

you to specify the resolution of the secondary passes. The available 

secondary resolutions are based upon the primary resolution set for the 

printing of the combined pass. 
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Or 

 

Specify Print Quality Settings for Individual Layer(s) (File Based). 

 

Fig 206. Specify Print Quality Settings For Individual Layer(s) 
(File Based) 

 

a. Resolution: Select the resolution at which you wish to print. 

b. Color appearance: Select the output color mode. Colored or 

monochrome. 

c. Compression: Compression specifies the type of compression which we 

want to apply on the tiff files generated as the output. 

d. Dot size: Using this option you can set the size of the dot for printing.  

e. Dots used: Specify the combination of dots to be used for generating 

printing data. Availability of this option depends upon “Dot size” 

selected. 
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f. Optimize Ripping: Checking this option will increase the ripping speed. 

g. Save as: This button is enabled when you have not selected “Use path 

same as that of source”. When the user selects this button then a dialog 

appears that asks you to enter the save location. 

h. Use path same as that of source: If this option is checked then the 

output files are stored in the same directory as that of the source file. 

The output file name is set as follows: <Source file name>_<source file 

extension>_<page number>_<Channel short name>.tif when this check 

is disabled then user can specify his own file name by clicking the “Save 

as” button. 

i. Create temporary file in case of network path:  When output file 

path is network path at that time printed file is first created into the 

local system and after printing is finished that file(s) is transferred to the 

network path. Temporary file(s) is created into the folder specified in the 

„Print Queue Manager Preferences‟ (on page 55). 

j. Create compressed file for final output: Check this option if you 

want to compress the TIFF files generated as output into a single 

(*.ZIP) file. This option is very useful in saving the disk space as well as 

grouping of similar output TIFF files. 

k. Create Directory for files: Check this option to create separate 

directory for the files to be saved. 

l. Overwrite old files: If the user wants to overwrite the old files 

generated then he should check this box. If the user has disabled this 

button and the file is sent for printing then if previously files with the 

given name existed then the creation of the tiff file will stop with an 

error message that the following files already existed. 

m. Generate unique file names in case of name clashing: This option 

is only enabled if „Overwrite Old files‟ option is disabled. It will generate 

a unique file name for saving in case of file clashing found while 

generating the TIFF files for output. 
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Or 

 

Specify Print Quality Settings for Individual Layer(s) (Mutoh Based). 

 

 

Fig 207. Specify Print Quality Settings For Individual Layer(s) 

(Mutoh Based) 

 

a. Resolution: Select the resolution at which you wish to print. 

b. Color appearance: Select the output color mode. Colored or 

monochrome. 

c. Print Direction: This option allows you to set the printing direction. It 

can be unidirectional or bidirectional or automatic. 

d. Quality: Allows the user to select the number of passes required to lay 

down one line of image on the printer. The greater the number of 

passes, the better the quality of the image. However, increasing the 

number of passes also increases the amount of time required to print 
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the image. 

e. Overlay: Select predefined passes overlay effect.  

f. Dot size: Using this option you can set the size of the dot for printing.  

g. Dots used: Specify the combination of dots to be used for generating 

printing data. Availability of this option depends upon “Dot size” 

selected. 

h. Dot type: The printer firmware can automatically adjust the dot size to 

the specified resolution. But you may specify the dot size yourself using 

one of available sizes. 

i. Optimize Ripping: Checking this option will increase the ripping speed. 

j. Layering: Specifies the layering method. It can be any of the options 

mentioned below. 

o Multi Pass: Each layer will be printed in a separate pass. 

o Simultaneously: All the layers will be printed simultaneously in a 

single pass. 

k. Layers count: Enter the no. of layers of white underbase or color data 

to be printed depending on the option selected currently. This option will 

only be enabled if you are printing layers in multiple passes. 

l. Secondary Resolution: When layers are to be printed simultaneously 

i.e. using wet on wet or wet on dry One Pass methods, the printing 

settings of each pass can‟t be specified separately. This option enables 

you to specify the resolution of the secondary passes. The available 

secondary resolutions are based upon the primary resolution set for the 

printing of the combined pass. 
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Or 

 

Specify Print Quality Settings for Individual Layer(s) (Generic). 

 

 

Fig 208. Specify Print Quality Settings For Individual Layer(s) 

(Generic) 

 

a. Resolution: Select the resolution at which you wish to print. 

b. Color appearance: Select the output color mode. Colored or 

monochrome. 

c. Print Direction: This option allows you to set the printing direction. It 

can be unidirectional or bidirectional or automatic. 

d. Quality: Allows the user to select the number of passes required to lay 

down one line of image on the printer. The greater the number of 

passes, the better the quality of the image. However, increasing the 

number of passes also increases the amount of time required to print 
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the image. 

e. Print Mode: Allows the user to select printing mode like print for high 

quality or print for high speed. 

f. Dot size: Using this option you can set the size of the dot for printing.  

g. Dots used: Specify the combination of dots to be used for generating 

printing data. Availability of this option depends upon “Dot size” 

selected. 

h. Optimize Ripping: Checking this option will increase the ripping speed. 

i. Layering: Specifies the layering method. It can be any of the options 

mentioned below. 

o Multi Pass: Each layer will be printed in a separate pass. 

o Simultaneously: All the layers will be printed simultaneously in a 

single pass. 

j. Layers count: Enter the no. of layers of white underbase or color data 

to be printed depending on the option selected currently. This option will 

only be enabled if you are printing layers in multiple passes. 

k. Secondary Resolution: When layers are to be printed simultaneously 

i.e. using wet on wet or wet on dry One Pass methods, the printing 

settings of each pass can‟t be specified separately. This option enables 

you to specify the resolution of the secondary passes. The available 

secondary resolutions are based upon the primary resolution set for the 

printing of the combined pass. 
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Step 20. Specify Advanced Media Settings for Individual layer(s) 

(Epson Based). 

 

Fig 209. Specify Advanced Media Settings For Individual 

Layer(s) (Epson Based) 

 

a. Advanced head control (Nozzle utilization in %): This option is 

used for masking the nozzles to use for printing. By using this option we 

can disable starting and trailing nozzles of the print-head from printing. 

This option is useful in mainly 2 cases. 

a. Some of the starting or trailing nozzles are blocked, and then 

the user can mask this area and can use rest of the printhead 

for printing. 

b. In case of printing on Rotary devices only small middle region 

of print-head is required for printing and in this cased user can 

mask unwanted top and trailing nozzles. 
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b. Banding correction: Perform settings for media feed compensation. 

This corrects the errors in the amount of feed of the grit rollers due to 

the type of media used. Correcting the amount of feed improves the dot 

positioning accuracy in the feed direction, which can help in enhancing 

the image quality. 

c. Registration offset (in mm): Registration offset (in mm) specifies the 

offset between the white ink layer and the color ink layer. 

d. Dry time per scan: Specify the time (in milliseconds) for which the 

head waits before printing each line.  

e. Dry time after print: This setting allows the control of the amount of 

time (in seconds) after which the next layer is printed. 

 

 

As this is the final step of the wizard, there is one option available in this 

step mentioned below. 

 

Set settings as default: Check on this button to set currently configured 

printer settings as default the selected printer. Whenever you change the 

printer during new layout creation dialog, these settings will be automatically 

loaded. This option will be enabled in the Next (or in the Last step 

depending on your version of software) step. 
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Or 

 

Specify Advanced Media Settings for Individual Layer(s) (Mutoh 

Based). 

 

 

Fig 210. Specify Advanced Media Settings For Individual 

Layer(s) (Mutoh Based) 

 

a. Media type: Specifies the media type according to which correction 

value will be used. 

b. Correction: When selected media type is user defined then you can 

specify the correction value in steps of 0.01 mm. 

c. Feed Registration offset (in mm): Registration offset (in mm) 

specifies the feed direction offset between the white ink layer and the 

color ink layer. 

d. Scan Registration offset (in mm): Registration offset (in mm) 
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specifies the scan direction offset between the white ink layer and the 

color ink layer. 

e.  

Or 

 

Specify Advanced Media Settings for Individual Layer(s) (Generic). 

 

 

Fig 211. Specify Advanced Media Settings For Individual 
Layer(s) (Generic) 

 

a. Feed Registration offset (in mm): Registration offset (in mm) 

specifies the feed direction offset between the white ink layer and the 

color ink layer. 

b. Scan Registration offset (in mm): Registration offset (in mm) 

specifies the scan direction offset between the white ink layer and the 

color ink layer. 
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Adding Platens into Layout 
By using menu command Layout > Insert New Platen in List, you will get an 

'Insert Platen' dialog to add new platen. This will add new platen into the job 

list view. 

 

Fig 212. Insert Platen Dialog 

 
a. Platen name: Platen name should be unique; otherwise new platen is 

not added into job list view.  

b. Add current platen info into the standard platen list.  

c. Width of platen: This should be up to maximum allowed paper width 

for current printer.  

d. Height of platen: This should be up to maximum allowed paper height 

for current printer.  

e. List of the available standard platens.  

f. Reset standard platen list with factory defaults.  

g. Delete selected platen from standard platen list. 
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You can add new platen into page as follows: 

 

1. By double clicking on the appropriate job from the list on the left 

pane.  

2. Selecting the job and clicking „Add‟ button on the layout tool bar.  

3. Selecting the job and pressing <Enter>.  

4. By dragging the job from job list view and placing into the layout 

view. 

 

Note 

If the platen cannot be accommodated in the page in erect 

position, it tries to put it through 90° rotation. Rotated platens 

are indicated by vertically displayed platen names. 

 

Note 
Standard platens are automatically added into job list view when 

application starts. 

 

Placing a Platen in Layout View 
Adding a platen places it at the first location on the media where it can fit it 

in an optimized way. Then you can move it to anywhere within the margins 

of the page.   

 

Use zoom-in and zoom-out commands on the layout tool bar to get a proper 

view of the page in use.  

 

To move a platen by using the keyboard, you need to select it first. Then use 

the arrow keys in your keyboard to move the selected platen in appropriate 

direction. For faster displacement, use <Shift> key in combination with these 

keys. 

 

If you want to use the mouse, pressing <Ctrl> key, click the left mouse 

button inside the desired platen rectangle and drag it with mouse button still 

down to the location of your wish.  

 

While dragging a platen if its edge reaches near enough to an edge of 

another platen, the other platen attracts it and tries to place it as closer as 

possible without overlaps. (This is done to save printing material). If you 

want to override this snapping feature then use <Shift> key while dragging 

and place the platen anywhere you like. 
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Note 
Platen Organizer constraints the placement of the platen within 

the margins of the page. 

 

Selecting a Platen in Layout View 
Using Keyboard:  

 

You can navigate through the platens by pressing the <Tab> key. Press 

<Shift> + <Tab> to navigate in the opposite direction.  

 

Using Mouse:  

 

Click inside the rectangle that represents the desired platen. Press <Ctrl> 

key along while clicking to select a platen that is hidden (overlapped) by 

another platen. 

 

Selecting multiple Platens:  

 

Press <Shift> key along with <Ctrl> and mouse click to select multiple 

platens. You can also use <enter> key while moving between the platens 

using the <tab> or <shift>+<tab> key to make multiple selections. 

 

You can also use <ctrl>+<A> to select all the platens in the layout. You can 

use <ctrl>+<D> to deselect the platens. 

 

You can also select multiple platens by drawing a selection rectangle starting 

form the blank space in the layout while holding the <ctrl>key down. All the 

platens having at least 8% of their area in the selection rectangle get 

selected. 

 

You can also toggle the selection status of the platens inside the selection 

rectangle by holding the <shift> key down in the operation as described 

above. 
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Checking for Overlaps 
Platen Organizer offers automatic checking for overlaps between any two 

platens of a layout. To use page optimally, platens should be placed as near 

as possible. But while doing so sometimes a platen may be placed over 

another.  

 

Check „Check overlaps‟ on the layout tool bar to prevent such catastrophe. 

Overlaps would be highlighted in real time (as you move a platen) by 

crossed hatch marks over the overlapped area as shown below. You can also 

use Layout > Check Overlaps to check current overlap status (this is a one 
time checking as against real time checking).  
 

Note 
If overlap is present, you will not be able to save the layout 

template. 

 

 

Fig 213. Check Overlap Button 

 

It can also issue warnings about overlapping of platens visually in real time if 

you want. 

 

When you will check the for the overlap region, it will show message box 

„Overlap found‟ OR „No overlap found‟ for the current page layout.  
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Fig 214. Overlapped Platens 

 

Auto Arrange 
Platens are placed in the layout one after another as you keep adding. But 

they can be arranged in the layout such that their cumulative area is 

minimized. 

 

The auto-arrange command tries to arrange all platens in such a way that 

they occupy minimum printable area.  
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The space between two successive platens can be set from View > Layout 

Options…. 

Snapping 
To place platens and guides easily Platen Organizer snaps the moving platen 

or guide to the nearest hot edge. 

 

In case of guide movement this hot edge is the nearest border or halfway 

mark of a platen. 

 

In case of platen movement a hot edge is the nearest edge of another platen 

or a guide. 

 

This snapping facility for the current moving object can be overridden 

holding <shift> while dragging the object (a platen or guide.) 

 

If you don‟t want snapping by default, check off menu command View > 

Snap. Checking this command again will enable snapping. 

 

You can also switch off snapping with platen bounding box and guides 

individually. Use menu command View > Snap To > Guide switch on/off 

snapping with guides. Use menu command View > Snap To > Bounding Box 

switch on/off snapping with platen bounding boxes. 
 

Layout Template 
Layout template is all about saving of the multiple platens in a single page 

with printer settings and placement positions that you made for each base 

type, with or without guidelines. Place the multiple platens in a layout whose 

width and height is defined by you. 

 

Save the layout using “Save layout template”. This can be achieved from the 

following ways: 
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Fig 215. Save Layout Template Option 

 

a. Right clicking layout will pop up the context menu in which Layout 

template will help you to save the layout or from the main layout menu 

File > Save Layout Template will help you the same. 

b. By using the Save button of Layout setting tool bar. 

 

While saving the layout template following requirements should be fulfilled. 

 

1. No overlap should be present into layout. 

2. Printer settings for each printing base type should set appropriate as 

per the printing background type for color data and white data. 

 

It saves the template file with *.klt (Kothari layout template) extension. It 

saves the printer settings, guidelines and platens with their positions. 

 

Open layout template from file using “Open Layout Template”. This can be  

achieved from the following ways: 

 

Fig 216. Open Layout Template Option 
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1. Click on open button in Layout setting tool bar. 

2. From right click context menu select Layout Template > Open Layout 

Template. 

 

Layout Template Management 
Layout template management feature allows you to manage list of saved 

layout template file for quick access. For more details please refer „Layout 

Template Management‟ on page no. 138. 

 

Layout Template Group Management 
Layout template group management feature allows you to manage the group 

of the saved layout template files for quick access. For more details please 

refer „Layout Template Group Management‟ on page no. 141. 
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Using Layout Options 

 

Fig 217. Layout Options Dialog 

 

a. Unit: Unit of displayed job spacing values.  

b. Horizontal: Default horizontal spacing desired between the jobs in the 

layout.  

c. Vertical: Default vertical spacing desired between the jobs in the 

layout. If same spacing button is checked then vertical spacing set same 

as horizontal spacing.  

d. Show bounding box: Check to show bounding box around the platen.  

e. Normal: Non-selected platen bounding box color.  

f. Selected: Selected platen bounding box color.  

g. Focused: Focused platen bounding box color.  

h. Show standard platen(s) in job list view:  If this option is 

unchecked then standard platens will not be added into the job list view 

when application starts or new template is created. 
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When the number of platens exceeds the page size in a page layout, further 

platens can only be added after resizing the page. Auto resizing is available 

for only those printers, which supports it. 

 

Merge Platen settings and positions 

 

Fig 218. Merge Platen settings and positions Dialog 

 

a. Print settings to use: Load printer setting files to use while generating 

combine files. User can load multiple setting files. 

b. Platen positions to use: Load platen template files to use while 

generating combine files. User can load multiple template files.  

c. Destination Path: Specify the folder path where you want to generate 

output files.  

d. Generate Files: Click this button to generate combined template files. 

It will pick each and every combination of printer setting file to platen 

template file. 
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Appendix A 

Glossary 
Calibration 

 

Adjusting the instrument so that it produces accurate and consistent results.  

 

Channel 

  

Equivalent of a printing plate. 

 

Clear Ink 

 

Special inks which are used to give special effects to the printing. 

 

CMYK 

 

It is a color space comprising of four inks Cyan, Magenta, Yellow and Black 

based upon subtractive color mixing theory.  

 

Color separation 

 

Process of converting a color image into one or more color plates is called 

color separation. These plates would then used for reproducing the original 

color image on a press.  

 

Densitometer 

 

It is an instrument for measuring the gray density in an area on the film. 

 

Dot gain 
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The change in the size of a printing dot from the film to the printed sheet, 

usually expressed in terms of percentage. 

    

Gamma 

 

A numerical value use to represent the non-linear response curve of an 

output device to light intensity. 

 

Gray scale 

 

Shades between black and white colors.  

 

Interpolation 

 

Interpolation is a process useful in generating the missing information from 

the given data samples. Alternatively in the context of images, interpolation 

is addition of pixels between others, usually done when enlarging the 

bitmap. 

 

Pixel 

 

It is the smallest addressable unit on the printer/monitor. 

 

RGB 

 

It is a color space comprising of three basic primaries Red, Green and Blue 

based upon additive color mixing theory.  

 

Resolution 

 

Resolution is usually defined as the number dots in a linear inch (DPI).  

 

Threshold 

  

This is a level, below which all pixels are considered as black and otherwise 

as white.  

 

TRC compensation 
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Tone Reproduction Curve compensation. Process of compensating for tonal 

gains/losses during printing. 

  

Wedges 

 

Gray scale ramp varying from 100% black to 0% black, changing with 

predefined steps. 

 

White Underbase 

 

The white mask that is printed using white ink over the printing base on 

which color data will be printed during subsequent pass. 



 

315 

Appendix B 

The length that can be output by Print Pro on your printer using Windows 

Printer Driver is a function of two variables. The resolution at which you want 

to print and the version of Microsoft Windows you are running Print Pro on. 

 

Windows 95, 98 or ME puts the limitation of the maximum number of pixels 

that can be addressed on the printer to 32767. Let us call this as addressable 

length X. If you were printing on a printer with a resolution of Y DPI (dots/ 

pixels per inch), then it would translate to X/Y inches in physical terms. For 

example, if you are printing on a 300 DPI printer the maximum length/width 

that can be printed on a page is 32767 / 300 inches or approx. 109.223 

inches. 

 

Windows NT or 2000 puts the limitation on maximum number of pixels that 

can be addressed to 2147483648 pixels. This would mean that on the same 

300 DPI printer you can print a length of up to 2147483648 / 300 inches or 

7158278.826 inches approx. 

 

Not only the above limitation, but there is another limitation which is 

enforced by the common dialog library of Windows on the reported page 

sizes by them. This size is limited to 129 inches in width and height. On all 

the Windows 95, 98 or ME and Windows NT or 2000 this limitation is 

applicable. 

 

The above discussion is true for both Non-Postscript and Postscript printers 

when printing is done through Windows GDI. Print Pro uses GDI for 

communicating with the printer. Postscript printer tries to solve the issue by 

dividing the reported printer DPI by 2 till the resulting number of pixels 

remain well within the range, but the limitation on the paper size reported 

still remains.  

 

You can still have any size plots from Print Pro by the help of its pagination 

feature, which of course needs to be stitched together. 
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Notes
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